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About this manual

This manual is an introduction into the operation of CircuitCAM 5.0 for
Windows ™.

CircuitCAM is a combined Computer Aided Design (CAD) and Computer
Aided Manufacturing(CAM) program.

You can use CircuitCAM to import, check and edit circuit board
production data in various CAM formats, and then output them again into
a CAM format(LMD). CircuitCAM is particularly useful in calculating the
isolation channels between the conductor tracks in circuit board
prototype production using LPKF circuit board plotters.

In addition to installation of the CircuitCAM software and a general
introduction of the CircuitCAM user surface, it teaches you the basic
features and concept of CircuitCAM on the basis of exercises.

This manual will not deal with the basics of Windows. If you are not yet
familiar with the different Windows objects, please refer to the Windows
documentation first.

In order to receive a better quality of the graphic representation in this
tutorial, the representations may partly differ from the original displays
on the screen as far as the colors are concerned.

It is the duty of the software user to check the observance of the
following points. It must be ensured that

* the software is only operated in accordance with its
designated use and in conjunction with the system
delivered;

* the complete manual is kept in a legible condition and is
always at hand at the software' s place of use;

* only authorized and sufficiently qualified personnel are
entrusted with the handling of the software;

* the personnel has read and understood this manual and in
particular the safety instructions contained herein.

CircuitCAM 5.0
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I. Conventions used in this manual
Bold text is used to emphasise important information.

lllustrations are numered. Example: Fig. 5

» Prompts for actions are identified with an arrow.

Italic sections are used to indicate the reactions consequent on an
action.

Word printed in italics mark proper names.

Key inscriptions and menu terms are printed in BOLD CAPITALS.

Il. Notes on the symbols used
Danger! This symbol is used to highlight danger to life or health.

Caution! This symbol is used to identify hazards which may cause
damage.

Note: This symbol is used for notes intended to help you avoid
faults in operation or to help you improve your procedures.

lll. Legend
CircuitCAM : Software for data processing
BoardMaster : Machine control software

IV. Target Group

This Manual is intended for personnel familiar with the basic use of
Windows as well as exporting of corresponding data from the CAD
programs used (Eagle, Protel... etc.).

Revision: 2.6.04 CircuitCAM 5.0
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1.0 Installation

1.1 System requirements

The minimum system requirements for an installation
of CircuitCAM are:

IBM PC or compatible system with

* Pentium-Il processor (Pentium or equivalent processor
recommended)

* Min. 256 MB (512 MB recommended)

* VGA colour monitor (recommended resolution 1024 x 768 pixels)
* Microsoft Windows 2000, Windows XP operating system

* (4x speed) CD-ROM drive

CircuitCAM requires approximately 20 MB free hard disk space for its
installation.

1.2 Materials supplied
The materials supplied with CircuitCAM include:
* 1x CD-ROM

« this manual

* License card

1.3 Installation

As soon as you have inserted the CD in the CD-Rom drive of your PC,
and provided the autostart-function of this drive is activated, then the CD-
browser will start automatically. Its menu guidance will lead you through
the installation of your LPKF programs.

If the autostart function is not activated on your PC, then proceed as fol-
lows:

» Select RUN... from the Windows START menu.
» Then click BROWSE.

» Select the CircuitCAM installation directory and double click
“Setup.exe” .

The installation routine for CircuitCAM starts running.

» Then follow the instructions in the installation program:

) Note: Clicking on CANCEL allows you to close the dialog box and
- cancel the installation.

CircuitCAM 5.0 Revision: 2.6.04 9
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1.4 Directories created during installation

By default, the installation program creates a "LPKF 50" subdirectory in
your program directory. Programs such as CircuitCAM and BoardMaster

are saved here.

The following subdirectories are created in the "LPKF 50" directory for
CircuitCAM:

» CCAM contains the program files for CircuitCAM..

» Data contains the data files for CircuitCAM. This is the default
directory in which all newly created data are saved.

» Ape_Templates contains the translation files for the import of
aperture and tool lists.

* New_Templates contains the CircuitCAM template files, listed in
the New submenu of the CircuitCAM File menu.

You can customize the directories for the conversion and template files
to your requirements as described in the following section see ,User
preferences” on page 11.

10 Revision: 2.6.04 CircuitCAM 5.0
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Figure 1:

Figure 2:

Installation

1.5 User preferences
On completion of installation, the CircuitCAM GENERAL SETTINGS

dialog box is displayed; here you can personalize your CircuitCAM
software:

General Settings e E x|

User | Directories

User: IHans Mustermann

Organization: IMustelmann GmbH

Location: IW 2345 Musterhausen

Serial Humber: |U20921 B1E

Enabling Mumber. IW 2345678904BC0EA

Language: |eng|\sh j

[To see changes - pleaze restart the application]

Ok I Abbracheml Ubemehmenl

» Enter the data that you require in this dialog field.

Note: The Serial Number and the Enabling Number can be found on
the license card. You may call up this GENERAL SETTINGS dialog
box in CircuitCAM at any time by selecting the General... line from
the CONFIGURATION menu.

Changing the language can be done at any time using the USER tab.
Please take note that CircuitCAM must be restarted afterwards in order
for the change to take effect.

Clicking on the DIRECTORIES tab allows you customize the CircuitCAM
directories for the translation and template files to your requirements:

General Settings x|

User  Directories

Aperture Template Directorny [ t=t):

IE:\LPKFSD\AF’E_TempIates |
Mew Template Directory [* cat):

IC:\LPKFED\NE\N’_TempIates |
Library Diirectom [* gme)

IE:\LPKFED\Libraries |

ok I Abbrechenl [bernehmen

This settings will be saved in the Windows registry.

CircuitCAM 5.0
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1.6 General settings

In the CircuitCAM version 5.0 it is possible to select the new setting BIG
CROSS. Go to the CONFIGURATION / GENERAL... menu and click on
METHODS. Under CURSOR you find the new setting BIG CROSS (see
figure 3) which makes appear a marking cross that extends over the
whole screen. This new cross-hair cursor enables the easy modification
or creation of layout data.

General Settings x|
Shortcuts Directories I Unit/Grid I
Methods Import &ssighment | Diverse | Colours | User
—&gc————————————— [~ Path/ Polygon [Mouse Function]
' Center Paint " &dd or &ppend [Temp &)
i+ Pgint on Arc = Create or Move Arc [TempE]
 Cut Pt/Seq [Temp L)
—Cincle————————— " Delete Pt/Seg [Termp D)
" Center ' Maove Pt/Seq [Termp k)
* Center + Radius " Select Only [Temp L]
! Tiwn Paints
" Circle in Closed Path Foint
ele n Hlassdina ’V  Mass % Certer
— Line — Cursar
o9 Ao
& 450 ' Small cross
Ay ' Big cross
~\
ok I Abbrechen [bermehmen Hilfe |

Configurarble Shortcuts

A key combination can be assigned to any program function of Circuit-
CAM. In order to add new key combinations or modify existing ones, click
on the tab SHORTCUTS under CONFIGURATION / GENERAL.... The
different function keys can be used to create new shortcuts and to modify
or delete existing ones (see figure 4).

General Settings x|
Methods | Impart &ssignment Diverse | Colours User |
Shortcuts | Directaries I Urit/Grid

i~ Select command: Assigned shortcuts:

File:

2 fault "
File->0pen ﬁm M
File-»Cloze
File->5 ave
File->5ave As
File->Sawe Al
File->Impart. .. [ — |
File->Pint...
File->Print Preview...
File->Print Setup
File->E xit
Edit->Undo Reset Al
Edit->Redo
Edit->Cut i
1 | » Load from File

Create Shortcut Save to File

oK I Abbrechenl Ubamahmanl Hilte |

12
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2.0 Getting started

&

fia

Figure 5:

&

fia

Figure 6:

In this chapter, we would like to give you a first look at CircuitCAM and
familiarize you with the user interface of CircuitCAM. We will show you
how you can customize CircuitCAM to your requirements and how to
use the online help when you require more information on a particular
topic.

Note: This tutorial uses the default settings suggested during the
installation for the name of the program group and the directories
created.

2.1 Starting CircuitCAM

Once installation of CircuitCAM is complete, a new LPKF50 program
group will be found under PROGRAMS in the Windows 2000/XP START
Menu; it will contain the following icons:

=lol x|
Datei  Bearbeiten  Ansicht  Favoriten  Extras  ? | n
< Zuriick > I ? | 7 ! Suchen Ordner X n | Elv
Adresse I_J ;\Dokumente und Einstellungent Al Users'Startmend|Programme!|LPKFS0 j Wechseln zu
E2 L2) 2 g2 2
CircuitCAM 5.0 CircuitCaM 5.0 Help CircuibCam 5.0 Tukar TukorCPU
Read-Me
|5 Objekt(e) 2,79KB |4 Arbeitsplatz 4

Note: Double-click on the READ ME icon to read the latest
information on CircuitCAM not available when this tutorial was
printed.

How to start CircuitCAM:

Select the CircuitCAM 5.0 shortcut from the LPKF 50 program group in
the START Menu.

B Progamme @ LPKFSO [ i circuitcams.o
@) CircuitCAM 5.0 Help
&) CircuitCAM 5.0 Read-Me
g Tukar
# TutorCPU
9) HilFe und Support
E Ausfahren. ..
@ Herunterfahren,..
CircuitCAM 5.0 Revision: 2.6.04 13
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2.2 Using online help

CircuitCAM has a context sensitive online help system. To help you
quickly find the topic or concept you are looking for, the online help
system has a table of contents, an index and a search function; in
addition you can obtain help on the CircuitCAM function that is currently
active.

How to call up the Online help topics:

» Select HELP TOPICS from the HELP menu.

Help

Hﬁelp T |:|pi|:::5:

About CircuitCAb.

How to obtain help on the current function:

» Press function key F1.

How to obtain help on any function:
» Click on k2| in the DEFAULT toolbar.

» Select an item from the menu bar or click on a button in a toolbar to
obtain more detailed information on the function selected.

Please refer to your Windows documentation for information regarding
the use of online-help.

2.3 Show program information

You may display the CircuitCAM version number by selecting ABOUT
CIRCUITCAM... from the HELP menu.

About CircuitCAM e |

% CircuitCAM Version 5.0 (502)

Copyright € LESoft Ing. Buero Lothar Klein, 1932-2004
Copyright © LPKF Lazer & Electronics AG. 1992-2004

LPKF Laser & Electronics AG
Osteniede 7
30827 Garbzen
Germany

Telefar: ++49-[0)51.31-7095-0
Telefax: ++49-0)5131-7095-30

Email: Ipkfi=ipkf.de
hittp: £ . Ik, de

This dialog box also contains information of how you may contact us.

14
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2.4 Wizard (Processing Assistant)

The “Wizard” supports you in processing data and leads you through the
entire processing routine with appropriate instructions. This is intended
to facilitate the work particularly of those who do not work regularly with
CircuitCAM or for new users who want to familiarize themselves with the
program quickly and reliably.

Note: It is necessary to observe that the Wizard only supports
standard, extended Gerber and Excellon data during import.

.

The Wizard is opend by clicking on the AN Wizard button.

Figure 9:Import Wizard

Import
Layout Top Side
Apettue List Top Side
Layovt Botiom Side

ist Bot

Balton Side
Save
Export to LD

st f | ‘ oz 1129

4

1- Zoom in: Clicking this button increases 5- Back: Clicking this button goes back one
the size of the data displayed (8). step in the processing sequence.

2- Zoom out: Clicking this button reduces 6- Next: Clicking this button jumps forward
the size of the data display (8). to the next operating step.

3- Overview: Clicking this button displays 7- Report window: This window shows
the entire overview in the data display (8). instructions, descriptions and aids on the

corresponding operations.

4- Graphic mode: Clicking this button 8- This window shows the data in the

switches off the import Wizard. current processing phase.

CircuitCAM 5.0 Revision: 2.6.04 15
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Note: In order to work in the normal graphic mode, the Import
Wizard can be switched off by clicking GRAPHIC MODE. If you
want to change to the Wizard while processing in graphic mode,

click the g button.

Changeover is possible continuously at any time, whereby the
Wizard is automatically updated to the current operating step.

2.4.1 Basic Wizard Functions

Instructions or requests required to perform the appropriate (next)
operation are given in the left report window ( see figure 9 ) for each
operation. In comparison to Version 4.0, the precise procedure has not
changed. Detailed instructions and explanations on the operating steps
are given in the appropriate chapters in this Manual. As a matter of
principle, the following operations are supported:

Import
Layout Top Side
Aperture List Top Side
Layout Bottom Side
Aperture Ligt Bottom Side
Crrilling data
T ool List
Contour Routing
Insulate
Top Side
B ottom Side
Save CAM
Export to LMD

Importing top side layout data:

Here, the layout data (for the top side) for the CAD software used is
imported into CircuitCAM, in order to process it.

Importing top side aperture list:

The aperture list is an ASCII file containing the required apertures with
corresponding definition, e.g. aperture number, size and shape. The
Gerber data can only be imported graphically correctif the appropriate
aperture lists are used.

Importing bottom side layout data:

Here the layout data (bottom side) for the CAD software used is
imported into CircuitCAM in order to process it.

16
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Importing bottom side aperture list:

Some CAD software uses aseparate aperture list for this layer, which
must be imported in the same manner as the list for the top side.
Importing drilling data:

The drilling data (Excellon data) is also defined in ASCII files in which the
coordinates for the holes to be drilled in the circuit board are defined
together with the associated tools.

Importing tool list:

A tool list is comparable to an aperture list; it contains the tools required
with corresponding definition, e.g. tool number, type and diameter of the
drill.

Contour routing:

If you want to machine the circuit board with a contour router, instead of
cutting it with circuit board shears, you can use the contour generator to
calculate the routing contour.

Insulating top side:

Here, the entire operation for cutting the circuit board contours on the
top side are supported (insulation cutting).

Insulating bottom side:

Here, the entire operation for cutting the circuit board contours on the
bottom side are supported (insulation cutting).

Save (*.CAM):

When you have completed all steps for processing your data, the file can
be saved with the extension *.CAM.

Exporting to LMD format:

The completed CAM file can be exported in the LMD format which can
be processed with the BoardMaster software to control the contour
router accordingly

As a matter of principle, Standard Gerber, Extended Gerber, Excellon as

well aperture lists and tool lists are supported by the
for processing the data format.

CircuitCAM 5.0
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2.5 CircuitCAM application window

CircuitCAM's working area, menus, toolbars and status bar look like
many other Windows application programs to make it easier for you to
begin using and working with the program.

Figure 11:
BE CircuitcAM - Laser - [Untitled1, LayoutMain] i =18l x|
BN Fie Edit View Insert Select Config Window Help =18 x|
D|Ch| (|| S[>] & |o@o] ] & = = =%
Ch | [ e 15| 2 SIS [ARER A B || ] 2] 527 2 [mm oom lfotom -]
o
o
Y
Ly
N
s
CircuitCAM has three types of document window:
GRAPHIC WINDOWS, LIST WINDOWS and REPORT WINDOWS..
When you start the program, the GRAPHIC WINDOW for the "empty"
specification file is opened in full-screen mode.
o  Note: You can open a number of document windows in CircuitCAM
({ at the same time. The WINDOW menu gives you access to
functions for arranging the various document windows and for
switching between the document windows.
18 Revision: 2.6.04 CircuitCAM 5.0
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Figure 12:

Figure 13:

Getting started

2.5.1 Graphic window

The production data imported for your circuit board are illustrated
graphically in the graphic window. This allows you to check that all the
data meet the desired requirements.

Note: The view is always of the upper side of the circuit board, so
the lower side of the board is illustrated as a mirror image.

u Tutor :J_D.'lq

)
.

PEBS TG 23UY Q}

AIMROMBEITOZIDE

L | 2w

In addition, the graphic window gives you access to functions for editing
the production data.

Note: When the mouse pointer is in the graphic window, clicking
the right mouse button will access a context menu for editing
selected objects:

Cancel
Select the last one

Cut

Copy

Copy as EMF in colored

Copy as EMF in monochromatic
Paste

Delete
Duplicate
Move

Fitch of bwo Pads
Measure

Properties...

CircuitCAM 5.0
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2.5.2 List window

The list window displays the apertures and tools imported and the layers
in tabular form with their corresponding definitions. You are able to edit,
delete or add new entries.

The opening of following windows will be explained later (see ,Aperture
list* on page 28).

Figure 14:
EﬁUnlilledtZ, Layers
o m| B%l4lE] BT 2] cese | ‘
Layer Mame | Order | Calar | Flash | Visible Selectable | True Widthl Outline | -
£ Toplayer 4 m m m|
£ BottomLayer 3 m = O O
£ DiillPlated 1O O O
£ DiilUnplated 2 m = O
% Boardluline i :%.%Unlilled1:3, configGerber\VApeT utor
=i TextTop
= TewBattom L o] Y e P L N e Close | ‘
£ CuttingDutside 16 - T T I T =
= Cuttinglrside 17 Configltem MNare Mo Type a 0 b
= SolderMaskTap 18 0 ] mmn
£ Soldert askBottom 19 O mmn
é. - O 0.2 mm
é SolderPasteB ottom 26 Q ::1_‘ ::
g SiIkScreenTop a ﬁﬁ%umilledtd, configE xcellon\T oolT utor
£ SilkScreerBottom 21
£ RuboutTop 2 t.l‘ll[l:ll Dl)‘l/.l?na;l El IE,_.E',_M_J Close | ‘
£ FrameTop 7 - -
%HuboutBottom 23 oﬂgltem Mame | MD|:EE | T_l,lpCe> | a D.Bmm| b
q = T2 WO 0.7 mm -
T3 [ O 0.9 rmm -
< | Ay
T =zl
2.5.3 Report window
The report window shows a log of functions such as export of the
production data, and displays any error messages.
Figure 15:
Z Report -10] x|
Layer = TextBottom, Phase =MillingBottom Al
Tool usage
D/P Flashes Paths Length [mm] Moves [mm]
Layer = DrillPlated, Phase =DrillingPlated
Tool usage
DiP Flashes Paths Length [mm] Moves [mm]
4, "Spiral Drill 0.6 mm" 5 0 0 Al
5, "Spiral Drill 0.7 mm" 9 0 0 59
7, "Spiral Drill 0.9 mm" 26 0 0 172
Layer = DrillUnplated, Phase =DrillingUnplated
Tool usage
D/P Flashes Paths Length [mm] Moves [mm]
Layer = DrillPlated, Phase =Dispense
Tool usage
D/P Flashes Paths Length [mm] Moves [mm]
2, "D Pink Cartridge 0.6 mm" 5 0 0 Al
3, "D Pink Cartridge 0.7 mm" 9 0 0 59 v
< | 2y

20 Revision: 2.6.04 CircuitCAM 5.0
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Figure 16:

Figure 17:

Figure 18:

Figure 19:

Figure 20:
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2.5.4 Toolbars

CircuitCAM has a number of toolbars which group together associated
functions:

DEFAULT
D[&(8| 8| =[] [BottomLayer ~l[apeTutor ~|lb12 L]

Standard functions such as open, save, print and
list boxes for layers, tool lists and aperture/tool

FRONT TO END

Functions to the generation of milling- and drilling data: importing,
contour routing, break-out-tabs insert, Insulate all Layer, exporting LMD -
file.

View

""" “a[*al|7a[a]a[%| &

Functions for zooming in/zooming out in the graphical view and for
setting the layer properties.

Grid+unit

| [om | |l 2 [E2 7 [om oM o om

CircuitCAM Lite-version CircuitCAM PCB-version

Functions for sliding layers on top of each other and for displaying the
unit, buttons to define the origin of coordinates and of the coordinate
system, as well as lists for unit and grid.

Select

K@ RS Fx Al

Functions for marking graphical objects

CircuitCAM 5.0
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Figure 22:
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Graphics

[E\ =110 I

Functions for adding graphical objects

How to show or hide a toolbar:

» Select the toolbar you wish to display or hide from the Toolbars
submenu under the View menu.

How to move a toolbar:

» Place the mouse pointer on the area between the buttons on the
toolbar or on the title bar of a floating toolbar.

» Drag the toolbar to a new position with the left mouse button
pressed. The toolbar will automatically be docked at the edge of the
window if you drag the toolbar to the edge of the application window.

2.5.5 Status bar

The status bar at the bottom of the application window displays
information regarding the object or function selected.

Few objects are selected Selected=16 508/ 25.4 mm 133.02/ 2413 mm

The status bar is divided into four information areas:

* Textual information
* Number of objects selected

 Current coordinates of the cursor

« Coordinates of the anchor point =&

You can also show or display the status bar by selecting the STATUS
BAR entry from the TOOLBARS submenu of the VIEW menu.
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2.6 Opening the "Tutor" sample circuit board

Production data for two sample circuit boards are supplied with
CircuitCAM. We recommend that you use the "Tutor" sample circuit
board when you try out the CircuitCAM functions for yourself.

How to open the "Tutor" sample circuit board:
» Select the entry OPEN in the menu FILE.
» Select the directory C:\LPKF50\Data.
» Mark the file TUTOR in the interactive box OPEN.

» Click OPEN to open the file "TUTOR.CAM" or click QUIT to
discontinue the procedure.

Note: If you have not started CircuitCAM you can open the sample
circuit board together with CircuitCAM by double-clicking TUTOR
symbol in the program group LPKF40.

The same applies for the sample circuit board “TUTORCPU”.

2.7 Closing CircuitCAM

How to exit CircuitCAM:

1. using the keyboard:
> Press ALT + F4.

2. using the mouse:
» Select Exit from the File menu

or click on x| in the top right-hand corner of the application
window.

CircuitCAM 5.0
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3.0 Preface to the exercises

Figure 23:

In the following sections you will become familiar with the basic functions
of CircuitCAM by working through exercises.

In the first exercise, you will load production data and prepare it for
circuit board prototyping. This exercise is somewhat more extensive
than the remaining exercises, as it covers the entire sequence of
operations required to generate production data suitable for passing on
to LPKF BoardMaster.

The remaining exercises show you how to correct production data which
does not work together, perhaps because a layer has been rotated or
mirrored in the export of production data from the circuit board CAD
program used or because there is an offset between the various types of
production data. In addition, these sections will introduce you to
functions in CircuitCAM which will help you, so far as is possible, in the
preparation of production data for prototyping.

3.1 "Tutor" sample circuit board

The circuit board you will be using in the following exercises is a double-
sided PCB with conventional and SMD components. The SMD
components are located on the solder side (the bottom side) of the
circuit board:

an
NP

PEBLT@4ET 2003 G}

COMRONENT/ICEIDE
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3.2 Listing of the exercise files

You will work through the exercises using prepared production data for
the "Tutor"” sample circuit board which were copied to the “Data*
CircuitCAM subdirectory during installation.

Production data for the "Tutor" sample circuit board:

TUTORAPE.TXT

TUTORTOOLS.TXT

TUTOR.CAM
TUTOR.WHL
TUTOR.NCT
TUTOR1.CMP
TUTOR1.SLD
TUTOR1.DRL
TUTOR2.CMP
TUTOR2.SLD
TUTOR2.DRL
TUTORS.SLD
TUTORS.SLD
TUTOR3.DRL

Translation file for the aperture lists
(Ape_Templates subdirectory)

Translation file for the tool lists
(Ape_Templates subdirectory)

CAM data, CircuitCAM version 5.0 format
Aperture list for Gerber data

Tool list for Excellon data

Gerber data for the component side
Gerber data for the solder side

Excellon data

Gerber data for the component side
Gerber data for the solder side

Excellon data with offset to the Gerber data
Gerber data for the component side
Gerber data for the solder side

Excellon data rotated 90° against the
Gerber data

Note: The filenames and file extensions for the production data can
be chosen freely and are not standardized.

CircuitCAM 5.0
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In this chapter, you learn the adjustment of UNIT + SCREENS, to open a
new document, as well as importing of the CAD-production-data.

The sequence of operations in CircuitCAM may be divided up into the
following three phases:

1. Import production data
2. Prepare production data for prototyping
3. Export production data

4.1 Create new CircuitCAM document

If you wish to edit production data in CircuitCAM, you must first open a
CircuitCAM document into which the production data will be imported.

CircuitCAM offers two ways of creating a new document:

* You may use the document based on the template file
"Default.cat™ which is opened automatically in CircuitCAM when
the program starts.

* You can create a new document by selecting a preconfigured
template file from the NEW submenu under the FILE menu.

(You will be learning more about template files in exercise 5.)

Note: New documentsare always named "UNTITLED" followed by a
number. You may save these documents as a file by selecting
SAVE as from the FILE menu.

In this exercise you will be importing the production data into the
document based on the template file "DEFAULT.CAT" which is opened
automatically in CircuitCAM when the program starts.

How to create a new CircuitCAM document:

» Start the CircuitCAM program.
The document "UNTITLED1" will already be opened.

» Select SAVE as from the FILE menu.

» Enter the filename TUTOR1 in the FILENAME text box of the SAVE
as dialog box.

» Click on SAVE to save the document as a file under the name
"TUTOR1.CAM".

Note: By clicking on CANCEL or pressing ESC you can close the
dialog box and cancel the function.
This works in all dialog boxes.

The file extension ".CAM" is automatically appended to the filename.
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Figure 25:

Figure 26:

Exercise 1

4.2 Customizing grid, unit and coordinates display

CircuitCAM has preference options for the grid, unit and coordinates
display to assist you in accurate placement in the graphic window.

Up to now, you have been using the default settings for CircuitCAM while
working in the graphic window. In this section we would like to show you
how you can customize these settings to your requirements. In
particular, it can be very useful to customize these preferences when
you have significant amounts of work to do on graphical objects.

The functions for setting the grid, unit and coordinates display are
grouped together in the CONFIGURATION\GENERAL\UNIT/GRID
toolbar:

General Settings E
Methods I Import Asgignment I Diverse | Colors |
User | Directories Unit/Grid
& Cartesian
< Polar
Lirit Dizplay Grid Curzor Grid
fom =] [or06 =]/ [oro =l

ak. I Cancel | LEpir | Help |

The additional functions in the GRID/UNIT property sheet are:

Switching over the coordinate display in the status bar
& dhsolute between ABSOLUTE COORDINATES and
" Relative RELATIVE COORDINATES.

: Switching over the display format in the status bar
(‘:Elt between CARTESIAN COORDINATES and POLAR
COORDINATES.

CircuitCAM 5.0
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You can select the preferences in the three following list windows:

|I'I'll'l'| 'I

DISPLAY UNIT
All values will be displayed in the unit selected here.

[1720 5]
DISPLAY GRID
Shows the dots in the grid selected here in the background.

[1no =]
CURSOR GRID
Allows placement in the grid selected here, also known as snap

to grid.

4.3 Import production data

In the following steps, you will import into CircuitCAM the production
data a circuit board CAD program generates for the production of the
circuit board.

you can import the following file formats in CircuitCAM:

- Standard Gerber - HPGL (Only PCB Version)
- Extended Gerber - DXF

- Excellon - ODB++ (Only PCB Version)
- Sieb & Meyer

- Barco (Only PCB Version)

In the first exercise includes:

« the aperture and tool lists with the corresponding definitions
* the circuit board data for the component side in Gerber format
* the circuit board data for the solder side in Gerber format

» the drilling data in Excellon format

4.3.1 Aperture list

The aperture list is an ASCII file listing the apertures required with
corresponding definition, e.g aperture number, type and size. The
Gerber data can only be graphically correctly converted with the
matching aperture list.

For more information see ,Gerber Format® on page 97.
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_, Note: An incorrect aperture list definition will be revealed by
incorrect representation of the pads and conductor tracks in the
= graphic window, i.e these objects will be too small or too large in
dimension, or displayed in the incorrect form.

How to import the aperture list:

» Select IMPORT... from the FILE menu or click on m in the

FRON TO END toolbar.
The OPEN dialog box is displayed:

Figure 27:

Import [ 2] x|
Look [ 5 Dt = =i
Test.cam Tutorl.crmp Tutar3.crmp
Tutor.cam Tutarl.dil Tutor3.dil
Tutar.LMD Tutarl. sid Tutor3.sid
Tutor.nct Tutar2.cmp Tutord.cmp
Tutorwhl Tutorz. drl Tutord. drl
Tutorl.cam Tutborz. sid Tutord. sld
Kl 1 o
File name: || Open I
Files of type: IAII files [.%] =l Cancel |

4

» Select the fileTUTOR.WHL and click on OPEN to import the
aperture list.

The IMPORT dialog box, the header which shows the name of the file
you have selected, will be displayed.

CircuitCAM automatically detects that this is an aperture list or a tool list
(Apertures/Tools select). The first time the two fields Apertures/Tool
template and Aperture list are empty. Make your entries here.
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Figure 28:
Import C:\LPKF50%Data’ Tutor.sshl 2|
[ File-Type: |G
i Aperture/Tool Template: I please select - j
List of &pertures: IGelberDefauIt j
el Uit IGet HIC-Drill D efault
) Absolute  mm
() Fielativte ’71'- inch I Set as [ efault
= Mecimal Posttioh———————"—1 Sef ag Default |
" Leading Zeros present
) Traling Zeros present
= Trafing andLeading Zeros present
€ Decimal Paint
| rpart
— Digits e
Iﬁ lﬁ Template Editor | Cancel |
Apertures | Uzed | M ode | Type | a | b | B |
FILE-TYPE:
Here if not detected automatically, you must specify the type of the file
being imported so that CircuitCAM can interpret the data correctly.
APERTURE/TOOL TEMPLATE:
Appears if the file type APERTURES/TOOLS is selected.
Here you should select a translation file for your production data.
CircuitCAM needs this translation file to convert the data correctly as the
aperture and tool lists used by circuit board CAD programs are not
standardized.
More information on the topic of translation files may be found in the
appendix, page 78 and following).
APERTURE LIST / TOOL LIST:
Here you should enter a name for the aperture list which will be used
within CircuitCAM.
LAYER:
Appears if the file type Gerber or Excellon is selected. Here you should
specify the layer to which the production data is to be assigned.
Template Editor
By clicking the button TEMPLATE EDITOR an additional program for
simple creation of new translation files for apertures and tool lists can be
opened.
» Select the TUTORAPE1.TXT translation file from the Aperture/Tool
Template list box
Figure 29:

Aperture/Taol Template © [Tutordpe, THT [Gerber) j
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» Enter ,,APETUTOR1“ as the name for the aperture list in the listbox
labeled APERTURE LIST.

Figure 30:
Aperture List : I.-’-'-.peTutu:ur'I| j
All the settings necessary for importing the aperture list are now
completed. If the translation file has been correctly selected, i.e it
matches the aperture list to be imported 100%, the result will be
displayed in the list box in the lower part of the Import dialog box.
Figure 31:
Apertures | Uzed | Mode | Type | a | b C =
B Do v & ) 02mm
[# 011 v 1 1 mm |
B o2 v ) 03mm
| D13 v 3 11mm
] D14 v 3 1.5mm
[# D15 W E 1 1.3 mm | "|
4 3

Caution!!! The exercise is interrupted here. The following
paragraphs are additional information.

If some apertures/tools are undefined due to an erroneous translation
file, i.e. marked with a question mark in the list window, you can define
the aperture/tools here manually (see figure below).

Figure 32: Undefined tools

|.ﬁ.pertures | Ized | kode | Tupe | a

[ D10 W ¥ 7

% D12 W k] b

[# D13 W [+ ?

% D14 W ] > \
% 015 W e 7

D16 W k] 7

For this purpose, click one of the apertures/tools which are undefined
(“?”) with the right mouse key.

The following window appears:
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Figure 33: Aperture/tool
Aperture/Tool : D22

Flash |Transf0rm| Diraw | Diversel

& Lircle 2 s |fFme

€ Oval

 Square b 9- ID i

" Rectangle 2 W

" Rounded Rectangle
" Beveled Rectanale
" Dectagon

iz |0rmm

2]
=
21 2| 21 2
21 21 2] 2] =
_T_
=

- il jir [0 ram
 Undefined
 Marker
" Special s=Dliameter
 0if
IEE‘I182:| 'I
. Position
E dit | * Datum

0k I Cancel | A | Help

[// =  Note: The next 4 operations should be considered as examples:

4 They are not part of the exercises in this manual. They are
intended only to illustrate how an aperture can be defined manually
and correctly (in this example, defintion of a flash aperture):

» Select the CIRCLE in the register FLASH
» Enter the value 0.7 mm for Parameter a:.
» Select the index card DRAW.

» Click the checkboxes DERIVED FROM FLASH DEFINITION and
AVAILABLE.

With these settings, this aperture is defined as a pure flash aperture.

[/ > Note: Detailed information on the Aperture/Tool box is given in the
W= Appendix.

Continue with this exercise:

If you wish also to use the translation file you have selected here for
importing the aperture list for subsequent circuit boards, click on SET AS
DEFAULT to save this setting as a default setting. The default aperture
list name GERBERDEFAULT will be used in this case. This setting can
then be used in further sessions by clicking on the Get GERBER
DEFAULT button.

» Click on IMPORT to import the aperture list.

You can show the imported aperture list in a list window.

» Select the GERBER APERTURE LIST... line from the FORMAT
submenu of the CONFIGURATION menu.

CircuitCAM shows the imported Gerber aperture lists in the list
window:
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Figure 34:
t o Bx|4lEs| B[ 2w clese |
Configuration Mame | | it | tode | £elnes | m | il | ...
ifzh abs Trailing 2 3O
ifzh abs Trailing 2 3O
> Double-click on the “APETUTOR1*“ entry to display the definitions
for this aperture list:
Figure 35:

t'|.1’||:|]| QIX|4|?D!;| EI E&lﬁ‘ﬁl Close ”

Configltem Mame | I ode | Type | a | b C
D10 O 0.2 mm
D11 O 1 mm
D1z O 0.3 mm
013 ] 1.1 mm
D14 O 1.5 mm
015 O 1.3 mim
D16 O 1.6 mm
07 ) 0.05 mm
D18 [+ o 2.5 mm 0.6 mm
019 [ [ 2.5 mm 0.6 mm
Dz0 O £.35 mm
D21 O £.35 mm
<= Note: You can check and edit the aperture definitions in the list
window by clicking on the line of the aperture you wish to check or
edit with the right mouse button.
It is not necessary to import the aperture list if the Gerber data are
available in Extended Gerber format (274X, Gerber-X with mass
parameter), as the Gerber data will already contain the aperture
definitions.
You will find a full description of the various functions in the list window in
the CircuitCAM online help.
» Click on CLOSE to close the list window.
The aperture list has now been imported into CircuitCAM.
o Note: Save your data to protect against data loss. For this purpose,
[i select the SAVE in the menu FILE .

» Select the name “Tutor1” and click SAVE.
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4.3.2 Tool list

A tool list is similar to an aperture list, it lists the tools required with their
definition, i.e. tool number, type and diameter of the drill.

The steps for importing the tool list are similar.

How to import the tool list:

» Select IMPORT... from the FILE menu... or click on m ‘ in the
FRONT TO END toolbar.

The OPEN dialog box is displayed.

» Select the file “TUTOR.NCT* and click on OPEN to import the tool
list.

The IMPORT dialog box, the header of which shows the name of the
file you have selected, will be displayed.

CircuitCAM detects automatically that this is an aperture list or a tool list
(Apertures/Tools select). Initially, the two fields APERTURES/TOOL
TEMPLATE and APERTURE LIST are empty. Make your entries here.

» Select the “TutorTools.txt* translation file from the APERTURE/
TOOL translation list box.

Figure 36:

AperturedTool Template :

Tool Ligt :

LIIKE aard # » Exc mil Inch25ébsT rail bt NCDl)
JtiBoard ® » Exc mm kMmZ3absT rail bt (MCll)

» Enter “TOOLTUTOR1“ as the name for the tool list in the TOOL
LIST edit field.
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Figure 37:
Import C:LPKF50%Data’,Tutor.nck e |
File-Type: IAperturess’TooIs select j
Aperture/Tool Template: [T utarT aols. TXT (MCDiil) |
Tool List: j
—Yalues——————————— L it Get Gerber Defaultl
g ':2?‘;';: ’E :::h IGet i 1 =
 Decimal Fostion——— Set as Default |
| Leading Zeros presemt
& Traiing Zeros present
| Traiing and Leading Zeros preseht
| Decimal Point
Import
Digits m.r:
’7 I3 j' I2 j' | Ternplate Editar | Cancel |
Tools: | Lzed | Maode | Diarneter |
[ T 0.6 mm
12 0.7 ram
T3 % 0.9 mm
All the settings necessary for importing the tool list are now completed. If
the translation file has been correctly selected, i.e it matches the tool list
to be imported 100%, the result will be displayed in the list box in the
lower part of the IMPORT dialog box.
Tools : | Jzed | kode | Diameter
[ T v 0.5 mm
[ T2 W 0.7 i
T3 W 0.9 rm
» If you wish also to use the translation file you have selected here for
importing the tool list for subsequent circuit boards, click on SET AS
DEFAULT to save this setting as a default setting.
The default tool list name NCDRILLDEFAULT will be used in this case.
This setting can then be used in further sessions by clicking on the
Get NC-DRILL DEFAULT button.
» Click on IMPORT to import the tool list.
You can display the imported aperture list in a list window.
» Select the EXCELLON TOOL LIST... line from the FORMAT
submenu of the CONFIGURATION menu to do this.
CircuitCAM shows the imported Excellon tool lists in the list window:
CircuitCAM 5.0
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g et Lo MUY P A o~ W e

| Unit | Mode
i abs
T abs

Close |

| Leles | ] | h |
trailing 3 2
trailinig 3 2

Configuration Mame

U...
O
O

> Double-click on the “TOOLTUTOR1“ entry to display the definitions
for this tool list:

g e o] e A o R e

| M ode | Type | a | b |

Configltem Mame
T ()
T2 = ()
T3 = )

» Click on CLOSE to close the function.

The tool list has now been imported into CircuitCAM.
Note: You will find a detailed description of individual functions
within the list window in the CircuitCAM online help.

Save your data to protect against data loss.

Do this by selecting SAVE from the FILE menu.

The document will be saved under the filename “TUTOR1” already
entered.

4.3.3 Gerber data for solder and component sides

Once you have imported and thus defined the aperture and tools into
CircuitCAM, you are in a position to import the Gerber data for the solder
and component sides.

How to import the Gerber data:

» Select IMPORT... from the FILE menu... or click on m |in the

FRONT TO END toolbar.

The OPEN dialog box is displayed.

Note: The import function in CircuitCAM is capable of importing a
number of files containing production data in a single process.

You can select multiple files by holding down the CTRL key as you make
your selections.
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—- You can select a range of files by selecting the first file in the range,
[i holding down the SHIFT key and selecting the last file in the range.
All files within this range will now be selected.

» Hold down the CTRL key and select the files “TUTOR1.SLD* and
“TUTOR1.CMP*.

» Click on OPEN to import the Gerber data.

The IMPORT dialog box is now displayed; here you define the file type
of the file to be imported, and assign each of the files selected in
sequence to an aperture list, tool list and layer.

Assignments for the Gerber file Tutor1.cmp (component side)

i Note: Select the Gerber option under File-Type if CircuitCAM does
[i not automatically interpret the file to be imported as a Gerber file.

» Assign the “APETUTOR1” aperture list previously defined to the
Gerber data in the Aperture List list field by dropping down the list
box with a click and selecting the “APETUTOR1* line:

Figure 40:
&perture List : I.ﬂ.peTutnrﬂ j
» Select the name TOPLAYER from the LAYER list box to assign the
Gerber data for the component side to this layer.
Figure 41:
Import C:LPKF50%Data" Tutorl.cmp E ﬂﬂ
[ File-Type: IGerber j
i [ |
List of Apertures: IApeTutor j
Wales Uit Sizexy———— 1 GetHCDil Defaultl
% Absolute ’7(' mm
' Relative % inch 61.1854 mm Set as Default |
—Decimal Pogition————————————
™ Leading Zeroz prezent L) oty
% Trailing Zeros present Previ
™ Trailing and Leading Zems prasent &I
" Decimal Point -
Optionsz... | Impart
Digits m.n:
J F=F = el
| Used | Mode | Type | a | b | B -
O 02mm
1 1mm ]
1 0.3mm
1 1.1 mm
O 15mm
[E ) 1.3mm _|L|
| | >
» Click on the button SET AS DEFAULT to store the current setting of
the layer. By clicking on the button DEFAULT the preset default
setting with the aperture list name Gerberdefault is used. Please
take note that only one default setting can be used, i.e. the layer
name must be newly allocated for a second Gerber file.
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» Click on IMPORT to import the file and to open the IMPORT dialog
box for the import settings for the next file selected.

Data already imported will be shown in the background of the graphics
window.

Assignments for the Gerber file Tutor1.sld (solder side):

Note: Select Gerber from the File-Type combo box if CircuitCAM
does not automatically interpret the file to be imported as a Gerber
file.

» Select in the list field APERTURELIST previously imorted aperture
list APETUTOR1“.

» Select in the listbox LAYER ,BOTTOMLAYER® to assign the gerber
files for the bottom-layer.

» Click on IMPORT to close the function.

The Gerber data for the solder and component sides have now been
imported into CircuitCAM and will be displayed in the graphic window.

22 Circuit CAM - Lite - [Untitied1, Layout\Main]

Bl Fic Edit View Insett Select Config Window Help =18] x|
D[{@] &l ©l=] &] ) = L]

LB {8 ] o] atessie o) |

[l
Far Help. press F1 [Selected=0 [3257 7-11.021 mm [0/ 0mm

Note: We recommend that you always assign the names
BOTTOMLAYER and TOPLAYER to the layers for the solder and
component sides, as CircuitCAM uses these layer names for the
preset isolation job.

You can preview the data before it is imported by clicking on the
PREVIEW- button to allow you to rectify incorrect settings before
importing the data.

The aperture list selected is displayed in the lower section of the dialog
box to give you the opportunity of detecting missing or incorrectly
defined apertures in advance.
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Figure 43:
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The dimensions of the data to be imported and the Gerber parameters
(unit, values, decimal position and M.N) are also displayed.

Save your data to protect against data loss.

Do this by selecting SAVE from the FILE menu.

The document will be saved under the filename “TUTOR1” already
entered.

4.3.4 Excellon data

The Excellon data are also in an ASCII file; this defines the drilling
coordinates for the pads and plated-through holes on the circuit board
with the associated tools.

How to import the Excellon data:

» Select IMPORT... from the FILE menu, or click on ﬁ in the
FRONT-TO-END toolbar.

The OPEN dialog box is displayed.

» Select the name “TUTOR1.DRL* and click on OPEN to import the
Excellon-file.

The IMPORT dialog box is now displayed; here you assign each of the
files selected an aperture/tool list and a layer.

Assignments for the Excellon file Tutor1.drl:

Note: Select Excellon from the file type list box if CircuitCAM does
not automatically interpret the file to be imported as an Excellon
file.

» Assign the “TOOLTUTOR1" tool list previously imported to the
Excellon data in the TOOL LIST list field by dropping down the list
box with a click and selecting the “TOOLTUTOR1“ line:

Tool Lizt IT::u:uIT utar j

» Select the name DRILLPLATED from the LAYER list box to assign
the Excellon data to this layer.

CircuitCAM 5.0
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Import C:\LPKF50%Data’Tutorl.del

File-Type: [NC-Diil

Layer : |TEER

Tool List: |T oolTutor!

Walues Unit

(+ Absolute (* mm
" Relative " inch

Decimal Position

" Leading Zeros present

{* Trailing Zeros present

" Traiing and Leading Zeros present
(" Decimal Point

Digits m.r;

Size up

41.54 mm

28.69 mm

Set as Default

L Ltuuu}i

Preview...

Import

Carcel

Taools: Uszed
[ T1
[ T2
T3

Mode

Diarneter

:

» Click on IMPORT to import the file.

The Excellon data have now been imported into CircuitCAM and will
be displayed in the graphic window.

Figure 45:

én-j_l:ilcuiIEAM - Lite - [Untitled1, Layout\Main]

B Fi= Edit

View Insert Select Corfig Window Help

DjE(E| Sl o] K]

=

|

=¥

C )] {815 25| SoLeloios o) el 3

[l

[For Help, press

Fi

[Selected=0

[7.878 7-11.021 mm

—-—> Save your work to protect against data loss.
[{ Do this by selecting Save from the File menu.

(070 mm

——— Note: You may import data into the existing data in CircuitCAM at
[{ any time. All production data (Gerber and Excellon) can be
' imported in one step.

The document will be saved under the filename "Tutor1" already

entered.

The DXF Data import will be explained in the appendix, because it's not
component of this exercise.
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4.3.5 Importing the data using the import assignment

Importing data is significantly easier and quicker if you work with the aid
of import assignment. Before importing, the parameters that were
assigned manually previously in this exercise are predefined in a dialog
box. This means that the data is displayed on the screen as soon as it
has been selected for import.

» Select “TUTOR.CAT* from the FILE-NEW menu.

Import assignment for the Tutor files has already been defined in this
template file.

» Open the GENERAL SETTINGS dialog box from
CONFIGURATION-GENERAL... and click on the IMPORT
Assignments tab.

Figure 46:
General Settings |
Shortcuts | Directories | Uit/ Girid |
Methads Import Assignment | Diverse I Calaurs User
File-5pect | Layer | Aperture,T ool List | Tupe
FRGT TopLayer TOR Gerber ¥
“HGEB BottormLayer  BEOTTOM Gerber %
“ExC DrillPlated TOOLS Excellon
* ddd Eagle 3.0di.. TOOLS AperturedTools =
| | 2]
File-Spec: [*XGT
Layer:
ITopLayer j
Aperture/T ool List: ITDF' j
File-Type: IGerbelX j
Add | Remove |
(0] I Abbrechen I Obermehmen | Hilfe |

All the settings required for importing the Tutor files quickly have been
predefined here. Set your Import assignments in the same way for the
data you wish to import and save it to your own template file. (See
Exercise 6, Own template files).

> Now repeat the import as described above. But select all the files to
be imported (Tutor1.nct, Tutor1.whl, Tutor1.cmp, Tutor1.sld and
Tutor1.drl) using the CTRL key.

Once you have confirmed the selection with OK, the data will be
imported and displayed on screen immediately, without you having to
go to the IMPORT dialog box.
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5.1 Checking production data

We recommend that you make a visual check to ensure that the
imported data have been correctly interpreted by CircuitCAM once all
the data required for prototyping the circuit board have been imported.

Note: You will find a listing of possible display errors, their causes
and how to rectify them in the "Tips & tricks in customizing the
translation file" section of the appendix on page 84.

The following section will describe the functions required to change the
view in CircuitCAM to allow you to complete a visual check on the
imported data. These functions have an important role to play in CAD
programs in making it possible for you to work with the graphical objects
with precision.

5.1.1 Working with the view functions

CircuitCAM has a View menu and a View toolbar. These group together
the functions you need to adapt the scale or the selection of the
graphical representation to your requirements.

There are also a number of keyboard functions for quickly zooming and
moving the selection. Some of this keyboard functions act to the current
cursor position.

How to change the graphical view:

-a] ZOOM WINDOW

Activate this button and drag with the left mouse button pressed to
select an area you wish to see in enlarged form.

*3) ZOOM IN

on this button to enlarge the view by a factor of 2.
Keyboard: PAGE UP

Tal ZOOM OUT

Click on this button to reduce the view by a factor of 2.
Keyboard: PAGE DOWN

[&] OVERVIEW
Click on this button to display all graphical objects in the
workspace.
Keyboard: HOME
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& PREVIOUS

Click on this button to return to the previous view.
Keyboard: INSERT

%| REFRESH
Click on this button to have the graphical objects redrawn.

Use the CURSOR KEYSon the keyboard and the scrollbars to move the
selection area.

Press END to center the selection area on the mouse position.

5.1.2 Working in the layer list window

The VIEW toolbar also includes the Layer button kel which you can
use to open the Layer list window. This list window shows all the existing
layers with their current settings:

Figure 47:

.t..l"1||:|:|| QPSl/-l?Da;l El lE,..El,.l\.'I_.l Close ”

Layer Name | Order | Color | Flash | Wizible | Selectable | Tre ... | 0. | ... |

i | ] O 0O

| ] O 0O

L O O 0O
£ Diillnplated 2 m = O 0O
£ BoardOutline 30O O O 0O
£ TestTop L | ] O 0O
£ TextBoattom 1B O [} o 0O
£ CuttingDutside 16 m ] o 0O
£ Cuttinglnzide 17 m = O 0O
£ SoldetaskTop 1 | [ ] O 0O
= SolderMaskBottom 19 m O O 0O
£ SolderPasteTop 25 ] ] O 0O
£ SolderPasteBattom X m O O 0O
& SikScreenTop O O O 0O
£ SikScreenBattom 2 ] O O 0O
£ RuboutTop 2 m 7] O
£ FrameTop O | ] O
£ RuboutBottom 2 m m O
£ FrameBottom 2 m O (]
£ RuboutdliLayer 24 o ] O
£ FramedliLayer 23 m o O
£ InsulateTop__Std 5 | [ ] O O 0O
£ InsulateTop__Small E O o O o 0O
= InsulateTop_Big Tom ] O O 0O
£ InsulateTop__Bigger i om O O O 0O
g InzulateB attarn_ Std 10 O ] O O 0O
£ InsulateBattom__Smal 1 ] =] O O 0O
£ InsulateBattom__Rig 12 O ] O O O
£ InsulateBottom__Bigger 17 m = O O 0O

The toolbar at the top of the list window also gives you access to these
other functions:

1> CREATE NEW LAYER

x| DELETE SELECTED LAYER
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%l EDIT SELECTED LAYER
| NAME LAYER
=2 SAVE
You can change the setting for a layer by clicking on the relevant check
box thereby either enabling it ¥ or disabling it[] .
Open the following dialog box by selecting a layer and clicking on %l -
Figure 48:
Layer: ToplLayer HE
W Wishle
¥ Selectable Cancel |
¥ True width w |
™ Dutline -
. Layer Calor
=
. Flask Color
=
Ef' g Note: You can also call the LAYER dialog box by clicking on the
= line of the appropriate layer with the right mouse button.
The following overview will clarify for you the effects of the TRUE WIDTH
and OUTLINE ILLUSTRATION settings:
Figure 49:

True width
O

Outline-illustration

TRUE WIDTH

obe

ofo

TRUE WIDTH
O

cée

0bo
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The graphical objects in the individual layers are displayed in the graphic
window as superimposed levels. The ORDER COLUMN in the LAYER
list window indicates to you the level down from the top layer of the layer
in the list.

Figure 50:

1

|2

|3

Remember that graphical objects in a lower level can be concealed by
graphical objects in a higher level.

» Click on the number of the layer which is to become the highest level
in the ORDER column of the LAYER list window.

The number 1 will be assigned to this layer in the ORDER column and
the number of all other layers will be incremented by one, so that these
layers are now one level deeper.

7 >  Note: You specify the properties of the individual layers, but not the
active layer, in the LAYER list window.

Select the active layer from the LAYER list box in the DEFAULT toolbar.

The active layer is the layer in which new graphical objects may be
drawn, for example.

Make sure that you do not have an object selected when you change the
active layer, as otherwise it will be moved to the newly selected layer.

E/ 77> Note: You will find a full description of the other functions in the list
U window in the CircuitCAM online help.

i

The new layers available in CircuitCAM 5.0 - Insulate bottom (small,
standard, big and bigger) - are layers for optimizing the routing process.
A correspondingly narrow to extremely wide tool is assigned to the
layers. For example during the insulate production phase, a tool as wide
as possible is selected or requested automatically for large or wide
routing surfaces. If the insulating strip to be cut is extremely small, a very
small tool is selected. This selection is accomplished automatically by
the software.

How to make a visual check on the imported data:

> Click on &l in the VIEW toolbar or press HOME to display all
graphical objects within the workspace.

» Click on the right mouse button and click now on MEASURE in the
just opened menu.
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» Select a point in the graphic, from which the measurement should be
started, e.g. the lower left corner of the circuit board frame.

» Push the Mouse pointer to the endpoint of your measurement.

On the left in the status bar the removal is indicated as kartesic and
polar coordinates.

Our sample circuit board has the dimensions 55.88 x 38.1mm.

Note: You may choose between millimeters, microns, inches and
mils (1/1000 inch) as the units in CircuitCAM; the default is
millimeter.

Change the unit using the UNIT list box on the GRID+UNIT toolbar
or in CONFIGURATION/GENERAL SETTING under the UNIT/GRID
tab.

» Click ESC to finish the measurement.

Use the VIEW functions in CircuitCAM to zoom in on areas of the circuit
board and to check the layers for cover.

5.2 Preparing production data for prototyping

In this section you will learn how to prepare the production data for the
fabrication of a prototype circuit board. This involves the deletion of
superfluous graphical objects, the addition of milling data and moving
graphical objects onto other layers.

5.2.1 Deleting graphical objects outside the circuit
board

The various layers often have registration marks outside the circuit
board outline, as is the case with our sample circuit board. You might
also think of other objects instead of the registration marks, such as
labeling fields, company logos, etc.

However, only those objects inside the circuit board outline are of
interest for the production of the prototype circuit board, and so all
objects outside this can be deleted.

Objects must be marked before they can be deleted:

* You can mark individual objects by clicking in the immediate
vicinity of the object to be marked with the left mouse key.

» To mark larger areas, hold the mouse key depressed and drag
the mouse pointer diagonally across the surface to be marked.

Objects must first be selected before they can be deleted. CircuitCAM
has a number of functions you can use to influence the way in which
objects are selected to ensure that only the object desired is selected,
and not other objects beneath, above or near the object. These functions
may be found in the SELECT menu or on the SELECT toolbar:
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= SELECTING LAYER OBJECTS

Click on this button to select the entire active layer.
The active layer is selected from the LAYER list box or by
selecting a graphical object.

x| SELECTING APERTURES/TOOLS OBJECTS

Click on this button to select all graphical objects created with
the active aperture or the active tool. The active aperture or tool
list is selected from the APERTURE/TOOL list box or by
selecting a graphical object.

Q) SELECTING ALL OBJECTS

Click on this button to select all layers.
(this function can also be activated by clicking on ALL in the
main menu SELECT).

The following switches may be used to determine what kinds of
graphical objects may or may not be selected:

Al LINE SELECTABLE
Lines may be selected if this button is enabled.

5 POLYGON SELECTABLE
Polygons may be selected if this button is enabled.

%] CIRCULAR SELECTABLE
Circles may be selected if this button is enabled.

5 RECTANGLE SELECTABLE
Rectangles may be selected if this button is enabled.

A FLASH SELECTABLE
Pads (flashes) and drillings may be selected if this button is
enabled.
All switches are enabled in the default setting (everything may be
selected).

£ T Note: You can change temporarily from the current selection mode
(@j) to the Plus mode by holding down SHIFT and

to the Minus mode by holding down CTRL.

The original mode is re-enabled when the key is released.

You can remove the selection by clicking on K| in the View toolbar.

If just one object is selected, the handles for the selected object will be
displayed:
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Figure 51:

G+nm
o0l

The handle closest to the cursor position when you clicked is displayed

asacross ¥ andserves as the anchor point. The selected object can
therefore also have the following representations:

Figure 52:

G- G.-?

%

o0 00d

The anchor point coordinates are displayed in the Status bar.

Jp Note: Use the + or - keys to move the anchor point to the next
handle on the selected object.

&
i3

If a number of objects are selected, the selected objects are shown in a
different color and the number of objects selected is shown in the
STATUS BAR

> Note: Select PROPERTIES from the CONTEXT MENU (right mouse
‘ button) to view or modify the properties of a selected object.

Note: Select GENERAL ... from the CONFIGURATION menu to
\

modify the methods for editing graphical objects to your
requirements in the METHODS tab.

HOW TO DELETE OBJECTS OUTSIDE THE CIRCUIT BOARD:

» Make sure that all selection switches are enabled in the Select
toolbar so that it is possible to mark all graphical objects:

Figure 53:

[ARINRR

» Click on E in the SELECT toolbar to enable the NEW selection
mode.

» Drag a box around the two upper registration marks using the left
mouse button to select the text between them:
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Figure 54:
é
B
=
z
» Click on 3l in the SELECT toolbar to enable the PLUS selection
mode.
» Drag a box around the lower registration mark using the left mouse
button to select them as well:
Figure 55:

&

EEBST@4ET 2909 _d}

BIMRED FEIUOEI DE

N

All the objects outside the circuit board are now selected.

> Clickon Xl in the DEFAULT toolbar or press DELETE to delete
the selected objects.

Tips&Tricks:

You can cancel an action by pressing ESC

Click on 2| in the Default toolbar or press CTRL + Z if you wish to undo
one or more actions.

Click on £ in the Default toolbar or press CTRL + Y if you wish to redo
an action you have undone.
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5.2.2 Moving the circuit board outline to a separate layer

In our "Tutor" sample circuit board, the circuit board outline is located on
the solder side and on the component side and thus on an electrical
layer.

It is sensible to place the circuit board outline on a separate mechanical
layer to ensure that the circuit board outline is not milled along with the
conductor tracks and pads, but that the circuit board outline is milled by
itself.

In the operations described below, the circuit board outline on the
component side ("TopLayer") is first selected and then moved to the
"BoardOutline" layer. The circuit board outline on the solder side
("BottomLayer") will then be deleted.

How to select the circuit board outline on the component side:

Note: As the circuit board outline on our sample circuit board is

located on two different layers, it is useful to assign the property
not selectable to one of the two layers to make it easier to select
the other layer.

Note: This procedure is always recommended when you wish to
show a number of layers, but only wish to edit a specific layer.

Note: Where objects in different layers are located at the same
position, CircuitCAM also allows you to toggle through these
objects by clicking on them a number of times, i.e. a different
object at this position will be selected with each new click. Note:
during multiple click take care to the shape of the cursor to avoid
modifications by mistake.

» Reset the SELECTABLE property for the BOTTOMLAYER layer in
the LAYER list window.

o] Roslsalts] BI[T 2] cwse ||

’iayewame [ Oider | Color | Flash | Misible | Selectable | True Width| Ouline | Used
=

] ] O O
= = O O O
] [m] O O

[T}

This will make it easier for you subsequently to select the circuit board
outline on the "TOPLAYER" layer in the graphic window.

» Click on CLOSE to close the LAYER list window.

» Click on the upper left-hand corner of the circuit board outline in the
graphic window to select it.
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Figure 57:
S N
L ‘rE %
< = Note: You must always click on a handle of an object, i.e a corner
point, to select it.
If you click on an object between two handles, you may select
another object close by.
The circuit board outline on the component side (TopLayer) is selected
and the solder side layer (BottomLayer) has the property NOT
SELECTABLE:
Figure 58:
% |
n% n
%
E
How to move selected objects to a different layer:
» Select BOARDOUTLINEfrom the LAYER list box on the DEFAULT
toolbar to move the selected circuit board outline to this layer:
Figure 59:
BoardQutline j
BoardQutline
TextTop
TextBottom |

» Press ESC to deselect all graphic objects.

The circuit board outline on the solder side can now be deleted.

» Setthe SELECTABLE property for the BOTTOMLAYER layer in the
LAYER list window.

» Setthe NOT SELECTABLE property for the BOARDOUTLINE layer
in the LAYER list window.

» Select the circuit board outline on the BOTTOMLAYER layer in the
graphic window.

» Press DELETE to delete the selected circuit board outline.

> Press HOME to redraw the picture.
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5.3 Direct Coordinate Entry

In CircuitCAM you can also activate mouse clicks by coordinate entry.
Selecting a certain position as well as redrawing an object have been
improved. A number of coordinates can be entered in sequence without
terminating the function. This considerably accelerates generating front
boards or RF layouts.

The following description is an example and is not part of the exercise.
However, you can practice this function on any desired open file as
follows:

» Select a layer.

» Select the POLYGON tool or CLOSED LINE.

» Select PROCESSING, SET CURSOR in the main menu bar.

The following window appears:

Set Cursor Point 2| x|
o IIj m Cancel |
% Ahsolute
= Set |

" Relative

» Make the following entries in the SET CURSOR POINT window:

x=0 x=10 x=10 x= 0
y=0=>8SET y= 0=>SET y=10=>SET y=10=>SET

Confirm with SET after entering each coordinate (x and y) .

» Then close the window by clicking OK.

5.3.1 Placing text objects on separate layers

It can also be useful to move text objects to a separate layer. As
CircuitCAM does not distinguish between text objects and conductor
tracks when these are located on the same layer, text objects would
otherwise be isolated just like conductor tracks:
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Text on electrical layer: Text on separate layer

LPKP LPKF

Since the procedure for moving text objects onto a separate layer is
comparable with moving the circuit board outline to the
BOARDOUTLINE layer, we will only describe the various operations in
general terms here.

How to place text objects on a separate layer:
» Select the text objects on the component side.

» Select TEXTTOP from the LAYER list box on the DEFAULT toolbar
to move the selected text objects to this layer:

» Select the text objects on the solder side.

» Select TEXTBOTTOMfrom the LAYER list box on the DEFAULT
toolbar to move the selected text objects to this layer.

» Press ESC to unselect all graphic objects

Note: You should also move the fastening holes from an electrical
layer to a mechanical layer, e.g DRILLUNPLATED just like the
circuit board outline and the text objects.

Save your work to protect against data loss.

Do this by selecting SAVE AS... from the FILE menu. Enter the
name "TUTOR2" and press OK.

The document will be saved under the filename "TUTOR2" already
entered.

5.3.2 Isolating with the default job

CircuitCAM offers default jobs which may be used for most circuit boards
without modification of the isolation parameters to calculate the isolation
channels. Later you will learn how you can customize the defaults for
calculating the isolation channels individually.

The FRONT TO END toolbar groups together the functions required in

the preparation of production data for passing on to BoardMaster,
including the function for isolation using the default job:

m ISOLATE COMPONENT SIDE AND SOLDER SIDE

CircuitCAM 5.0
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How to calculate the isolation channels using the default settings:

» Click on @ in the FRONT TO END toolbar to calculate the
isolation channels for the solder side and the component side in a
single operation.

Note: Calculation of the isolation channels may take some time
depending on the number of graphical objects and the parameters
set such as the isolation grid.

In addition, the processor performance and the amount of memory
in your computer are important factors for the time requirement.

After calculation, the isolation channels are represented graphically.

In this case, the cutting tracks are illustrated corresponding to the tools
used in the colors assigned in each case ( see ,,Color Assignment for
Insulating Tools" on page 82).

The isolation channels are illustrated graphically after calculation. The
isolation channels on the component side are located in the
"INSULATETOP"layer, those on the solder side on the
"INSULATEBOTTOM" layer:

Component side ("InsulateTop") Solder side ("InsulateBottom™)
o DDE =

o T

[ Q00— o o o

DE!T:F ooos

[ IIIIIIIIII
=

¥

Note: Save your work to protect against data loss.

Do this by selecting SAVE from the FILE menu.

The document will be saved under the filename "TUTOR2" already
entered.

5.3.3 Preparing for Production Data Export

As of version 5.0 CircuitCAM also offers the possibility of checking the
tool lists before exporting to ensure that an appropriate tool has been
defined for all holes to be drilled and that different tools have not been
defined for the same hole dimensions or routing areas. This offers the
advantage that errors can be avoided for later tool assignments when
the tool lists are made up. This checking and adapting work is required
only when the standard lists and jobs have been changed. If you have
not changed any of the standard lists, you can skip the next chapter
“Checking the Tool Lists”.
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5.3.3.1 Checking The Tool Lists

Check the tool list as described below if required:
» Click CONFIGURATION, then FORMATS, then LPKF CIRCUIT
BOARD PLOTTER TOOL LIST.

» Then double click LPKF DRILLING TOOLS in the list displayed.
The following window appears.

Figure 62: Tool list

AR+
g

.30 G|x|%

El IE ._.El.l\.'l_.l Close I

| Mode | Type | a | b | c | Used
Spiral Dnll 0.2 mom E O 0.2 mmn 0
Spiral Drill 0.3 mm 4 O 0.3 mm O
Spiral Dl 0.4 mm 4 B 0.4 mm O
Spiral Dl 0.5 mm 4 D] 0.5 mm O
Spiral Diill 0.6 mm = O 0.6 mm O
Spiral Drill 0.7 rarn [ O 0.7 mm O
Spiral Dl 0.2 mm E O 0.8 mm O
Spiral Drill 0.9 mm 4 O 0.9 mm O
Spiral Dl 1.0 mm 4 B 1 mm O
Spiral Dl 1.1 mm 4 D] 1.1 mm O
Spiral Drill 1.2 mm = O 1.2mm O
Spiral Dl 1.3 ram [ O 1.3 mm O
Spiral Drill 1.4 ramn [ O 1.4 mm O
Spiral Drill 1.5 mm 4 O 1.5 mm O
Spiral Dl 1.6 mm 4 O 1.6 mm O
Spiral Dl 1.7 mm 4 B 1.7 mm O
Spiral Diill 1.8 mm = O 1.8 mm O
Spiral Drill 1.9 rm [ O 1.9 mm O
Spiral Dl 2.0 rarn [ O 2 i O
Spiral Dnll 2.1 mm E O 21 mm O
Spiral Dl 2.2 mm 4 O 2.2 mm O
Spiral Dl 2.3 mm 4 B 2.3 mm O
Sipiral Diill 2.4 mm = O 2.4 mm O
Contour Router 2.0 mm E O 2 mm 3 —_ﬂ O

» Itis only necessary to click the £ button to display the list of
drilling tools. —

Here the drilling dimensions are displayed graphically in relation to
one another on the right side of the tools (see figure below)
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Configltem Mame ‘

a

S|%| B &2 M close
[

1

‘ Diill gaps and overlaps ‘

Spiral Drill 0.2 rm
Spiral Drill 0.3 mm
Spiral Drrill 0.4 rm
Spiral Drill 0.5 rm
Spiral Drill 06 mm
Spiral Drill 0.7 rm
Spiral Drill 0.8
Spiral Drill 0.9 rm
Spiral Drill 1.0 mm
Spiral Drill 1.7 rm
Spiral Drill 1.2 rm
Spiral Drill 1.3 mm
Spiral Drill 1.4 rm
Spiral Drill 1.5 rm
Spiral Drill 1.6 mm
Spiral Drill 1.7 rm
Spiral Drill 1.2 rm
Spiral Drill 1.9
Spiral Drill 2.0 rm
Spiral Drill 2.1 rm
Spiral Drill 2.2 rm
Spiral Drill 2.3 mm
Spiral Drill 2.4 rm
Contour Rauter 2.0 mm |
G aps:

0
0.25mm
0.35 mm
0,45 mm
0.55 mm
0.65 mm
076 mm
0.85 mm
0.35 mm
.05 mam
115 mm
1.25mm
1.35 mm
1.45mm
1.55 mm
1.5 mm
1.75 mm
1.85 mm
1.95 mm
206 mm
215 mm
2.25mm
235 mm

0.2 mm
0.3 mm
0.4 mm
0.5 mm
0.6 mm
0.7 mm
0.8 mm
0.9 mm

T mm
1.7 mm
1.2mm
1.3 mm
1.4 mm
1.5mm
1.6 mm
1.7 mm
1.9 mm
1.9mm

2 mm
21 mm
2.2 mm
23 mm
2.4 mm

0.25 mm 5§

0.35 mm
0.45 mm
055 mm
0LES mm
0.75 mm
085 mm
0.95 mm
1.05 mm
115 mm
1.25 mm
1.35 mm
1.45 mm
1.55 mm
.65 mm
1.76 mm
1.85 mm
1.95 mm
2.06 mm
215 mm
225 mm
235 mm
245 mm

e}

=
= oL
e}

==}
I e had
opF0oooooooooOooOoOoOoOoOoOn

Mot available

If two or more drilling dimensions for various tools overlap, this is
indicated graphically by accordingly shaded areas (see figure below).

Figure 64: Tool overlapping

b

=

b
F]

In this case the tool to be corrected should be changed so that the

overlap is corrected or eliminated.

» For this purpose open the settings window by clicking the
appropriate tool in the list with the right mouse key.

The following illustration appears.
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Figure 65: Flash

Figure 66: Diverse

Exercise 2

Aperture/Tool : Spiral Dnll 1.2 mm

Flash |Transf0rm| Diraw I Diversel

G‘ a: |1.2mm ffe IDmm
~

= Sguare b ID i 9 IDmm
" Rectangle c: ID i h: ID i
" Rounded Rectangle

" Beveled Rectangle d: ID (617 i IDmm
" Dctagon . I

(g Undegfined i ID o . IUmm
" Marker

" Special a=Diameter
~

-~
Off

IEC1182: I vl .

) Position

Edit | * Datum

ak. I Cancel | Lppl | Help I

Here you can set the diameter of the tool as required.

» Click on DIVERSE.
The following illustration appears:

Aperture/Tool : Spiral Drill 1.2 mm [ |

Flazh I Transfnrml Draw  Diverse |

Mame : Spiral Drill 1.2 mm

Capture [nterval for Export [Flash)

V¥ Uszer Defined

bdin - Maw:
a: |1.15 mm |1_25 i
b: ID mm IEI T

ar. I Caticel | Sl | Help |

Here you can define the range of drill diameters to which the tool in
question is to be assigned under CAPTURE RANGE FOR EXPORT.
Any overlaps with other tools or gaps in the dimension settings, where
no tool is assigned, can be corrected here by changing the values.

With the same procedure you can check or correct the milling tool. Here,
however, it is necessary to click the 11| button after double clicking

LPKF MILLING TOOLS (see beginning of chapter) to access the milling
tool list. The catch areas for the milling tools are displayed accordingly.
Overlaps are marked as described Figures 66 “Tool dimension
overlapping” on Page 63, and gaps are marked according to the
following illustration:
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Figure 67: MaRfehler bei
Fraswerkzeugen

] SRS e T e Il
End Mill 0.8 mm [31 mil] 076mm  0.8mm 0.34 mm B4

End Mill 1.0 mm [33 mi] 0.95 mm 1 mm 1.05 mm B

End Mill 2.0 rarn [73 mil] 1.9 mm 2 mm 2.1 mm [—)(—]

End Mil 3.0 mm (118 ml) 285 mm 3 mm 215 mm [—)H

Gaps:

S

——— Note: Gaps and overlaps are actually necessary and desirable for
milling tools. For this reason, make all changes with extreme care!!

5.3.3.2 Export production data

Once the isolation channels have been calculated, the prepared
production data can be exported to allow production of the prototype
circuit board using the BoardMaster software and your prototyping
system.

The LpkfMillDrill(LMD) binary data format was developed to optimize the
link between CircuitCAM and BoardMaster. The production data from all
the layers of a job can be captured to one file in the LMD format.

How to export production data in the LpkfMillDrill format:

» Select LPKF CIRCUIT BOARD PLOTTER from the EXPORT-LPKF

submenu of the FILE menu or click on E in the FRONT TO END
toolbar.

yoE= Note: It is possible to select between 3 different jobs in the LPKF
(i File Export Menu:

» LPKF Circuit Board Plotter:

This is the standard export job. As a matter of principle all
applications can be handled with this job.

* LPKF Circuit Board Plotter Galv THP:

With this job the production phases for the AutoContac
system are not output. This has the advantage, that
superfluous error messages regarding the AutoContac
system are avoided.

» LPKF Circuit Board Plotter No THP:

With this job no through-contacts of any type are planned.
Some of the production phases are consolidated (e.g. all
drilling phases ...). This facilitates more rational work
(particularly with ProtoMat 95/x).

The file created will be saved to the working subdirectory ("Data")
under the same name as the CircuitCAM file, but with the file
extension ".LMD".
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Figure 68:

Exercise 2

Following the export, the REPORT WINDOW displays information

regarding the data exported, with any error messages.

Note: You can also export the production data in the most common
CAD formats such as Gerber, Excellon and HP-GL (only PCB

version) in addition to the LpkfMillDrill format.

» Do this by selecting the appropriate line in the Export submenu of the

File menu.

File Edit View Insert Select Config  ‘Windo

e 3
Open Chl+O
Close

Save Ctrl+5
Save As..,

Save Al

Import... Alk+I

LPEF
Gerber

Print. .. Chrl+P
Prink Presview, .
Print Setup...

Excellon
HP-GL
Diverse

- v row v

1 Tutar, cam DxF

2 TestDateiFuerDyFModifikation. cam
3 TestFileForDxFModification, canm
E:xit Alt+F4

To conclude the second exercise, you can now close the "TUTOR2"

document by selecting CLOSE from the FILE menu.

Note: If the program BoardMaster should have started before the
exporting the data, the exported Imd-file immediately is imported
by BoardMaster and placed in the center of the material working

area.
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In this chapter you learn, how to use the contour generator and the
inserting of break-out-tabs. Furthermore the generating of surfaces by
removing all the residual copper is shown.

6.1 Using contour routing

Should you wish to have the circuit board milled out by the circuit board
plotter rather than having it cut to size by a circuit board guillotine you
can use contour routing to calculate the milling contour.

Use the CircuitCAM file "TUTOR1.CAM" again for the following
exercise:

» Select OPEN from the FILE menu.
» Select the “TUTOR1* file and click on OPEN.

Note: Once you have opened the file "TUTOR1.CAM" in
CircuitCAM, you should save this document to a different file name
to ensure that the original data remains available to you for further
exercises.

» Select SAVE AS from the FILE menu.
» Enter “TUTORS3 as the filename and click on SAVE.

You may select either a selection or a layer as the source for the milling
contour. A selection will be used as a source in this exercise, as the
circuit board outline for this circuit board is located on the "TOPLAYER"
and "BOTTOMLAYER" layers together with the conductor tracks and
pad.

Note: If you are having the circuit board milled out by the circuit
board plotter, it is no longer necessary to place the circuit board
outline on a separate layer, as was the case in exercise 2.
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How to create a milling contour:

» Select the circuit board outline in the TOPLAYER layer.

Figure 69:

*
—
J
7
-
=

| 1 n
=]
CTJ

> Click on | in the FRONT TO END toolbar to open the CONTOUR
ROUTING dialog box:

Contour Houting EHE3 |

" Inzide ok,

Source

Cancel

i

& Cument Selection

' Layer Fiun
| [
Destination Layer:
IEuttingDutside LI
uzed T ool
Lizt Toal
LpkfCuttingT ools =l |EndMil 2.0 mm (7 mi)long =]

Gap Wwidth : I'I mm

< = Note: If the circuit board outline for the circuit board is already
[g placed on a separate layer, e.gon the "BOARDOUTLINE" layer, you
may use this layer as the source for calculating the milling contour
by clicking on the LAYER radio button and selecting
BOARDOUTLINE from the LAYER list box.

» Click on RUN to generate the milling contour.

Once calculation is complete, the milling contour will be displayed in the
graphic window:
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Figure 70:
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You can delete the circuit board outline from the "TOPLAYER" and
"BOTTOMLAYER" since the milling contour has now been generated
on the "CUTTINGOUTSIDE" layer:

» Press DELETE to delete the circuit board outline, which is still
selected, from the "TOPLAYER" layer.

» Select the circuit board outline in the "BOTTOMLAYER" layer.
» Press DELETE to delete this circuit board outline.

Caution! The circuit board would be completely milled out of the
board material with the current contour and could be thrown about
by the rotating milling head.

Caution! It may therefore be desirable to leave the circuit board
connected to the board material by at least two break-out-tabs to
prevent personal injury and damage to the circuit board plotter.
The gap width is defined in the Contour Generator Dialog Box.

How to insert the break-out-tabs in the milling contour:
» Select the contour generated on the "CUTTINGOUTSIDE" layer

Figure 71:

% = PPF%”.‘UWH’”Q;‘TQ — %

IDE

T

|
GIMRD FETCE
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» Use the + and - keys to move the anchor point#* from handle to
handle on the contour line.

Figure 72:
=W — = =
BlleslsyCEE
| *
1
» Press CTRL + G or click on [l in the FRONT TO END toolbar to
insert a tab at the anchor point position:
Figure 73:
—
1[N Feyra-1
u m »u
» Repeat steps 2 and 3 to insert break-out-tabs at subsequent
positions:
Figure 74:

*%* i B aaag ‘ %;

= =

- ?.I

=» 0 At

GOMRO BJIUORIDE

You have now generated a milling contour in which the circuit board is
connected to the board material by five break-out-tabs:
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Note: To save the current position of the exercise, select SAVE
from the FILE menu.

The document will be saved under the file name "TUTOR3" already
entered.

6.1.1 Modifiable Milling Direction and Sequence

In order to process interior and exterior contours optimally, you can
define the milling sequence as well as milling direction. For this purpose,
it is possible to consider your special requirements for comprehensive
and/or irregular contours with numerous breakout tabs for various
applications. To use this function proceed as follows:

» Select a milling channel by clicking the left mouse buttom.

» Select EDIT, SWAP ... in the main menu bar.
The following menu appears:

Curve k

Diverze k

tove to next  Chrl+l
tove to pres Crrl+l
b ove b first  Chrl+F
Move tolast  Crrl+l

Here you can select whether the milling path is to be cut first or last.
Move to first: This conductor is cut first.
Move to last: This conductor is cut last.

Move to next, next to previous: Moves the cutting path forward or back
one step in the sequence.

At the bottom left of the screen, you can check the sequence in which
the conductors will be cut (see figure below).
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Figure 77:

Exercise 3

y
#1 : Open path zelected [4:1 Ling), width 0,203 mm

If the lines are to be checked, each individual line must be clicked.

In order to check the cutting direction of a line, click on it with the left
mouse key. The properties of the line are shown in the status display line
( see figure 77). While the line is selected, you can also determine the
direction by means of the + or - keys on the keyboard. If the marking
moves along with the + key, then this is the actual cutting direction.

The optimum cutting direction for a cutting path depends on which side
of the cut is to be the “good” side. With the function EDIT - CURVE -
REVERSE you can change the cutting direction. When the cutting path
is selected and the <+> key pressed, the anchor point moves in the
cutting direction. However, observe the circuit board side. Data for the
bottom layer is mirrored in BoardMaster, resulting in a reversal of the
cutting direction as well.

6.2 Create rubout area

A rubout area is a zone in which not only the isolation channels around
conductor tracks and pads are milled, but also all the residual copper
between the conductor tracks and the pads are removed from the circuit
board. This operation can be sensible for technical reasons (e.g. EMV)
as no electrical potential is assigned to this residual copper.

You will find the functions for creating a rubout area in the RUBOUT
AREA submenu of the INSERT and in the FRONT TO END toolbar:

Rl
=4 | RUBOUT AREA ALL LAYERS

creates a rectangular Rubout area on the top and bottom side
of the circuit board.

You can define the range of the Rubout area using the following drawing
functions which can be found in the GRAPHICS toolbar:

S| pOLYGON

is defined by any number of handles set by mouse click.
The polygon is finished by pressing ESC once the last handle has been
set. The function is concluded by pressing ESC once again.
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Figure 78:
© K
@ 'k
) ‘k
)
: pl‘
® <ESC>
B| RECTANGLE
(default setting for Rubout area)
dined by two mouse clicks:
Figure 79:
e |
N
™ m
°Q
N
The “rectangle” function can be terminated by pressing ESC.
®l cireLE
defined from the centre point by two mouse clicks:
Figure 80:

X m
AN
© @

The CIRCLE function can be terminated by pressing the ESC key or by
entering a circle diameter manually.

position numerically from the keyboard by selecting SET
CURSOR... from the EDIT menu.

The SET CURSOR dialog box will be displayed and you can enter
the new cursor position in the text boxes:

[ﬁ‘r » Note: Instead of clicking with the mouse, you can enter the cursor
;\ 53
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Figure 81:
Set Cursor Point EHE

Ly I|J frh Cancel |
* Absolute
Set |

" Belative

» Click on SET to accept the values.

The Set cursor function corresponds to a mouse click at the position
entered and can thus be used for drawing graphical objects precisely.

Three predefined layers are available for drawing Rubout areas,
"RUBOUTBOTTOM?" for the bottom side of the circuit board,
"RUBOUTTOP™ for the top face of the circuit board and RUBOUT ALL
LAYERS for both sides of the circuit board (standard).

You will be creating the Rubout area on both sides of the circuit board
around the 14 pin SMD IC in the following exercise.

How to generate a rubout area:

» Click on E@ in the FRONT TO END toolbar to create a rubout

area on both sides of the circuit board.

The RUBOUT ALL LAYER /ayer is now active, the default for the
rubout area shape is RECTANGLE.

Note: You can select a different shape for the rubout area by

[j( . clicking on &| (POLYGON) or @| (CIRCLE) on the GRAPHICS
toolbar.

Use the view functions to position the rubout area precisely.

» Click above and to the left of the 14 pin SMD IC to set the starting
point of the rectangle:
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Figure 82:
[28.769 713,981 mm %
> Move the cursor down and to the right to draw the rectangle around
the SMD IC:
Figure 83:

» Click again to set the end point of the rectangle.

» Double Click on ESC to toggle from graphic mode back to selection
mode.

The rubout area is now defined.
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(“ > Note: If a Rubout area should be defined only on one Circuit board

¥

side, choose after click on E the corresponding layer (RuboutTop
| RuboutBottom) from the List box LAYER in the standard tool bar.

Note: Naturally you can also define a number of rubout areas of
different shapes on one circuit board.

Note: Since a rubout area is a graphical object just like any other,
you can also select rubout areas resize, reshape, move and delete
them.

defined precisely, but can simply be drawn over the conductor
tracks and pads just like in the exercise. All the conductor tracks
and pads located in this area are taken into consideration when
calculating the isolation channels.

D
e
6
[r> ; Note: The residual copper area to be removed does not need to be
-

T Note: Any text objects over which the rubout area is positioned
E: must be located on an electrical layer, so that they are also taken
into consideration in the calculation of the isolation channels for
the rubout area.

select SAVE from the FILE menu.
The document will be saved under the filename "TUTOR3" already

(“' > Note: To save the current position of the exercise,

entered.
oy Note: At the end of the exercise 3 you can close the document
E: "TUTOR3" by clicking on CLOSE in the menu FILE.

< 5 Note: You are now familiar with the basis functions of CircuitCAM
for preparing production data for circuit board prototyping.

EC* ©  Note: A list of the predefined layers and insolating jobs in

CircuitCAM is given in the appendix; moreover we show you the
parameters required for defining an output job and how you can
match a translation file to your circuit board CAD program, to
obtain your prototype circuit board quickly.

£ T Note: Also use the sample circuit boards “TUTOR” and
@j) “EAGLETUTOR?” to familiarize yourself with other CircuitCAM
functions.

£ T Note: Detailed information on every function is given in the
@j) CircuitCAM online help and in the reference manual.
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7.1 Customize isolation job

CircuitCAM incorporates a number of preconfigured jobs which you can
use for calculating the isolation channels (see appendix).

Thus, for instance, in the FRONT-TO-END toolbar, the jobs
“INSULATEDEFAULTTOP...” and “INSULATEDEFAULTBOTTOM...”
are assigned by default to the button with the functions INSULATE ALL

LAYERS @ .

CircuitCAM has the INSULATE dialog box in the EDIT menu for
customizing the preconfigured jobs and creating new jobs.

Open the ISOLATE dialog box by selecting INSULATE... from the EDIT
menu. The dialog box is divided up into two pages to which you can
jump by clicking on the tab.

The illustration in figure 84 shows the configuration for the
“INSULATEDEFAULTBOTTOM?” default job.

7.1.1 CircuitCAM - Lite

Settings on the Start tab

Insulate E
Main | Adwvanced I
—Job
Delete |
Save |
IInsuIateDefaultBottom j E—— |
— Tool Lapout Tracking
Standard : ILIniversaI Cutter 0.2 mm [8 mil] j g 1
Rubaut : [End Mill 1.0 mm 33 mil =l i _ﬁm
—Width
Baze [All] Special [Padsz)
Run
|D.2 T |D.3 i
ok I Cancel | Anply | Help |
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Figure 85:

Exercise 4

JOB:

Select the side of the circuit board for which the job is to be executed.
The corresponding layer, “TOP” or “BOTTOM”, will then be used
automatically.

TOOLS:

Here you should define the tools that will be used for milling the circuit
board. The Lite version has two tools available for removing the copper
areas most efficiently and quickly.

Click on =] to drop down one of the list boxes from which you can select
the tool required:

Insulate E

Main | Advanced I

—Job

" Top [Component Side] &I
& Bottom [Solder Side] Save |
I InzulateD efaultBottom j Saveds, |

— Toal Layout Tracking
Standard : |HfE C 0.2 ro [ mil] g E
Rubout : [|] Lt 3?] —ﬁm

. bicro Cutter 0.1 mm (4 mil]
i Width—————— I Micra Cutter 013 mm (5.1 mil] I

Base (Al End Mill (RF] 0.15 mm (6 mil]
ase End Mill (RF) 0.25 mm (10 mi) B
02 mm End Mill [RF) 0.4 mm [16 mil]
End Mill 0.8 mm [31 mil]

End Mill 1.0 mm (39 mil] =
End Mill 2.0 rm (79 mil]
End bill 3.0 e (178 ol

ok Cancel | Lol | Help |

ISOLATION WIDTH:
Specify the width for the isolation around all electrical objects (conductor
tracks and pads) in the Default text box.

You can enter the width of the isolation around the pads that have been
created by flash apertures in the Special text box.

PREFERRED DIRECTION:

Clicking on one of these two buttons allows you to define the preferred
direction of the conductor tracks on the side of the pcb selected. The
milling tracks within the Rubout areas are then calculated in accordance
with the preferred direction.

DELETE:

Clicking on the DELETE button deletes the highlighted Isolation Job.

SAVE:

Clicking on the SAVE button saves the modified Isolation Job. The
modification will also be saved to the underlying template file (*.CAT).
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SAVE AS:
Clicking on the Save As button allows you to save the modified Isolation

Job under a new name. The old Isolation Job remains unchanged. The
modification will also be saved to the underlying template file (*.CAT).

Settings on the Advanced tab

Insulate | x|

Main  Advanced |

Laper

Base (Al): [Botomlaper ¥
Special [Padz] : |- Flashed Pads Only - -
Fubout1 : [FubouBotiom =]
Rubout2: [Fubouttllayer v
Destination : W

V¥ Exact base width

Insulation Grid : |0.005 mm
Frimary Overlap [%]: |50

ar I Canicel | Ll Help

LAYERS:

You specify which layers are to be used in calculating the isolation
channels and to which layer the result will be saved in the Layers Group
Box.

The layer RuboutTop or RuboutBottom and RuboutAll layers serve as
the source for definition of the areas in which all residual copper is to be
removed.

REMOVE SPIKES:

Checking this check box removes all the small copper spikes or burrs up
to the size of the diameter of the standard tool. Note that the
calculation and milling time will be longer.

EXACT BASE WIDTH:

Checking this checkbox causes the isolation width specified in the
START tab to be complied with precisely. Otherwise, the maximum
achievable width for the same number of milling passes will be
generated.

ISOLATION GRID:

This value specifies the precision to which the isolation tracks are
calculated. A smaller value means higher precision which means a
longer calculation time. A value of 0.005 mm should be selected for
structures with a conductor track width and minimum distance of 0.2
mm. Higher values (0.05 mm) can falsify the result.

72

Revision: 2.6.04 CircuitCAM 5.0



IRiH

Laser & Electronics

Figure 87:

O
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Note: Since the isolation procedure is grid-based, there is a linear
relationship between the processing time and the number of grid
points to be computed. The finer, thus, the isolation grid, the longer
the calculation takes.

Recommended isolation grid: 0.005 mm

PRIMARY OVERLAP:

It is useful to use different milling tools if larger areas are to be milled
efficiently. The conductor tracks and the pads are first isolated with a
small milling tool to ensure high precision. The remaining isolation area
can then be milled with a larger milling tool.

Specify the value by which the milling path of the next larger tool should
overlap the milling path of the smaller tool in the PRIMARY OVERLAP
text box. If this value is too small, the standard tool will have to be used
unnecessarily at many points (at the corners) resulting in a longer milling
time. If the value is too great, the rubout tool will get too close to the
conductor tracks.

s ‘.

70 %

Tool 2

70 %
1 Tool1T 1
v

Note: The next larger milling path should overlap the smaller
milling path by between 50% and 90%.
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7.1.2 CircuitCAM - PCB

All of the CircuitCAM - Lite Version features are also available in the

PCB version. However, this version has additional features as described
below.

Setting in Main Index

Figure 88:

Insulate [ ]

Main | Advanced |
rdJab

" Top [Component Side] Delete |
" Bottom (Solder Side} save |
I InsulateD efaultE ottom j T |
— Tool
Small: | ﬂ Layout Tracking
Standard : IUnivarsaI Cutter 0.2 mm [ mil] j }
A
Big: IEnd Mill 1.0 mm [39 mil] j
Bigger : I j

~width
Baze [Al] Special [Pads] R
ID.2 mm ID.3 M

Ok I Cancel | Ll | Help |

TOOLS:

In addition to the two tools in the Lite Version, the PCB Version has two
additional tools: The SMALL tool for use on points on the circuit board
which cannot be reached with the standard tool due to its diameter. The

LARGER tool which is used as an additional rubout tool for removing
larger copper areas.
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Figure 89:
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Settings in Advance Index
Insulate E
Main  Adwanced |
— Layer
Base (A : |EI) Rubout Miling
Special [Pads] : I Flashed Pads Only - j & wparallel
Rubaout-1 :IHuboutBottom d © yparallel
Hubout-2:|HubouL&IILa}ler j " gry-parallel
Deestination : IInsuIateBottom j " Concentric
™ Inverss Frame : IFrameBottom j

Insulation Grid : |n.005 mm ™ Remove Spikes

IV Inner lzolation

Frimary Overlap [%] ISU ¥ Exact bage width
¥ Independent primary
™ Laser 0

™ Baze width by standard tool anly
V' Clear resulting layers

Ok I Cancel | Al | Help

Note: The Source layer “Frame” and the checkbox “Inverse” as
well as the checkbox “Clear Resulting Layers” are new in
CircuitCAM 5.0 . In areas on circuit boards which high voltage or
high frequencies, it may be necessary to process the various areas
with different insulation methods.

When an area is defined with the aid of the graphic function
“Rectangle” or “Polygon” on the layer entered here and the
checkbox INVERSE is switched off, the insulating jog is
accomplished only in this area. If the checkbox “Inverse” is
switched on, the insulating job is performed only outside of this
defined area.

In each case, two insulating passes are required.

Caution! During the second pass, always switch off the checkbox “
“Clear resulting layers” because otherwise the result of the
previous insulating path is lost!

RUBOUT MILLING:

In addition to the X or Y parallel rubout paths, concentric or X and Y
parallel paths can be generated.

INNER INSULATION:

When this checkbox is switched off, only the outer isolation channels are
created around the conductor, however, not the inner isolation channels
on a closed conductor line.

INDEPENDENT PRIMARY:

When this checkbox is switched off, no primary cutting channel is
generated between two elements closer together than the diameter of
the standard tool (danger of short circuit). If the checkbox is switched on,
a milling channel is always generated (danger of reducing the width of a
conductor).
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LASER

Only used in connection in LPKF Protolaser. When switched on, this
checkbox prevents multiple superimposition of milling channels. This is
important when a laser is used for “Insulation milling”.

When a circuit board plotter is used, this checkbox must be switched off.

BASE WIDTH BY STANDARD TOOL ONLY

When this box is checked, only the standard tool is used for the base
insulation width entered on the index card “Main”. This could be very
important in the RF engineering sector. For standard circuit boards, the
checkbox should be switched off to optimize the number of milling
channels (big tool) and therefore the milling time.

CLEAR RESULTING LAYERS

When this box is checked, the milling paths for the resulting layers from
insulating operations performed previously are deleted (default setting).
If the checkbox is switched off, the new result is added to the previous.

Note: In the case of multiple insulating passes with the checkbox
switched off, an unnecessary number of milling paths are
generated. This can drastically increase the millling time.

Note: In the FRONT-TO-END toolbar, the button with the function
INSULATE ALL LAYER is assigned the jobs “INSULATE DEFAULT
TOP" and “INSULATE DEFAULT BOTTOM” as a default setting.
Adapt these jobs to your requirements to obtain quick access to
the desired insulating functions with the toolbar.

You can adapt the default job to your requirements as follows:

» Select the job “INSULATE DEFAULT BOTTOM” on the MAIN
INDEX card in the dialog box INSULATE.

Note: You can store the standard job under another name as a
precautionary measure so that it will still be available later. Click
SAVE AS... to store the default job under a different name.

Enter the new name in the text box and click SAVE. After you have
stored the job under a new name, select the job “INSULATE
DEFAULT BOTTOM?” again in the job index.

» Change the parameters in the MAIN and ADVANCED index cards to
meet your requirements.

» Click SAVE on the main register card to SAVE the job “INSULATE
DEFAULT BOTTOM” with the new parameters.

» Repeat this step for the job “INSULATE DEFAULT TOP”.

If you now click T-)ﬁf in the FRONT-TO-END toolbar, the default jobs
with the parameters with you have changed are executed immediately.
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You can create a new job as follows:

» Select the job which you want to use as the basis for creating the
new job on the MAIN register card in the dialog box INSULATE

» Change the parameters in the MAIN and ADVANCED index cards to
meet your requirements (see “CircuitCAM - Lite” on Page 79 and
“CircuitCAM -PCB” on Page 83).

» Click SAVE AS... on the MAIN index card to store the modified job
under a new name.

» Enter the new name in the text box and click OK.

> Note: You can delete a job by selecting it on the JOB index card
E: and clicking DELETE.
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7.1.3 Insulating Frames (PCBs only)

If you want to create circuit boards to be used in the high-voltage range
or high-frequency range, you can increase or reduce the insulation
intervals separately in certain areas with this function. Moreover, this
function can be helpful for optimizing the milling times and tool costs.

It is possible to define a frame around an area on the circuit board layer
so that this area can be assigned different insulating parameters than
the rest of the circuit board side. The tools to be used can be redefined
as well as the conductors for this framed area.

The following description gives an example. File used is the same as
that used in the exercises, and should be opened beforehand. When this
has been accomplished, proceed as follows to familiarize yourself with
this function:

» Select the layer FrameTop in the list box Tutor in the standard tool
list as the active layer (see figure below).

Figure 90:
|FrameTup j
RuhuutTui -
[}
RuboutBottom

Switch the BottomLayer to invisibly described below.

» For this purpose select entry VIEW, LAYER, or click the button

El (“Layer”).

» Switch the VISIBLE box for the BottomLayer by clicking with the
mouse.

» Click on CLOSE.
Only the top layer is now visible on the screen.

» Select the CLOSED PATH menu INSERT or click the button g
“Closed line”.

» Mark the desired area with the mouse and press the ESC key to
switch off the tool.

» Press the HOME key on your keyboard to refresh the display.
» Select the menu EDIT, INSULATE.

The following window appears:
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Figure 91: Insulating - Start

Insulate | %]

Main I Advanced |
~Job

i~ Top [Component Sids) Delete

& Batiom [5older Sidek

Save

Savels. .

Layout Tracking
|V—£
Bigger : I
~Width
Base [Al] Special [Pads] Fun
ID 2 mm 0.3 mm

0K I Cancel | Aoply | Help |

IIﬂsuIateDefaultE ottom j

r Took

Small: [

Standard : [Universal Cutter 0.2 mm [ mil

Big: IEnd Mill 1.0 rom [33 mil]

Ll e Ll |

Settings on Main Index Card

» Select the radio button COMPONENT SIDE (TOP).

Explanation on Windows and Functions:

JOB:

Select the side of the circuit board for which the job is to be performed.
The appropriate layer, "TOP" or "BOTTOM" is then used automatically.

TOOLS:

Here you can define the tools to be used later for machining the circuit

board. In the Lite Version, two tools are available to remove the copper
area optimally and quickly.

Click =] to open the list box from which you can select the desired tool.
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Insulate
Main | advanced |
—Job
" Top [Component Sids]
% Bottom [Solder Side] Save
IInsuIaleDelauItBUltUm j Saveds..

— Toal Layout Tracking
Standard : C 0 5 mi
Uni Cutter 0.2 mmm [8 mil] %,,4 ii’}
Rubout ] iyersal Cutter 0.22 mm [2.7]
Univergal Cutter 0.24 mm [3.4)

) Micro Cutter 0.7 mm (4 mil)
r—wiidth Micra Cutter 013 mm [5.1 mil)

Base (Al End Mill (AF] 0.15 mm [ mil]
BB End Mill [RF] 0.25 rm (10 mil) g
[ozwm End Mill (AF] 0.4 mm [16 mil]
End Mill 0.2 mm (31 mil)

End Mill 1.0 mm [39 mil)

End bl 2.0 mm [73 mil]

—|End Mil 3.0 rmm 112 mil
Ok I Cancel | Lol | Help |

INSULATION WIDTH:
Indicate the width of the interrelation around all electrical objects
(conductors and pads) in the text box BASE. In the text box SPECIAL

you can specify the width of the insulation around the pads which are
produced with flash apertures.

LAYOUT TRACKING:

You can define the layout tracking for the conductors on the selected
circuit board layer by clicking one of the two buttons. The cutting paths
within the rubout areas are then calculated according to the layout
tracking.

DELETE:

You can delete the marked insulating job by clicking the DELETE button.

SAVE:

You can save the modified insulating job by clicking the SAVE button.
Changes are also stored in the basic template file (*.CAT).

SAVE AS:

You can store the modified insulating job under a new name by clicking

the SAVE AS... button. The old insulation job then remains unchanged.
The change is also stored in the basic template file (*.CAT).
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Figure 93: Insulation

Exercise 4

Settings on Advanced Index Card:

Main  Advanced I
— Layer
Base (4] ; |Elll=EE Rubout kiling
Special [Pads) W * wparallsl
Rubout-1 W Lo y-parallel
Rubout2: [Fuboudllayer =]  wepparlel
Destination : | InsulateBottam - " Concertric

[ Inverss Frame lm
Irsulation Grid - |0.005 ™ Remove Spikes

¥ Inner lsolation

Primary Overlap [7] : |30 ¥ Exact base width
¥ Independent primary
I Laser 0 i

I™ Base width by standard tool oy
¥ Clear resulting lapers

Ok I Cancel Lapaplly Help

Explanations on Windows and Functions:

LAYERS:

In the group box layers, you can specify which layer is to be used as the
source for calculation of the insulation channels and on which layer the
result is to be executed.

REMOVE SPIKES:

When this box is checked, all small copper spikes or hairs are removed
down to the size of the diameter of the standard tool. Caution! Longer
calculation and milling time!

EXACT BASE WIDTH:

When this box is checked, the insulation width set in the MAIN index is
maintained precisely. Otherwise, a maximum achievable width is
generated for the same number of miling channels.

INSULATION GRID:

This value specifies the accuracy with which the insulation pads are to
be calculated. A smaller value results in a higher accuracy and longer
calculation time. For structures with a conductor width of 0,2 mm and
minimum interval, a value of 0.005 mm should be selected. Higher
values (0.05 mm) can make the result erroneous.

Note: Since the insulating operation is grid-based, the calculation
time is linear to the number of grid points to be calculated.
Therefore, the finer the insulation grid, the longer the calculation
operation requires. Recommended insulation grid: 0.005mm

(For extremely slow computers: 0.01mm)
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PRIMARY OVERLAP:

In order to efficiently machine large surfaces, it is practical to use
different milling tools. For high accuracy, first the conductors and pads
are insulated with a small milling tool. The other insulation surfaces are
then cut out with a larger milling tool.

Enter the value in the PRIMARY OVERLAP text box by which the milling
pad of the next larger tool is to be overlap the milling channel of the
smaller tool. If the value is too small, unnecessary use of the standard
tool is required in many points (in corners) resulting in a longer milling
time. If the value is too large, the rubout tool comes too close to the

conductors.
Figure 94:
70 %
Tool 2
70 %

1 Tool1T 1

v
T Note: The next larger milling channel should overlap the smaller

E: milling channel by 50 % to 90 %.

7.1.4 Color Assignment for Insulating Tools

In order to obtain a better overview of the tools used for insulating, it is
possible to associate various colors with the tools. This possibility is
particularly interesting because 4 different insulating tools (small,
standard, big, bigger) can be used. For insulating widths, there are
(standard, small, big, bigger) to use the tools optimally (no small
insulating tool wide insulating path,...). To differentiate these four tools
from one another, a layer can be created for each tool. These layers can
be assigned different colors.

» Click the &&| button in the View toolbar.

The layer list appears (excerpts).

Figure 95:Layer List

EOmEmI
EOmEmI
CANEIRAN
ooool
ooool

LANEARAREANN
REREI

=i InsulateBottom__Std 27
= InsulateBottom__Small 28
= InsulateBottom__Big 29
= InsulateBottom__Bigge, 0
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First possibility:

» Click the color box for a layer in which the color is to be changed with
the left mouse key.

The following window appears:

Figure 96:

HE | BE |
B R e

» Click the desired color with the left mouse key.

The corresponding color is assigned and the window closes
automatically.

Second possibility:

» Now move the mouse to the text designation of the layer, whose
color you want to change and click once with the right mouse key.

The following window appears:

Figure 97:Color definition for
Isolation tools
1 Layer: InsulateTop__ Std EFHE3

Ok

¥ Selectable Cancel
[ TrueWidth
4—" I Outline

5/ . Layer Color
N Nen
T T ]

. Flazh Color
e
6

NN e
T ]

.
Pl

Help

1- Visible: The selected layer can be
switched visible or invisible.

2- Selectable: The layer can be protected
against unintentional modification later by
removing the check mark.

3- True width: When this box is activated
(checked), the true width of the conductor
is visible. Otherwise, only thin lines are
displayed which do not correspond to the
actual conductor image.

4- Outline: If this box is activated, only the
outlines of the conductors to be pro-
cessed with the tool are displayed.

5- Layer color: Display color for all
elements except flashed pads.

6- Flash color: Separate display color for
flashed pads.
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In this window you can change the true width or outline display in
addition to the colors.

This window can be closed by clicking OK.
After selecting a color, as described in the first possibility or clicking OK
as with possibility two, you return to the layer List View level.

» Click CLOSE.
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8.0 Exercise 5

Figure 98:

Exercise 5

In this section you will learn how to create user-specific template files for
CircuitCAM and how to correct production data in which the layers are
coincident.

8.1 Creating a CircuitCAM template file

CircuitCAM offers the possibility of creating a template file with user-
specific basic settings similar to a format template in a word processing
program for a telefax, letter or report.

If, for example, you use the same aperture and tool list again and again,
you can create your own template file which already contains both these
lists. You will then not need to import these aperture and tool lists again
for new circuit boards.

All current settings, such as name and colour of the layers are also
saved in the template file. More informations you will find in the
appendix.

CircuitCAM template files are also saved in the CAM format, but have
the file extension "CAT" and are saved to the "NEW_TEMPLATES"
subdirectory.

The available template files are listed in the NEW submenu of the FILE
menu:

File Edit Wiew Insert Select Config ‘Window Help
Defaulk Cerl+M

O Chrl+0

Close 4Layver.cat

Save Chrl+s E‘Laver.c_at

Save As.., 6La\;eran.cat

Save Al glayerPin. cat
Defaulk.cat

Import. .. Alk+I Protolaser,cat

Export

Print... Crl+P

Prink Presdew, ..

Print Setup...

1 Tutar.cam

2 TestDateiFuerDFMadifikation. cam
3 TestFileForDiFModification. cam

Exit Alk+F4
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Various template files are saved to the templates directory when you
install CircuitCAM:

Template file Intended Purpose

Default.cat Standard template

4l ayer.cat Multilayer board, 4 layers when production is with sequential
build-up method

6Layer.cat Multilayer board, 6 layers when production is with sequential
build-up method

6LayerPin.cat Multilayer board, 6 layers when production is with registration
pin method

8LayerPin.cat Multilayer board, 8 layers when production is with registration
pin method

ProtoLaser.cat Template with ProtoLaser tool lists

Use the "TUTOR1.CAM" file you created in the previous exercise as the
basis for creating the template file.

fia

< 7> Note: The most recently used documents are always listed in the
File menu so that you can open them quickly.

7> Note: Click on “TUTOR1“ in the File menu to open the document
"TUTOR1.CAM" if you have already closed it.

fia

How to create a template file for the following exercises:
» Click on ALL in the Select menu to select all graphical objects.
» Press DELETE to delete the selected objects.
» Select SAVE AS from the FILE menu.

» Change to the templates directory "NEW_TEMPLATES" in the
SAVE AS dialog box. This directory is located in the "LPKF50"
directory.

» Select the NEW TEMPLATE (*.CAT) line from the FILE TYPE list
box.

» Enter TUTOR1 in the FILE NAME text box.
» Click on SAVE to save the "TUTOR1.CAT" template file.

» Select CLOSE from the FILE menu to close the "TUTOR1.CAT"
template file.

The "TUTOR1.CAT" template file will now be listed in the NEW
submenu of the FILE menu. This file already contains the
"APETUTOR1" aperture list and the "TOOLTUTOR1" fool list.

fia

> Note: You should save this template file under the name
"DEFAULT.CAT" if you use the same template very frequently.

The template file called "DEFAULT.CAT" is the file that is started
automatically when CircuitCAM is opened.

A new document based on the template file “DEFAULT.CAT" can also
be opened by clicking [] in the STANDARD toolbar.
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8.2 Move layer

The production data used in exercise 1 represented an ideal case.
Naturally, it may be the case in practice that the various production data
do not match up as a consequence of differing data origins and must first
be corrected.

To illustrate the problem, first import the production data into CircuitCAM
as you learned to do in exercise 1.

Do this by opening a new document based on the "TUTOR.CAT"
template file:

» Select TUTOR.CAT from the NEW submenu of the FILE menu.

» Import the following production data from the "DATA" subdirectory
into the new document:

» ,Tutor2.cmp"
o ,Tutor2.sld"
o Tutor2.drl"

The following image appears in the graphic window once the production
data are imported:

Figure 99:

‘EB PEBCTG4GT 2008 @

CIMRONENT (@1DE

This exercise includes Excellon data which does not coincide with the
Gerber data as a result of the specification of a different origin during
output in the circuit board CAD program.

CircuitCAM includes the following function to make the layers coincide
again:

i| MATCH UP LAYER
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How to move a layer:

Use a significant object that occurs in both the layers to be brought back
into registration as your reference coordinates:

oo ==L,k ‘
s oo = o9
&

¢®

Note: A significant object can be a drill hole and it's solder pad, as
long as at is designed by a flash. Both graphical objects have a
center coordinate, so that selecting can be done very accurate.
Don’t use graphical objects which are drawn and not flashed. Only
flashed elements can be processed with this function as only these
have a defined center.

» Click on i‘] in the GRID+UNIT toolbar.

» Select the lower drilling in the "DRILLPLATED" layer as your
reference source.

When you move the mouse-pointer, a "rubber tape" steps up from the
reference point.

» Now you have to mark the upper pad of the layer "TOP LAYER" as
target-point.

The layer "DRILL PLATED" will be moved and the layers are
registered.

Note: Select SAVE AS... in the FILE menu and enter “TUTOR5*.
Now click on SAVE to save this exercise.

You have now learned how you can match offset layers. Since the next
steps for prototype preparation are identical with Exercise 1, we will not
list them again here.

To conclude the fifth exercise, you can now enter “TUTORS“ in the
menu SAVE AS under FILE menu and click on SAVE.

Now you can finish the exercise 5 by selecting CLOSE from the FILE
menu.
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Figure 101:

Exercise 6

In this section you will learn how you can simplify the importation of
production data by the use of import assignments and how to correct
production data in which one layer has a different alignment.

9.1 Using import assignments

If you use production datawith specified file extensions, e.g. "drl", "sId",
"emp", you can use import assignments in CircuitCAM to automate and
thus simplify the import of production data. Here you determine which
file extension represents what type of production data and assign a layer
and a aperture list and tool list to this extension. You will no longer need
to specify this information when you later import a file with this extension.

» Open a new document by clicking on DEFAULT NEW in the menu
FILE.

Save this new document as template file under a new name (Test.CAT)
in the table “NEW TEMPLATES“. Now the import-allocations are saved
in a new CAT-file and not in default. CAT.

How to specify import assignments:

» Open the CONFIGURATION menu and select the GENERAL... line
to open the GENERAL SETTINGS dialog box.

» Click on the IMPORT ASSIGNMENTS tab.

General Settings x|
Shortcuts | Directories I Uit/ Grid I
tethods Impart Assignment | Diverse | Colours I Uzer
FiIe-Spect| Laper | Aperture/T ool List | Type
a [
File-Spec: I
Aperture/T ool List: I j
File-Type: IAperturefTools auto j
Add | Remawve |
oK I Abbrechen | Ubemehmenl Hilfe |

» Enter *.DRL in the FILE SPECIFICATION text box to specify the
import assignment for the Excellon production data (*.drl).

CircuitCAM 5.0
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I Note: You can also use wildcards when defining the file
specification:
The question mark "?" stands for a single character.
The asterisk "*" stands for a complete word or a group of
characters.

i

(G

» Select EXCELLON from the FILE TYPE list box as the files with the
extension ".drl" contain Excellon production data.

= Note: Depending on the file type selected, either the LAYER list box
or the TEMPLATE list box will be displayed in the IMPORT
ASSIGNMENTS dialog box.

» Select TOOLEXERCISE from the APERTURE/TOOL LISTS list box
to use this tool list for the Excellon production data to be imported.

» Select “DrillPlated” from the LAYER list box to assign the Excellon
production data to this layer.

» Click on ADD to accept the import assignment.

The available import assignments are displayed in the top list box:

Figure 102:
Methods Import Assignment I Diverse I Colars I
FiIe-Spectl Layer | Aper;yre:’Tool Lizt | Type
* DAL DiillPlated Tooldbung Excellon
1] | 2]

> Note: You can amend the preferences for existing import
assignments by selecting the import assignment from the list box
and editing its parameters.

fia

» Click on APPLY to accept the modified parameters.

You can delete an existing import assignment by selecting the import
assignment from the list box and clicking on REMOVE.
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Repeat the works steps on the previous page, to define import
instructions for the following production data:
Aperture list Tool list
FILE-SPECIFICATATION * whi *nct
APERTURE/TOOL LIST ApeExercise ToolExercise

FILE-TYPE

Aperture list / Tool list

Aperture list / Tool list

TEMPLATE

TutorApe.txt

TutorTools.txt

Excellon data | Gerber data Gerber data
Component Solder side
side
FILE-SPECIFICATATION *.drl *.cmp *.sld
APERTURE-/TOOL LIST ToolExercise ApeExercise ApeExercise
FILE-TYPE Excellon Gerber Gerber
LAYER DrillPlated TopLayer BottomLayer

The following import assignments should now be displayed in the list

box:
Figure 103:
Methods Import Assighment | Diverse I Colars
FiIe-Spectl Layer | ﬂpel.t!.,lre.-"TDd List | Type
=il CDrrillPlated ToolJbung Encellon
* whl Tutortpe. T...  Apellbung Apertures/Tools 3.
* nct TutorToals...  Toolbung Apertures/Tools 3.
*.Cmp TopLager Apellbung Gerber
* gld BottomLayer  Apellbung Gerber
1] |

» Click OK to close the dialog box GENERAL SETTINGS and save
the import assignments in the template file Text.CAT.

L T Note: The above indicated file-specifications, file types, layer...

( refer exclusively to the included Tutorial data. The file name and the
Import assignments are very individual at each user. According to
the chosen file-type the list box LAYER or the Listbox TEMPLATE
is indicated in the dialog box IMPORT ASSIGNMENTS.
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9.2 Rotate layer

In exercise 5 you learned how to correct production data in which the
layers did not coincide. This exercise includes Excellon data which are
offset against the Gerber data and are additionally rotated by 90°.

Open a new document for this exercise based on the "TUTOR.CAT"
template file:

» Select “TUTOR.CAT* from the NEW submenu of the FILE menu.

» Import the production data from the "Data" subdirectory into the new
document:

» ,Tutor3.cmp"
e Tutor3.sld"
e ,Tutor3.drl"

Note: Import the three files in a single operation. Thanks to the
definition of the import assignments it is not necessary again to
assign layers or tool and aperture lists in the IMPORT dialog box.

The following image appears in the graphic window once the production
data are imported:

Q} PEBC TB467 2903 Q}
L =
- =4

" mEnm
CIIMRONENTI (FIDE

&

You will need the functions for mirroring or rotating graphical objects in
addition to the Match-up-Layer functions you have already used.

You will find these functions in the MIRROR/ROTATE submenu of the
EDIT menu:
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Figure 105:

Figure 106:

Exercise 6

irror/R otate relative Walug ...

a0

180°

27
kirrons
birror=+30°
Mirrart’
irrory’+30°

The effects of the various functions are illustrated by this example object

ABC

0° MIRROR X
ABC VBCl

MIRROR X+90°
O
m
>

180° MIRROR Y

0gv B'EK

MIRROR Y+90°

<
o
9

[nec] #

A selected object always rotates around the anchor point:

Gt

u|
e 0

You may also mirror/rotate around the anchor point of an object which
itself will not be mirrored/rotated:

» Select the anchor point by clicking on the object.
The anchor point is indicated by a cross:

CircuitCAM 5.0
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Figure 107:

Figure 108:

Figure 109:

Figure 110:
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» Select the objects you wish to mirror/rotate by dragging with the left

mouse button rather than by clicking:

e

In this way, the anchor point of the object previously clicked on is
retained and can be used as the reference point for mirroring/rotation:

e

You can also position this anchor point completely independently of any

object:

» Select SET ANCHOR POINT... from the EDIT menu.

The SET ANCHOR POINT dialog box showing the current coordinates

of the anchor point will be displayed:

Set Anchor Pt

|-33.D2 mm

i
'S |15.24|mm

Cancel |

» Enter the new coordinates for the anchor point in the text boxes and

click on OK.
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In the following exercise you will use the position of a drill hole as the
reference point for the rotation of the complete layer.

How to rotate a complete layer:

» Click on the drill hole at the bottom right to select it.

Figure 111:
. v
The position of this drill hole is now the reference point around which the
layer will be rotated.
The active layer “DRILLPLATED" is shown in the LAYER list box of
the DEFAULT toolbar:
Figure 112:

[DrillPlated ~|

» Click on LAYER in the SELECT toolbar or the il button to select all
the objects in the active layer "DRILLPLATED".

» Select 270° from the MIRROR/ROTATE submenu of the EDIT
menu to rotate the entire layer by 270° counter clockwise.

Following rotation, the layer will still have an offset over the Gerber data,
but is aligned the same way:
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Figure 113:
@ PEBC TB4ETF 2005 ‘$‘
£
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You can now register the layers against one another using the MATCH
UP LAYER function, as shown in exercise 5.
<% Note: You can correct layers that are mirrored in the same way. Do
this by selecting Mirror X or Mirror Y from the MIRROR/ROTATE
submenu of the EDIT menu.
T Note: You may use the tutorial files "TUTOR4.CMP",
"TUTOR4.DRL" and "TUTOR4.SLD" if you wish to practise
mirroring layers.
T Note: We recommend that you first rotate or mirror the layer and
then move it.
T Note: To save the current position of the exercise,
select SAVE AS from the FILE menu.
Enter “TUTORG6!“ as the filename and click on OK.
You have now learned how to define import assignments and how to
make rotated and offset layers coincide. Since the further steps in
preparation for Prototyping are identical with those in exercise 2, we will
not list them here again.
To conclude the sixth exercise, you can now close the document by
selecting CLOSE from the FILE menu.
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10.0 Appendix

10.1 Gerber Format

This chapter shows you:

* Where Gerber is used

» The Gerber format syntax

* The difference between drawing and flashing
* The data format

* The structure of the aperture lists

10.1.1 Use of Gerber Format

The Gerber format is used for photoplotter control. The photoplotter is
used to create films used for etching, e.g. for production of circuit
boards. Films are not used for producing circuit board phototypes with
circuit board plotters. However, with the aid of the CircuitCAM software it
is possible to use the same data for control of photoplotters for
generation of the required milling data.
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10.1.2 Structure of a Photoplotter

For better understanding of the Gerber format, it is most practical to first
familiarize yourself with the principle structure of a photoplotter. For us,
the most important constituents of a photoplotter are:

* the aperture plate
* the shutter

* light required for exposing the film

photoplotter
Lightsource @ 8§ 0‘9 o
Aperture plate e
Shutter e
Y-aXiS/: o= /
X-axis
As shown in the figure above, the aperture plate is a disc with apertures
at around its circumference. Each of these apertures has a designation.
As a rule, the smallest aperture has the designation D10, the next larger
D11... and so forth. These apertures have different shapes. For
example, they are circular, square or rectangular.
The shutter is located between the film and aperture plate. Its purpose is
to allow the light from the bulb to pass through to the film only at certain
moments.
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10.1.3 Gerber Format Syntax

10.1.3.1 Drawing

Example 1:

A line is to be drawn with the aid of the photoplotters. This line is to have
a width of 0.3 mm and a length of 2.3 mm. Moreover, it is to be round at
the ends.

For this purpose, a number of commands are sent to the photoplotter.
These commands are explained below.

First, it is necessary for the photoplotter to turn the aperture plate so that
a round aperture with a diameter of 0.3 mm is placed in front of the
shutter. In this example, this is aperture D12.

The command is: G54D12*

G54 is the command to turn the aperture plate.
D12 indicates the new position of the aperture plate.

Next, it is necessary for the photoplotter to move to the starting point for
the line without drawing anything. This means the shutter must remain
closed.

The starting coordinate for this line are to be X=100 and Y=150.
This command is: X100Y150D02*

X100Y150 indicates the position to be moved to.
D02 is the command to move with the shutter closed.

At the starting point for the line, the photoplotter is to open the shutter
and move to the end point of the line. The end point is at the coordinates
X:102 and Y:150.

The command is: X102Y150D01*

X102Y150 indicates the position to be moved to.
D01 is the command to move with the shutter open.

Example 2:

Now, another line is to be drawn. This line is to have the same
dimensions, however, the ends are to be rectangular. For this purpose, it
is necessary to use a rectangular aperture. The edge length of this
aperture is also 0.3 mm. On our aperture plate, this is aperture D17.

The command is: G54D17*
G54 is the command to turn the aperture plate.
D17 is the rectangular aperture with edge length of 0.3 mm.
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Next, it is necessary for the photoplotter to move to the starting point for
the line without drawing anything. This means that the shutter must
remain closed. The starting coordinates for this line are X=100 and
Y=100.

The command is: X100Y100D02*
X100Y100 indicates the position to be moved to.
D02 is the command to move with the shutter closed.

Now, the photoplotter is to open the shutter and move to the end point of
the line. The end point is at the coordinates X=102 and Y=100.

The command is: X102Y100D01*
X102Y100 indicates the position to be moved to.
D01 is the command to move with the shutter open.

10.1.3.2 Flashing
A rectangle was the result of the last command sequence.

Example 3:

It is also possible to generate a rectangle with fewer commands. This
assumes that the desired shape is available as an aperture on the
aperture plate.

A rectangular aperture with dimensions of 2.3 x 0.3 mm is required on
the aperture plate. In our example, this is aperture D20.

It is necessary for the photoplotter to turn this aperture in front of the
shutter.

The command is: G54D20*
G54 is the command to turn the aperture plate.
D20 is the command to select aperture D20 (rectangle).

It is then necessary for the photoplotter to move to position X:101 and
Y:50 and open and close the shutter here.

The command is: X101Y50D03*

X101Y50 indicates the position to be moved to.

D03 is the command to open the shutter and close it again without
moving.

The last command in any Gerber file must be the command M02*, to
define the end of the Gerber file.

This block of commands represents the complete Gerber file:

G54D12*
X100Y150D02*
X102Y150D01*
G54D13*
X100Y100D02*
X102Y100D01*
G54D30*
X101Y50D03*
Mo02*
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10.1.4 Aperture List

The Gerber file specify only which apertures are to be used. However,
this provides no information on the shape or size of the individual
apertures. This information is obtained from a second file: The aperture
list.

There is no defined format for the aperture list. Every CAM or CAE
software has its own format for the aperture list.

Example:

! GAPFile Version 1.0

! Created: Thu Aug 6 17:23:45 1998

! Created by: ECAM 3.21a GAPFile Version 1.0

Type Width Length Rotate
English Metric English Metric
D10 ROUND 3.93 0.100 0.00 0.000 0
D11 ROUND 7.87 0.200 0.00 0.000 0
D12 ROUND 11.81| 0.300 0.00 0.000 0
D13 ROUND 15.74| 0.400 0.00 0.000 0
D14 ROUND 19.68 0.500 0.00 0.000 0
D15 SQUARE 3.93 0.100 0.00 0.000 0
D16 SQUARE 7.87 0.200 0.00 0.000 0
D17 SQUARE 11.81 0.300 0.00 0.000 0
D18 SQUARE 15.74| 0.400 0.00 0.000 0
D19 SQUARE 19.68| 0.500 0.00 0.000 0
D20 RECTANGLE 90.55 2.300 11.81 0.300 0
D21 RECTANGLE 11.81 0.300 90.55 2.300 0

The aperture list has a tabular structure. Each line contains information
on one aperture. The information is subdivided into columns.

The name of the aperture is contained in the first column.
The second column describes the shape of the aperture.
Columns three and four indicate the size in the units mil and mm.

For round apertures, the diameter is specified here, for square
apertures, the edge length.

For rectangular apertures, the extension in the X direction is specified in
these columns.

Columns five and six contain the extension in the Y direction. These
columns are not used for round or square apertures.
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10.1.5 Units, Format and suppressed Zeros

The coordinates for the Gerber file do not provide any information on
whether the values are to be interpreted in millimeters or inches.
Moreover, the Gerber file does not indicate where the decimal point
should be. For example, the second line of the sample double file could
be interpreted as follows:

X100Y150D02* could mean
X:10.0 mm, Y: 15.0 mm

or

X:1.00 inch, Y: 1.50 inch.

This information can be present in the aperture list or contained in an
additional file also containing production instructions. In our example,
such a file is used:

! DSNFile Version 1.3

! Created: Thu Aug 6 17:23:45 1998
! Created by: ECAM 3.21a

!

DSNFile  Version 1.3

Database_type: RS274X
Database format: 2.3
Coordinate_mode: Absolute
Zero_suppression: Leading
Coordinate_units:  Metric

The question regarding the units can be clarified quickly. In the last line,
the expression Coordinate_units: Metric means that the coordinates
must be read in mm.

The position of the decimal point can be read out of the combination of
two pieces of information. These are the Database_format and the
Zero_suppression.

Format 2.3 indicates the number with two digits in front of the comma
and three digits behind the comma. Actually, the coordinates in the
sample Gerber file should consists of five digits.

However, as you can recognize, only two or three digits are used. The
reason for this is that the zeros at the beginning of the coordinates
(leading zeros) and at the end of the coordinates (trailing zeros) are not
written. Here, we speak of suppressed zeros.

There are two possibilities for suppressing the zeros:
Only the leading or only the trailing zeros are contained in the
coordinates.

From the first line of the sample Gerber file, written with all zeros:
X00100Y00150D02*,

the following results when the leading zeros are suppressed:
X100Y150D02*,

and the following results when the trailing zeros are suppressed:
X001Y0015D02*.
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In order to correct the decimal point, it is necessary to know which zeros
have been suppressed.

If the leading zeros were suppressed, the number of digits following the
decimal point is decisive.

If trailing zeros were suppressed, the number of digits in front of the
decimal point is decisive for the position of the decimal point.

In this example, you can see the line Zero_suppression: Leading. This
means that the leading zeros are suppressed. This can also be
recognized by the fact that the coordinates in the sample Gerber file
never starts with a zero.

10.1.6 Extended Gerber

When the Gerber data is transferred from the customer to the template
manufacturer, it frequently occurs that information required for
production such as the aperture list is not received by the manufacturer.
In this case, it is necessary to confer with the customer regarding the
missing information often leading to unnecessary telephone calls and a
delay in production.

For this reason, the Gerber format has been extended. This extended
format is called "Extended Gerber" or "RS247X".

The advantage of this format is that all necessary information for reading
the Gerber file correctly is already contained in the file itself. This means
that no separate aperture list is required, because the definition of the
aperture is already contained in the Extended Gerber file.

The following example shows the syntax for definition of units and
formats as well as the definition of the apertures. This definition block is
always located at the beginning of the Extended Gerber file:

%FSLAX23Y23*%
%MOMM*%
%ADD10C,0.10000*%
%ADD11C,0.20000*%
%ADD12C,0.30000*%
%ADD13C,0.40000*%
%ADD14C,0.50000*%

%ADD15R,0.10000X0.10000*%
%ADD16R,0.20000X0.20000*%
%ADD17R,0.30000X0.30000*%
%ADD18R,0.40000X0.40000*%

%ADD19R,0.50000X0.50000*%
%ADDZ20R,2.30000X0.30000*%
%ADD21R,0.30000X2.30000*%
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Definition of the format is accomplished with the following line:
%FSLAX23Y23*%
FS stands for Format Statement.

L stands for leading zero suppression.
As a result, zeros appear only at the end of the coordinates.

A stands for absolute coordinates meaning that all coordinates are
based on the zero point.

X23Y23 stands for the number of digits in front (2) and in back (3) of the
decimal point. It is possible to define this differently for the X and Y axis.

The units for the Gerber data are defined in the next line: %MOMM*%
MO stands for mode.
MM stands for millimeter.

In the event that the Gerber data is present in inches, IN would be
substituted for MM.

The apertures are defined by the following lines:

%ADD15R,0.10000X0.10000*%
AD stands for aperture definition

D15 is the name of the aperture
R is the shape of the aperture. R stands for rectangle; C for circle

0.10000X0.10000 stands for the size of the orifice inthe X and Y
direction.

Note: Further information on the Gerber Format is given on the
following Internet page: www.barco.com, and there under Electronic
tooling systems - Products - data format descriptions.
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10.2 Predefined Layer
Template file
Layer name Use default Single Sided Double 4Layer 6Layer
Sided

TOPLAYER Layout X X X X
Component side

BOTTOMLAYER Layout solder side X X X X X

LAYER2 Layout Multilayer 2 X X

LAYER3 Layout Multilayer 3 X X

LAYER4 Layout Multilayer 4 X

LAYERS5 Layout Multilayer 5 X

DRILLPLATED Holes X X X X X
(throughplated)

DRILLUNPLATED Holes X X X X
(not throughplated)

BORDOUTLINE Circuit board outline X X X X X

TEXTTOP Text for component side X X X X

TEXTBOTTOM Text for solder side X X X X X

CUTTINGOUTSIDE Contour routing X X X X X
outside

CUTTINGINSIDE Contour routing X X X X X
inside

SOLDERMASKTOP Solder resist mask X X X X
component side

SOLDERMASKBOTTOM Solder resist mask X X X X X
solder side

SILKSCREENTOP Component printing X X X X X
on component side

SILKSCREENBOTTOM Component printing on X X X X
solder side

RUBOUTTOP Rubout surface X X X X
Component side

RUBOUTBOTTOM Rubout surface X X X X X
Component side

RUBOUTALLLAYER Rubout surface X X X X
All layers

INSULATETOP_* Insulation channels on X X X X
component side

INSULATEBOTTOM_* Insulation channels on X X X X X
solder side

Note: We recommend maintaining the names of these layers,
because CircuitCAM provides these layers for preconfigured jobs.
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10.3 Importing DXF files

When importing DXF files, the problem frequently arises that the data
does not contain surface information, but rather only outline data which
may also be split up into individual line segments. In CircuitCAM such
data can be converted quickly and easily into surface data with the aid of
the “Combine to Polygon” function. This means convenient processing
of DXF data particularly in the RF and microwave range.

DXF is a data format which is used primarily by CAD programs for
machine design for 2 and 3-D design. AutoCAD is the program used
most frequently to generate DXF data. The major difference between
DXF and Gerber data is that in the DXF format, one file is used for all
layers and that the conductive copper surfaces of the circuit board are
usually shown in the drawings only as contours and not as filled
surfaces.

The procedure for importing DXF data is identical with that for the
Gerber or Excellon data as a matter of principle:

» Click IMPORT and select the DXF file to be imported.
CircuitCAM recognizes the format of this file.

Note: If CircuitCAM does not recognize the DXF format, check
again to ensure that you selected the correct file. If so, select DXF
manually in the list box “File type”.

» Select one of the entries present in the APERTURE LIST box (DXF
mil unit, DXF inch unit or DXF mm unit).

These lists vary in terms of different resolutions used for data import. In
this manner, the size of the circuit board is defined. In contrast to
extended Gerber format, for example, the DXF format does not contain
any information on the size of the circuit board.

» After selecting one of the entries, check the circuit board size (size
x.y). If the values do not correspond with the expected size, select
one of the other entries.

» Check the size again. If necessary, use the “Preview” button to
check the layout and its size.

If none of the entries leads to a realistic result, define your own entry
with a resolution (unit), which provides correct representation.

» Select the "Top Layer" in the layer list box.

In most cases, the layer name is already defined in the DXF file. In this
case, selection of the layer is required only to continue in the program,
because the IMPORT button releases all required parameters only after
specifying.

In rare cases, layer names may not be specified in the DXF file. In this
case, all data is assigned to the selected layer. This can be corrected in
AutoCAD.

Recreate the DXF file and repeat the import process.

» Click IMPORT.
The DXF data appears in the CircuitCAM graphic window.
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Caution! Check again whether the dimensions of the display layout
correspond to the expected size. Simple viewing is not sufficient,
because although the data appears with the correct relationship,
the layout can still be represented too large or too small by a
certain factor.

» Click the upper-left corner of the layout or an element close to it for
exact checking.

» Click the right-mouse key.
A pop-up menu opens.
» Select Measure from this menu.

> Move the mouse pointer to the opposite corner.

A rubber band is tensioned between the mouse pointer and the
selected element and the length of the rubber band as well as the Y
and Y path (cathetus) is displayed in the bottom left corner of the
CircuitCAM window (in the status bar).

You can check the layout size on the basis of these values.

If the layer names of the DXF file do not correspond to those in
CircuitCAM, these names should be changed in order to use the
prepared insulating and export jobs in CircuitCAM.

» Select the layer names to be changed in the LAYER list box.

» Select the entry Layer in the SELECT menu to select all graphic
elements in the selected layer.

» Select a suitable layer in the LAYER list box to move all elements to
this layer.

Proceed in the same manner for all other DXF data layers.

All copper surfaces required as conductive copper (conductors, solder
eyes) on the circuit board must be represented as filled surfaces in
CircuitCAM. If this is not the case in the DXF files, it is necessary to
modify the data.

Four different possibilities exist in the DXF data for defining copper
surfaces:
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Possibility 1: As continuous, closed line.

Figure 115:
SES>>O>>55>5>>> r
Possibility 2: As closed line, however with individual line segments.
Figure 116:
B3> r
Possibility 3: A continuous closed line surrounds one or more other
lines. The differences between these surfaces defines the remaining
copper surface.
Figure 117:
SEEEE3E33333>3>> E
Possibility 4: Same as 3, however with individual line segments.
Figure 118:

[

>3320 305533350550>

How is this data modified?
Possibility 1.

» Select the closed line surrounding the surface to be filled by clicking
with the left-mouse key.

» Select the function "PATH TO POLYGON" from the EDIT DIVERSE
menu or press the key combination Shift+P.

The selected element appears as a filled surface (Polygon). Proceed
in the same manner for all other elements.
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i Note: If the result is not as you expected, use the “Undo” function
and check the element selected.
Multiple selection of more than one element can be used before
executing the function "Path to Polygon". However, ensure that the
selected elements are of the same type as described under
possibility 1.

Possibility 2.

For this situation, modification is similar to possibility 1. However, it is
first necessary to connect the individual line segments of a closed line to
form a continuous line.

» Mark all individual line segments of one or more closed lines with the
aid of the various selection possibilities (left mouse click, Ctrl + left
mouse click, Shift + left mouse click, left mouse click and pull
rectangle; details in CircuitCAM Manual).

After completing selection, select the function "COMBINE" from the
EDIT CURVE menu or the key combination Ctrl+B. Then proceed as
described for possibility 1.

i

[iﬂ' Note: If the result of the COMBINE function provides an erroneous

result (line segments connected which were not to be connected),
ensure that the value for the capture interval for the connect
function was set realistically. This value defines the max. distance
between line segments to be connected with one another. If the
value is too large, adjacent segments are connected with one
another which should not be connected. If the value is too small,
segments which should be connected with one another may not be
connected because their beginning or end points are not precisely
on top of one another due to inaccuracies in the DXF data. The
value for the capture interval is given on the tab “Diverse” in the
Configuration General Setting menu. The value for the parameter
"Threshold curve-combine” should be 0.01 to 0.05 mm. This value
depends on the structure of the layout.

Possibility 3.

With this possibility, it is necessary to subtract one or more parameters
from another larger parameter. This modification must be accomplished
step for step.

First, it is necessary to modify the enclosing lines to form polygons as
under possibility 1.

The outer, larger polygon (and only this polygon!) can be selected and
changed to a particular polygon by selecting the function "POLYGON
WITH CUTOUTS" in the INSERT menu. Holes or cutouts can be
inserted in such a polygon

» Select all the polygons within the larger polygon which are to be
deleted as cutouts

» After selecting the above, select the function "CUTOUTS" in the
INSERT menu.
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The result is a polygon with openings, which has precisely the expected
design - if all selections have been performed correctly.

Note: If the result is not what you expected, use the “Undo”
function and check the elements selected.

Possibility 4.

For this situation, modification is similar to possibility 3. However, it is
first necessary to connect the individual line segments of an enclosing
line to form one continuous line as in possibility 2. Then proceed as
described for possibility 3.

After completing the above modifications, your layout can be further
processed with all prepared insulating and export jobs. All jobs present
for this purpose can be used.

A CircuitCAM file (TestFileForDXFModification.CAM) is part of the
data sub directory. This file contains examples for the possibilities
mentioned above. This file serves for practicing the procedures
described above and obtaining a better impression of the descriptions.
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Figure 119:Text window

10.4 Text Function

the INSERT menu.
The following window appears:

Appendix

Insert Text 21xl
— Font setting 0K I
] —— Layer:
5 I TextTop ﬂ Cancel |
] Select a font: I ©c 1503098 j
33— Selectafont syl : IHegu|a[ j
4 ————— Select a charset : IDefauIt j L 9
5— Pathwidt [T Line distance |—//
- |0 *|1.70000
_—10
6—— Height: |2 o Char distance : Ig_mggg |
S 11
Lewvel of linear interpolation : | —E——/
7\— Mode Orientation | — 1 2
T .. " Absolute —
LR |23.85?1 mm RO hd
& Mouse ;
y: [#T 758 mm C Reiaive ||| ADF g
Character 0 of 1000
8 —_

In CircuitCAM it is possible to insert texts in a graphic, using the Windows
fonts that are installed on the PC. Both TTF and TTC fonts are possible,
depending on the country setting of the operating system.

» For this purpose, click TEXT, TOPLAYER (or BOTTOM LAYER) in

1- Layer: List box for selection of layer on
which text is to be located.

2- Select a font: Here; it is possible to
select the font for the text.

3- Font style: Here, you can choose bet-
ween regular, italic, bold and bold italic.

4- Character set: Here, you can select
different character sets within a font.

5- Path width: Here, the path width for the
text can be specified in mm.

6- Height: Here, the height of the text can
be specified in mm.

7- Mode: Radio buttons for setting the text
position with the mouse (absolute or
relative)

8- Text entry window: Here, you can enter
the text to be positioned on the layer.

9- Line distance: Distance between the
lines can be set

10- Distance: Distance between the
characters can be set

11- Level of linear interpolation: Here the
quality of the edge resolution of the
Windows fonts can be modified in steps
from 1 to 10

12-Orientation: After activation of “arbi-
trary” an angle can be specified in the
right box. When not activated, the angle
can be turned® by exactly 90° and 180° in
the right window.

» Now open the SELECT FONT list.
The selection list for the fonts appears.
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» Select a font.
The selected font appears in the display box SELECT A FONT.

» Click momentarily on the bottom white text entry window.
The entry cursor is activated and flashes in the text entry box.

» Then you can enter the desired text in the bottom window.
» Click OK.

» Then position the text on the layer and arrest it by clicking once with
the left mouse key.

A text created in this manner can only be processed with a tool. The tool
used here is defined as LPKFMILLINGTEXT TOOL under CONFIG -
FORMAT CONFIGURATIONS - LPKF CIRCUIT BOARD PLOTTER
TOOL LIST and can be changed there.

Note: In the PCB version of CircuitCAM, DXF files with texts can
also be imported and interpreted correctly.

This assumes, however, that true type fonts are used! MTEXT
entities in the DXF file are not supported.

The major advantage is that it is no longer necessary to divide up
the texts into vectors in AutoCAD, which would result in a lower
data quantity and corresponding appearance.
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Figure 120:Layer for ground surface

Figure 121:Top layer

Appendix

10.5 Generating Ground Planes

CircuitCAM offers the possibility of automatically and simply generating
ground planes in the PCB layout. This means that extensive
construction work is no longer necessary for ground planes when the
EDA system does not provide such a function. This then reduces the
milling work and provides a simple computer-oriented design of the
layout.

The following instructions are an example. In this case, the same file
was used which was used for the main exercises. If other files are used,
the circuit board representations naturally look different.

Proceed as follows to familiarize yourself with this function:

» Open the file “TUTOR1.CAM”

» Switch all of the used layers to “Invisible” except for the TopLayer by
‘removing” the check in the list and close the Layer list window.

t o] GflalE] BT 217 cese ||

Layer Mame | Order | Color | Flash | Yisible | Selectable | True ‘width | Outline | Uszed |
= Toplayer L | ] (]
< BottomLaper 1 m = O O O
= DrillPlated 1 o O O O O
= Drillrplated 2 m O O O
= o uting E O O O O O
& TedtTap % m ] O |
£ TextBattom 15 o [ O O

» Select the TOPLAYER as the active layer (See illustration below).

ﬁlTupLayer jl
SIS ARSI T

» Construct the desired ground surface with the RECTANGLE or
POLYGON function. Then press ESC to quit this function.
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» Select the constructed surface by clicking with the left-mouse key in
the vicinity of a corner and select the function COPPER/GROUND in
the INSERT menu.

Inzert

Rubout Area 3

Open Path
Cloged Path
Palygon
B

Rectangle
Circle
Text 3

Fad/Hale
Airbitrany Hole k

| e B
- [Entats

Copper [ground]
- Bt [ems]

» Select all elements within the ground surface by pressing and pulling
with the left mouse key. However, not the plane itself.

In this manner, all elements which are to be released from the ground
surface are marked.
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Figure 124:
> Now deselect all elements not removed, i.e. which are to be
connected to ground. For this purpose, press the SHIFT key and
click the left-mouse key in the vicinity of the element in question.
Figure 125:

» Now select the function -POURING (ITEMS) in the INSERT menu.
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Figure 126:

Ihzert
Rubout &rea 4

Open Path
Cloged Path
Falygon
A

Rectangle
Circle
Test 3

Fad/Hole
Arbitrany Hole 3

v Erlimam it Eutaits
- Cutouts

v LCopper [ground]

- Pouring [iternz)

» In the COPPER POURING box enter the value by which the
conductors and solder pads located inside of the ground plane are to
remain free. This is the insulation distance between ground and the
other signals.

used, e.g. for the universal cutter 0.2mm, the value should be set to

[j,/) Note: This value should be adapted to the insulating tool to be
'
i 0.24 mm.

Figure 127: Copper pouring
Copper pouring EHE3

Walue : ID.24| mm
Cancel |

The desired ground surface is then completed. The result appears in the
graphic window.

Figure 128:
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Figure 129:
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10.6 Design Rule Check

The CircuitCAM PCB version allows a “Design Rule Check”. This means
that before starting insulating or data output, it is possible to check
whether the desired minimum intervals have been maintained between
conductors and/or pads.

For this purpose, the layer to be checked and the dimension of the
minimum interval are simply defined. Those points at which the minimum
interval is not maintained are indicated graphically in the layout.
Moreover, the following intervals can be measured:

1. Distance from hole to hole

2. Distance from hole to conductor

3. Distance from hole or conductor to circuit board frame
4. Minimum width of remaining copper ring around holes

These measurement possibilities increase the reliability for circuit board
prototyping considerably, because many errors can be eliminated before
they do any damage.

For the following work instructions we again want to point out that this is
an example. The basis for layout representations are the files from the
exercises in the main chapter. If other data is used, some
representations look different.

Proceed as follows to familiarize yourself with this function.

» Open the file TUTOR2.CAM in the FILE menu

Checking the Distance between Two Layers:

» Switch all layers except the TopLayer, DrillPlated and BoardOutline
to invisible and close the Layer list window.

o m| Blsl4l%] 8] [T 200] _ cose ||

Laper Mame | Order | Colar | Flash | Wizgible | Selectable | True Widthl Outline | Used |

OEO0EODE
OEOEODE
K& &R R COE
K& &R RO
K KRR REE
ooooooo
ooooooo

1. Checking the interval within a layer:

This Design Rule Check checks the minimum desired interval within a
layer. This serves for checking whether a milling tool with the desired
width (0.2 mm) can be used. On the other hand, it is also possible to
check for the minimum interval required for the electrical properties.

» Select the function DESIGN RULE CHECK in the EDIT menu
The following window appears:
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Figure 130: Design Rule Processing

Design Rule Check EHE
™ Inter Min Spacing % |rtra Min Spacing
Cancel |
Layer : ITUDLB}'BT j
Layerz : I j Fun
Layer Result : IDHETop j

Width : |D-24 it
PpResolution : ID.D'I mm

The display may vary depending on whether the radio button "Enter min
spacing" or "Intra min spacing" is selected.

» Select the layer to be checked in the LAYER1 list.

» Enter any desired name in the LAYER RESULT for the layer result
on which the positions of any errors present are to be displayed
graphically.

» Enter the minimum interval to be checked under WIDTH.

If the possible use of a milling tool is to be checked, enter a value
approx. 0.02 mm larger than the diameter of the tool in order to avoid
later flaws resulting from rounding errors when insulating.

» Select the value 0.5 mm here to provoke errors.

» Click Run

The following message appears:

Figure 131: Design Rule Check,
Message

Designed Rule Check

&2 mistakes found

118 Revision: 2.6.04 CircuitCAM 5.0



IRiH

Laser & Electronics

Figure 132: Design Rule Check

Appendix

CircuitCAM reports 2 errors, i.e. the minimum interval of 0.5 mm was not
maintained at 2 points. These two points are indicated graphically in the
layout (see arrows).

2. Checking the interval between 2 layers:

This Design Rule Check serves for checking the minimum interval of
holes or components in relation to the circuit board limit.

» Select DESIGN RULE CHECK in the EDIT menu
The following window appears:

Design Rule Check HE
% Iriter Min Spacing " Intra Min Spacing
Cancel |
Layer! ; |DiilFlatsd =]
Layer? : IBnaldDutline j Bun
Layer Result IDHCDriIITDEDard j

Ydiclth |2-5 mm
PpResolution : ID.D'I i

The illustration can vary depending on whether the radio button "Enter
min spacing" or "Intra min spacing" is selected.

» Select the first layer to be checked in the LAYER1 list.

» Select the second layer to be checked in the LAYER2 list.

» Enter in the LAYER RESULT box any desired name for the layer
result on which the positions of any errors present are to be indicated
graphically.

» Enter the minimum interval to be checked under WIDTH.
» Select the value 2.5 mm here to provoke errors.

» Click RUN.
The following message appears:
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Figure 133: Design Rule Check,

Message la_llgl .__.I IE T

1 | [mm ][00 <o (ot j‘

Designed Rule Check [E3

&1 mistake found

CircuitCAM reports 1 error, i.e. the minimum interval of 2.5 mm was not
maintained at 1 point. This point is indicated graphically in the layout
(see arrow).

10.7 CircuitCAM template file

CircuitCAM also offers the option of creating a template file with
customized basic settings comparable to the format template in a word
processor.

The template file is where all settings located in the subentries of the
menu bar are saved.

This also includes the names and colours of the layers, the imported
apertures and tool lists, the isolation jobs and the export jobs, along with
all entries located in GENERAL SETTINGS (with the exception of the
“User” and “directories” tabs) of the CONFIGURATION menu. No
graphic data will be saved in the template file.

CircuitCAM template files are saved in the CAM format, but have the file
extension “cat” and are saved to the “NEW_TEMPLATES" subdirectory.

After CircuitCAM has been installed, several template files will already
be saved to in the template directory and “DEFAULT.CAT* will be
identical to “DOUBLESIDED.CAT*.

Template file Purpose
Default.cat Default template file
4L ayer.cat Multilayer board, 4 layers when production is with

sequential build-up method

6Layer.cat Multilayer board, 6 layers when production is with
sequential build-up method

6LayerPin.cat Multilayer board, 6 layers when production is with
registration pin method

8LayerPin.cat Multilayer board, 8 layers when production is with
registration pin method

ProtoLaser.cat Template with ProtoLaser tool lists
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The available files are listed in the NEW submenu when you select it
from the FILE menu:

Figure 134:

File Edit “iew Insert Select Config Window Help
Deefaulk ChrlH

Cpen ChrlH0

Close 4Layer.cat

Save Chrl+5 6Layer.Fat

Save As... 6LayerP!n.cat

Save Al BlayerPin.cat
Default. cat

Impart... Al+1 ProtolLaser,cak

Expoark

Print. .. Chrl+P

Prink Presigw, .,

Print Setup. ..

1 Tutor,.cam

Z TestDateiFuerDxFModifikation. cam

3 TestFileFarDxFModification. cam

Exit Alk-+F4

If, for example, you use the same aperture and tool list again and again,
you can create your own template file which already contains both these
lists. You will then not need to import these aperture and tool lists again
for new circuit boards.

All current settings, such as name and colour of the layers are also
saved in the template file.

Here you have the opportunity to remove layers that you do not require
from the layer list, or to insert unique colour tags and permanently assign
these new functions.

oy Note: You should save this template file under the name
E: “DEFAULT.CAT” if you use the same template very frequently.
—> Note: The template file with the name “DEFAULT.CAT” is the file
( CircuitCAM opens automatically when it is started.

You can also open a new document based on the “DEFAULT.CAT”
template file by clicking on 0] in the DEFAULT toolbar.

10.7.1 Creating your own template file

As already described previously, CircuitCAM gives you the opportunity
to save your own settings in the form of template files.

An example of this would be changing an apertures/tool list and
modifying isolation jobs for your own purposes. A basis for this would be
the default template file “DEFAULT.CAT“.

» Start CircuitCAM

The template file called "DEFAULT.CAT" is the file that is started
automatically when CircuitCAM is opened.
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» Store this template file under its own name.
» Click SAVE AS in the FILE menu

» Now select the dialog box opened as File of type NEW TEMPLATE
(*.CAT). Then select the directory NEW_TEMPLATES, where all
other template files are located.

» In Names, type in OWN and click on OK.

Your new template file “OWN CAT“ has now been saved. It contains
precisely the same settings as the “DEFAULT.CAT* template file.

All subsequent changes will, however, be saved to your own.cat file.

This .cat file is available at the start of a new project in the File, New
menu.

10.7.2 Saving an aperture list in the template file

» Select IMPORT from the FILE menu.
The OPEN file menu field will be displayed:

Figure 135:

Import HE

Lack jn: I {3 Data

= =] @l & = =

Test.cam
Tutar.cam
Tutar. LMD
Tutor. hct
Tutar. yhl
Tutorl.cam

Tutorl.cmp
Tutorl.dil
Tutorl.sld
TutarZ.cmp
Tutor2.dil
Tutor2.sld

Tutor3.cmp
Tutor3.drl
Tutor3.sid
Tutord.crp
Tutord. dil
Tutord. sld

Kl - o

File name: | Open

Files of type: IAIIfiIes["."] j Cancel |

4

» Open the file “TUTOR.WHL* in order to import the blind-list and give
a marking name, for example APERTURES, for the aperture-/tool
list.

The file TUTOR.WHL is only an example in this case. You should carry
out the same procedure with your own aperture list in future.

» To import the aperture list TUTOR.WHL, make all the required
settings in the IMPORT dialog box, as described in Exercise 1.

» Select the GERBERAPERTURE LIST... line from the FORMAT
CONFIGURATIONS submenu of the Config menu.

CircuitCAM shows all imported aperture lists in the list window.
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Figure 136:
o L] e A =
Configuration M ame | I ik | bl ode | JEal=) Ju] =t | m | h | ...
? inch abs Trailing 2 3
inch abs Trailing 2 3
Let us assume that you only want to use your APERTURES list in future.
This would mean that all other lists can be deleted.
» Left click to select “APETUTOR* and click on |
This action will delete this aperture list.
Figure 137:
o] Gllle] BITT L1 | cose |
| Configuration Mame | Lnit | Iode | Zernes | m | n | ...

7 Aperture inch abs Trailing 2 30
Double-clicking on APERTURES opens the aperture list. Right-clicking
on an aperture accesses the properties for the aperture. You may now
change the shape or size of the aperture as required.

Figure 138:
O] B |4 S [ 200 cose |
[ Configltemn Name ‘ Mode | Type | a | b | =]

D1D [E:] [ 0.2 i

EEL]

B:g Flash |Transform| Dirawe I Diversel

[ D14 & e a: [Trm f: [im

[ D15  Oval

[ D16 £ Square b IDmm 9 IUmm

017  Rectangle =H IElmm h: IEImm
D1B £~ Rounded Rectangle
[ D19 {~ Beveled Rectangle d: IDmm i IUmm
[ D20 - DCtag_on e: IElmm B IEImm
[ D21 " Undefined
[l D22 " Marker
" Special a=Diameter
o orpr |-_a_-| e
Ecisz:[ =] .
Edi * Do’
Ok I Cancel | Lappl | Help
By clicking OK you quit this dialog box.
» Click on i‘ to return to the list of the aperture lists.
» Now highlight the APERTURES list and click on E‘ (on the left,
next to Close) to save this list to the “OWN.CAT* template file.
» Click i‘ again.
The list of all format configurations appears.
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» Select the entry configsGerber and then click E] , to store all

Gerber aperture lists present and permanently remove the deleted
lists from the cat file.

10.7.3 Saving a modified isolation job

A further important point is the definition of your own custom insulation

job.
To define an isolation job, open the ISOLATE .... submenu from the
EDIT menu.
Figure 139:
Insulate E
Main |Advanced |
—Job
¢ Top[Component Side) Delete
& Bottom [Solder Side) Save |
IInsuIatEDefauItBnttnm j Er——
— Tool
Small: IM\CID Cutter 0.1 mm (4 mil) j Layaut Tracking
Standard : IUniversaI Cutter 0.2 ram [2 rmil] j % ii ! i fl
A——
Big: IDoubIe Edged Cutter 1.0 mm j
Bigger : IDouble Edged Cutter 2.00mm j

—Width [
Base (4] Special [Pads) g
ID.2 mrm 0.3 mm

kK I Cancel | Ll | Help |

By way of an example, we will redefine the isolation width for Special
and the preferred direction of the conductor tracks for a job on the solder
side (bottom).

» Click on the SPECIAL edit field and enter the value 0.7 mm. Then
click on the Vertical Conductor Track direction button.

Clicking on SAVE saves the changes under the name
“INSULATEDEFAULTBOTTOM* to your CAT file and thus
automatically assigns it to the button in the FRONT-TO-END toolbar. Or

you may click on SAVE AS, thus saving a new, additional job to the CAT
file.

In both cases, this modification will always be available to you when you
start a new project with this CAT file: File-New-own.cat.

Clicking OK quits this dialog box.
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10.7.4 Saving a new layer

Layer information, such as new layers or the layer parameters can also
be modified and saved to the CAT file.

» Click on g to open the layer list.

Figure 140:

ol m ] rafa] S T B L ewse ||
[[Laver Name [ Oider | Color | Flash | Visble | Selectable | True..| 0. | U..|
= TopLayer [ | [S]
ottomLayer T @ o o o
iillPlated 1 o o o o
iilnplated 5] =] o o
oardOutline: 3 g [m] o o
extTop “om =] o o
‘extBottom AL o o o
ttingld utside 16 m m o o
uttinglnside: T\ =] o o
oldeMaskTop I | [ ] o o
olderd askBottormn 1" m m o o
olderPasteTop 5 m m o o
olderPasteBottom % @ 5] o o
ikScreenTop 2 g [m] o o
ikScreenBottom pal = m o o
ubautTop 2 m m [m]
meTop 7 m m O
uboutBottom 2z m (] [m}
ameBottom % m = o
ubautAlLayer 24 @ m [m]
medlLayer A g (=] [m]
eulateT op__Std 5 m m [m} o o
sulateT op__Smal E O o o o o
sulateT op__Big T m =] o o o
lateT op_Bigg 8 @ =] o oo
sulateBottom__Std NI | m [m} o o
wilateB ottom__Small 1 7] m [m] o o
silateBottom__Big 2 m ] o o o
S InsulateBoltom_Bigger R | = [m} o o

In this list you may now modify the various parameters by clicking on

VISIBLE or SELECTABLE, or even add a new layer.

» Do this by clicking on Dl and entering a new name for the layer.
Once you have also assigned all the necessary parameters to this
layer, click on t..| . This takes you one level higher.

Figure 141:

t[3m] Bx|s|ds] B[ 5 22| close

» Now highlight the LAYERS Entry, and click on the E‘ button to save
all the modifications in the layer list to your CAT file.

10.7.5 Saving the parameters

The settings for the parameters under General Settings are very
personal and depend on the one hand on your individual preferences
and on the other hand on the characteristics of the layout to be
processed.
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Open the GENERAL SETTINGS dialog box by clicking on GENERAL
SETTINGS... in the CONFIGURATION menu. Take a look at all the tabs
and your settings.

Detailed information on the various index cards is given in the
CircuitCAM online help under GENERAL SETTINGS.

When you quit this dialog box by clicking on OK, all the entries for the
COLORS, UNIT/GRID, METHODS, IMPORT ASSIGNMENTS and
DIVERSE tabs are saved to the CAT file on which the document is
based.

The entries on the USER and DIRECTORIES tabs are saved to the
Windows Registry as these are user and computer-specific data.

= Note: All other changes are always saved to the template file
[( (*.CAT) on which the document (project) is based. CircuitCAM will
prompt with an appropriate message if the underlying CAT file is
unknown.

In this case, modifications you wish to use at a later date must be
saved using File-Save As *.cat.

10.8 Prepared isolation jobs

The software supplied contains two prepared isolation jobs. You can find
the settings for these jobs in the table below:

Job*:
InsulateDefaultBottom |InsulateDefaultTop
Isolation width
Base 0.2 mm 0.2 mm
Special 0.3 mm 0.3 mm
Tool
Standard Universal Cutter 0.2 mm |Universal Cutter 0.2
mm
Big End Mill Cutter 1.0 mm End Mill Cutter 1.0 mm
Layer
Base BottomLayer TopLayer
Special - Flashed Pads Only - - Flashed Pads Only -
Rubout1 RuboutBottom RuboutTop
Rubout2 RuboutAll RuboutAll
Summery InsulateBottom InsulatTop
Isolation grid 0.005 mm 0.005 mm
Rubout milling X-parallel Y-parallel
Primary- overlapping |80 % 80 %
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Figure 142:

Figure 143:

Appendix

10.9 Creating Drilling/Milling Tools

When working with CircuitCAM and the circuit board plotter, it may be
necessary to modify present drilling or milling tools, i.e. to change their
parameters or define new tools.

As a matter of principle, we differentiate between two types of tools:
Drilling tools and milling tools for routing the contours of the circuit board
or structuring the copper laminate.

The tools can be defined in a manner very similar to defining the
apertures used for Gerber data. The terminology Flash for drills and
Draw for cutters is used in the same manner as for the aperture
definitions, because the same program routines are used within
CircuitCAM.

The various LPKF tool lists are given in the CONFIGURATION menu
under FORMAT CONFIGURATIONS..._LPKF CIRCUIT BOARD
PLOTTER TOOL LIST:

» Click on FORMAT CONFIGURATIONS ..._LPKF CIRCUIT BOARD
PLOTTER TOOLS LISTS in the CONFIGURATION menu (see
illustration below).

Config Window  Help

Format Configurations — # Gerber - Aperture List

Job Configurations r Excellon - Toal List ...

General Settingz .. Sieb+tdeyer - Tool List .
HF-GL - Pen List ...

LPKF Circuit Board Platter - Tool List ..

LPKF Steneil - Tool List ...
LPKE Diwerse - Tool List ...
DF - Tool List ...

Barco DPF - Aperture List ...
Diverse - Aperture List

The following list window appears:

t.[3m] Gx|alds] S
| Caonfiguration Manme | zed |
LpkfDrillingT oolz
LpkfdillingT ools
LpkiMillingDutiineT ool
LpkftillingT extT ool
LpkfDizpensaT ools
LpkPy acuumT ools
LpkfSaldStopT ool
LpkfFilmFoilT ool
LpkfrdarkingT ool
LpkfCuttingT ools
LpkiBackingT ool
LpkfadurninurmCutting o
LpkiDizpenzeSolderPaz

O

OoOoooOoOoOogoooo
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All lists displayed here contain LPKF tools used for rapid prototyping.

The most important are:

LpkfDrilingTools

contains all tools for drilling the circuit

board

LpkfMillingTools

contains all tools which can be used for

insulating

LpkfCuttingTools

contains all tools for circuit board contour

routing

Two examples are given to show how a new drilling tool and new milling
tool can be generated. You can also change the parameters for existing
tools in the same manner as defining the individual parameters.
Definition of the various parameters should be accomplished extremely
carefully, because incorrect entries can have effects on the result.

10.9.1 Definition of New Drilling Tool

» Double click theentry LpkfDrillingTools.

The list of drilling tools is opened and the following display appears:

LD B)%|4%[%| B [ 2% close |
Configltem M ame | Mode | Type | a | b | c
Spiral Drill 0.2 mm 4] O 0.2 mm
Spiral Drill 0.3 mm = O 0.2 mm
Spiral Drill 0.4 mm = O 0.4 mm
Spiral Drill 0.5 mm = O 0.5 mm
Spiral Drill 0.6 mm = O 0.6 mm
Spiral Drill 0.7 mm = O 0.7 mm
Spiral Drill 0.8 mm = O 0.2 mm
Spiral Drill 0.9 mm = O 0.9 mm
Spiral Drill 1.0 mm = O 1 mm
Spiral Drill 1.1 mm = O 1.1 mm
Spiral Drill 1.2 mm = O 1.2 mm
Spiral Drill 1.3 mm = O 1.2 mm
Spiral Drill 1.4 mm = O 1.4 mm
Spiral Drill 1.5 mm = O 1.5 mm
Spiral Drill 1.6 mm = O 1.6 mm
Spiral Drill 1.7 mm = O 1.7 mm
Spiral Drill 1.8 mm [ ) 1.8 mm
Spiral Drill 1.9 mm [ ) 1.9mm
Spiral Drill 2.0 mm [ ) 2mm
Spiral Drill 2.1 mm [ ) 21 mm
Spiral Drill 2.2 mm [ ) 2.2mm
Spiral Drill 2.3 rmrn [ ) 2.3
S piral Drill 2.4 o [ ) 2.4 mm
Contour Router 20mm ] ) 2 mm = Bl

A drilling tool with a diameter of 2.5 mm is to be added to the list as an

example.

» Mark the tool following which the new tool is to be entered and click
the button 3.
The following window appears:
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Figure 145:
Cancel |
» Enter the name of the new tool:
Figure 146:
MHew Aperture/Tool
M ame: QK

ISpiraI Drill 2.5 mm Cancel |

» Confirm the entry with OK
The new tool appears in the list .
Open the dialog box with 4 index cards for definition of the tool with a

right-mouse click. In our example, only the index cards Flash and
Diverse are of interest.

Figure 147: Aperture/Tool

Aperture/Tool : Spiral Drill 2.5 mm

Flash ITransforml Draw | Diverse |

{*" Circle a: |2.5mm f: IDmm
 Oval

# S b- ID i q: ID T
" Restangls c: IEI mm h: ID mm
" Rounded Rectangle

" Beveled Rectangle d: IDmm i ID mm
i .

I Bitdaeg:;r;d B IDmm I: IDmm
™ Marker

" Special a=Diameter

=~
 Oif

IEC1182:| vI .

. Puozition

Edit | * Datum

QK I Cancel | Appl | Help |

The important entries to be made in the Flash index card are the shape

of the tool and the diameter. The shape of a milling or drilling tool is
always round. Mark the radio button ROUND (circle).

> Note: This dialog window is also used for definition of highly

i3}

[

of different shapes are specified here.

varying apertures in Gerber format; for this reason, a large number
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» Enter the desired drill diameter under a:

» Click the DIVERSE tab and enter the rest of the parameters.
The following window appears:

Figure 148:

Aperture/Tool : Spiral Dnll 2.5 mm

Flazh Transfnrml Draw  Diverss

Mame : ISpiraI Dol 2.5 mim

Capture Interval for Export [Flazh)

7 llse

0K I Cancel | Spnl | Help |

This index card again shows the name of the tool.
Important here is the entry of a capture interval to be used for the tool.

Circular elements on DrillPlated or DrillUnplated in the layout serve for
correct assignment of the drilling tools. When defining the drilling tools,
it must be ensured that every diameter is clearly assigned to a tool.
Here, it is not permissible for the capture intervals of the individual tools
to overlap (unclear assignment) or to have gaps (no assignment
possible). (See Chapter ,Checking The Tool List“ on page 62).

A capture interval of 2.45 to 2.55 mm is defined for the 2.5 mm drill. This
means that all circles with a diameter of 2.45 mm (inclusive) up to 2.55
mm (exclusive) are assigned to this tool.

It must be ensured that the settings for the adjacent tools are adapted to
these new entries. In our example this means that the capture interval
for the 2 mm contour router (last tool) will have to be checked and
corrected if necessary. This milling tool is then set for all holes with a
diameter greater than 2.5 mm, i.e all holes with a diameter greater than
2.5 mm are automatically milled.

» Close the dialog window by clicking OK and open the dialog widow
for the 2 mm Contour router with a right-mouse click on this entry in
the list.

» Select the index card Draw in the dialog window.
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Figure 149:
Aperture/Tool : Spiral Dnll 2.5 mm
Flash |Transform Dirauw |Diverse|
™ Derived from Flash Defirition
¥ Avvailable
Path width: 2 mm
Comertype—————— End type
& Round & Riound
™ Extend " Extend
© Truncate © Truncate
W Capture interval [ Owverlap
i |2.45 i ID mri
i |2IJ rifm Min path length
ID i
QK I Cancel | Lppf | Help |
Change the values under capture interval according to the definition of
the new drilling tool:
Figure 150:

¥ Capture interval

mire | 2-45 mm

max |20 mm

This ensures that the milling tool is only used for holes with a diameter
beginning with 2.55 mm. If the capture interval is not adapted, it is not
clear for CircuitCAM whether the drill or milling cutter is to be used for a
diameter of 2.53 mm. This diameter would be assigned to both tools.

» Close the dialog window after changing with OK.

If the change is to remain stored for future layouts, save the new tool list
as template file (see “Creating CircuitCAM template file” on Page 91).
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10.9.2 Definition of New Milling Tool

» Double click the entry LPKF MILLING TOOLS.

The list of insulating milling tools is opened and the following display

appears:
Figure 151:
Y m| Gxlals] @) TR cose |
Canfigltem Mame | Miode | Type | a | b | C
IUniversal Cutter 0.2 mm [ mil) O 0.2 mm = T
Urniverzal Cutter 0.22 mm [8.7) O 0.22 mm 3 ﬁ
L riversal Cutter 024 mm [9.4: O 0.24 mm 3 m
Micro Cutter 0.1 mm [4 mil] 2 0.1 mm ) il
Micro Cutter 0.13 mm [5.1 mil] 2 0.13 mm ) il
End Mill [RF) 0.15 ram [ mil] 2 0.15 mm = =
End Mill [RF) 0.25 mm [10 mil] 0 0.25 mm = =
End Mill [RF] 0.4 mm [16 mil) () 0.4 mm = 9
End Mill 0.8 mm [31 mil) ) 0.8 mm = 9
Erd bill 1.0 rarn 39 mil) O 1 mm 3 ﬁ]
End Mill 2.0 rar [73 mil) O 2mm 3 ﬁ]
[ End Mill 3.0 (118 mil) ) 3 mm =) 9
As an example, a new milling tool with diameter of 0.26 mm is to be
added to the list.

» Mark the milling tool, below which the new tool is to be added and
click the button -

The following window appears:

Figure 152:
New Aperture/Tool EHE

Cancel |

» Enter the name of the new tool:
» Confirm the entry with OK.

The new tool appears in the list.

m‘ Note: If you have defined a tool as described above and want to use

B it for working with the circuit board plotter, it must be ensured that
it is defined with the same name and diameter in the BoardMaster
tool library (*.TOL) used!
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Figure 153:

Figure 154:
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Click the right-mouse key to open the dialog box with 4 index cards for
definition of the tool. In our example, only the index cards Flash and
Draw are of interest.

Aperture/Tool : Universal Cutter 0.26 mm E
Flash ITransforml Diraw I Diversel
& Circle a: ID.2Bmm [
 Oval
P b- ID i q: ID i
" Rectangle c: |0mm h: [0 mm
¢ Rounded Rectangls
" Beveled Rectangle d: ID Gl 05 ID m
" Octagan e: [0mm i: [0 mm
™ Undsfined
O Marker

" Special - a=Dliamnetar
[ i

IEC‘I182:| vl .

: + Poszition
Edit | [ aturn
Ok I Cancel | Sl | Help

The important entries to be made in the Flash index card are the shape
of the tool and diameter. The shape of a milling tool or drilling tool is
always round.

» Mark the radio button CIRCLE.

Note: This dialog window is also used for definition of highly
varying apertures in Gerber format, for this reason, a large number
of different shapes are listed here.

» Enter the desired milling diameter under a: .

» Click OK to confirm the entry and close the dialog box.

The new tool appears in the list and is defined here as a milling and
drilling tool:

w LINMYER:G! LUIED U.24 rmm U

Loy
Universal Cutter 0,26 mm O 0.26 mm
[ Mirrn Castber 17 mm Tl [ M1 mm

This symbol in the tool list describes the tool as a drilling (Flash) tool as
well as milling (Draw) tool.

This symbol in the tool list describes the tool as a drilling (Flash) tool.

This symbol in the tool list describes the tool as a milling (Draw) tool.

» Click the tool again with the right-mouse key to define it as a pure
milling tool, because a milling tool cannot be used simultaneously as
a drilling tool. However, this is quite possible for an aperture inserted
in Gerber data.
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Aperture#Tool : Universal Cutter 0.26 mm E
Flash |Transf0rm| Draw I Diversel
& Circle a: IDmm f: IDmm
 Oval 7 [
€ Square b: I i g.l i
" Rectangle c: IDmm h: IDmm
" Rounded Rectangle .
" Beveled Rectangle d: IDmm 0z IDmm
" Dctagon .
e: |0mm i |0 mm
7 Undsfined I I
" Marker
" Special
IEC1182: I vl
it |
QK I Cancel | Lol | Help |

Figure 156:

Aperture/Tool : Universal Cutter 0.26 mm
Flash I Transform  Draw | Di\-'ersel
I= | Derived from FeastDetittisn
IV Awilable
Path width: [0:26Fm
Corner type End type
" Round  Round
" Extend  Estend
i Truncate  Tuncate
ird Capture interval - Overlap
min: ID mm IEI mm
max; ID mm Min path length
ID mm
Ok I Cancel I Aol | Help |

Laser & Electronics

» Click the radio button OFF on the Flash index card. This switches off
the drilling (Flash) characteristics for the tool.

> Now click the Draw index card. The following box appears:

The check box AVAILABLE is switched on in this window and the tool

diameter is entered. Other important parameters for a milling tool are the

CAPTURE INTERVAL, OVERLAP and MIN. PATH LENGTH. Enter the
values for these 3 parameters as shown in the following illustration:
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Figure 157:
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Aperture/Tool : Universal Cutter 0.26 mm [ %]
Flash I Transform  Draw |D|verse|
= | Dt from Flash Defiition
IV Available
Path width: |U-2B mm
Corner type End type
& Found & Round
" Extend " Extend
© Tuncate © Truncate
¥ Capture interval ¥ Overlap
i |n 258 mm |n 039 mm
mas: ID.2B2 mm Min path length
ID.251 mm

()8 I Cancel | Sl | Help |

For the capture interval, a interval is entered within which this tool is to
be used similar to drilling tools. In our example, all lines with a width of
0.258 (inclusive) and 0.262 are realized by a path with this tool.

All lines narrower than this are filled out with a smaller tool. All wider
lines are filled out with this tool by cutting a number of paths until the
exact width is achieved.

In contrast to the drilling tools, the list of milling tools can have overlaps
and gaps within the capture interval. A line located outside a capture
interval can still be realized by cutting a number of paths with a smaller
tool. This is not possible with drills

The overlap indicates the amount by which parallel cutting paths with
the same tool are to overlap without posing the danger of fine copper
hairs remaining between the paths. CircuitCAM sets this value to 10 %
of the tool diameter as a default value (checkbox switched off). We
recommend a value of 15 % of the tool diameter. Switch On checkbox
and enter value.

The parameter min. path length indicates the minimum length of a
cutting path which can be generated during the insulating process. This
parameter is particularly important for rubout tools such as end mills.
These tools have a hollow shape so that copper could remain when the
cutting path is shorter than the tool diameter. We recommend entering a
value equal to the diameter of the tool for this parameter.

» Complete the entry by clicking OK.

» Click CLOSE in the list window.
The tool list is closed.

Note: Define the tool parameters carefully to avoid errors when
exporting the BoardMaster production data.
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10.10 Export Jobs

In addition to the possibility of usingCircuitCAM as CAM software for
circuit board plotters, it can also be used for preparation of production
data for the circuit board manufacturer. Generation of multiple boards,
ground areas, milling data etc. All these modifications can be exported
as Gerber or Excellon data (only with PCB version).

CircuitCAM already has a number of prepared output jobs for the LPKF
circuit board plotter:

Job Application

LpkfCircuitBoardPlotter: Standard export job for circuit board plotter and
all options

LpkfCircuitBoardPlotterGalvTHP:  |Export job for circuit board plotter
recommended for use of a galvanic U
contacting system

LpkfCircuitBoardPlotterNoTHP: Export job for circuit board plotter recom-
mended when no through contacting
possibility whatsoever is used.

LpkfCircuitBoardPlotter+Auto Export job for circuit board plotter with Auto-
Contac Contac
Data output

LpkfSolderMaskCutting: Export job for circuit board plotter for cutting
Solder mask of the EasySolder system

Use one of these jobs to output the production data you have generated
and provide it for use by LPKF BoardMaster or other software.

The LPKFCircuitBoardPlotter-Job is assigned to the 2z button in the

FRONT-TO-END Symbol bar. By clicking this button the production files
will be saved in a LMD-file. If BoardMaster is open, the LMD-file will
automatically be imported into BoardMaster and placed on the screen.

In the following you can see, which parameters are defined in the
exported job.

» Select in Menu CONFIGURATION in the submenu JOB the entry
EXPORT... to show the listbox with all available export-jobs.
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Figure 158:GerberXTOP,- Bottom +
Excellon Jobs (only in the PCB-

Version)

Figure 159: Export Job

-
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» Click the entry Lpkf Circuit Board Plotter with the right-mouse key.

The following window appears:

Export [ x|
-~ Configuration Type
" Excellon Cancel |
™ Gerber
" Gerber Tranzfamn... |
 HP-GL

¥ | 1:4 Transfommation
[~ Savefs..

File Specification : |* LMD

The format in which the data is to be exported, the name of the exported
file and whether the data is to be turned, mirrored or shifted
(transformed) during export are defined in this window.

» Click OK to close the window.

Note: Click on "Transform" to open the Transform dialog box and
modify the origin, scaling and alignment used to output the
relevant layer.
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> Double click the entry “LPKF CIRCUIT BOARD PLOTTER” to
display the various entries (tasks) with the assigned tool list, layer
and production phase:

Figure 160:

t'|.]'||:|:|| Q|X|/-|a’a;| EI IE;.Q.',A’L' Close ||

Task | List | Phase IENEREE
E InsulateT op* LpkfilingT aals MilingT ap O O
E BoardOutline LpkfilingOutineTaol — MilingTop O O
E TextTop LpkfrilingT extT ool tillingT op O O
E InsulateB ottam® LpkiMilingT ools billingE cttom O 0O
(4] B oardOuting LpkiMilingOutineTool  MillingE ottam O 0O
E TextBottom Lpkftiling T extTool IillingB attom O 0O
E DrrillFlated LpkfDriling T ool: DrrillingPlated O 0O
m Drilldriplated LpkfDrilingT cols DrillingUriplated O d
E DrrillFlated LpkiDispenseT ools Dispense O 0O
[3] CrilPlated Lpkfi acuumT ools Wacuum o O
[] DrilPlated LpkfBackingT ool DrillingB acking o O
E CuttingOutside LpkfCuttingT ool CuttingOutside O 0O
E Cuttinglnzside LpkfCuttingT ools Cuttinglnside O d
E Soldert azkTop LpkfSaldStopT ool CuttingS oldStopT op o O
E Soldertd askB ottarm LpkfSaldStopT aal CuttingS oldStopE attam O O
E DrillFlated Lpkft arkingT ool M arkingDrills O O
E DrilUnplated Lpkf arkingT aal MarkingCrills O O
4] 5olderPasteTop LpkiDizpenseSolderPast DispenszeSolderPasteTop o O
[H] 5 olderPasteBotom LpkiDizpenseSolderPast DispenseSolderPasteBott o O

Now open the following window by clicking the desired job with the right-
mouse key:

Figure 161: Export Task (LPKF Mill
Drill)

Export Task [LPKF Mill Drill)

B|
= oK |
Layer : IInsulateB ottam® j ﬂl
- [MilinaBattanm -
F'hase.l J (rarEar... |
— Sorting
—Digtance———— 1~ Direction I Collect
0 i Mo direction ¥ Fill mods - -
: Concentric x
&+ Min.Length 4 I J
L=
(s ¥ Default Transfarmation [Job]
oy
[™ Closed(primany] paths first [T Scanner support
[T Cincle-diameter

Here you can select the data format in which the job is to be exported.

You can also click on the entry for a line in this list window to open a
dialog window where you can customize the export task to meet your
requirements.
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Note: These modifications should never be saved under the same
CAT filename, otherwise you would destroy the original job. Either
create new jobs or save any modifications to the original job in a
new CAT file, should you need modifications to a job.

A second job is provided for double-sided PCB that are not to be
through-hole-plated; this will make processing in BoardMaster simpler
and faster:

“LPKFCIRCUITBOARDPLOTTERNOTHP” generates an almost
identical LMD file. The difference is that the various production phases
have been summarized into just two production phases:
MILLINGBOTTOM and MILLINGTOP.

You can save modified or new jobs in the basic *.cat file in the job name
list window.

» Mark the job to be saveed and click | H -

10.11 Batch Function ( PCB Version Only)

The batch function allows automatic processing of various CircuitCAM
functions. This allows the user to generate production data for the circuit
board plotter in a simple manner.

Another advantage: infrequent or less experienced users can use
CircuitCAM with very little information, such as where and how to
start the batch mode.

The following chapter is intended to clarify the operation of the Batch
function and put you in a position to generate a batch job customer-
tailored to your requirements.

The sequence for a batch job reflects the manual work with the front-to-
end tool bar:

* Import all required data

» Calculate circuit board contour

* Insulate the two sides of the circuit board
« Store CAM file and then

* Export the production data in LMD format

Functions such as modifying data, partial definition of the rubout
surfaces, etc. is not possible in the batch mode.

Important: Automatic processing of a batch job is only possible
with the default template file DEFAULT.CAT and the Batch-Job
DEFAULT.

Definition or modification of a batch job can be accomplished in the list
window batch settings in the Configuration-Job configurations menu:
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Figure 163:

Figure 164:
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|E|:|nfig Window Help

Format Configurations  » i

Job Configurations Insulate Sethngs ...
General Settings .. StencillSethinms...
Export Settings ...

B atch Settings ...

The following list window is opened:

L e ) e P ) e ) R T
Job Mame |

Diefault

» The batch dialog window can be opened by clicking the entry
Default with the right-mouse key:

Batch
Task. List r— Task Attribute:
Fraperties:,. |
Type | Parameters | " Subnlab [stencil, insulate, export]
Impart All Sdd Befare |
Insulate InsulateDefaultTop I j
Inzulate InzulateD efaultB ottam Eddbrter |
ggg::ur Rauting € Start non-job action
Export LpkiCircuitB oardPlotterG alv THR I ﬂ Figmve |
5! Start extemes Programmile ., B aster] Epply |
! =
" Terminate CircuitCAM
Cancel |
~Job Attribute RUN

™ Background processing

¥ | CommandHine sensitive

The dialog window is subdivided into 3 areas:

1. The task list stores all individual tasks in the sequence to be
processed in the batch job from top to bottom.

2. The Task attributes serve for selection or definition of the tasks to
be performed.

3. With the buttons at the right, tasks can be added, deleted, changes
confirmed and to the extent possible, the properties of some tasks
described in greater detail.
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For definition of a task, it is first necessary to define the type of task by
switching on the corresponding radio button:

1. Jobs:

Here, a task from the areas Insulate, Export or Stencil (CircuitCAM
Stencil Version only) can be incorporated into the batch job. All jobs
defined in the areas are available, e.g.:

InsulateDefaultTop for insulating the solder side

InsulateDefaultBottom for insulating the solder side

LpkfCircuitBoardPlotter for exporting the production data for the
plotter

2. Other tasks:

These are tasks which are not based on a job but rather whose
properties are defined in the batch dialog window, e.g. importing data,
contour generator and saving data.

3. CircuitCAM is closed at the end of the batch job when the radio button
CIRCUITCAM IS CLOSED is clicked. If you want to terminate
CircuitCAM, this entry must always be the last in the task list. Any
messages occurring during the batch run are logged in a text file (*.rep).

The new task can be inserted in front of or behind the task marked in the
task list by clicking ADD 4 or ADD * .

The marked task can be deleted from the task list by clicking the
DELETE button.

Definition of a new task in the task list.

1. Sub-Job tasks:

» Mark the task before or in back of which the new task is to be
inserted.

» Click the radio button JOB.

» Select the job to be added in the task list as a new job in the List Box.

Figure 165: Task attributes

— Task Attributes

i Syb-Job [stenci, inzulate, export]

=l
------- jobsl neulate---- -
g InzsulateDefaultB ottom —
InzulatelefaultT op
InsulatePrevious
------- jiobz0utput------
LpkfCircuitBoardPlotter
O LpkfCircuitB oardPlatter sk T HE—FE1]
LpkfCircuitBoardPlatterMoTHP
Gerber=Top w2

—

» Click the button ADD 4 or ADD * to insert the new task in front of
behind the marked task.
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[F ©  Note: Pay attention to the sequence of tasks in the task list. It is not
| practical to isolate the data before importing or export the data
before isolating.

2. Non-Jobs
» Mark the task before or in back of which the new task is to be
inserted.
» Click the radio button Non Jobs.

» Select the job to be added in the task list as a new job in the List Box.

» Click the button ADD 4 or ADD * to insert the new task in front of
behind the marked task.

Figure 166:

&+ Start non-ob action

Imnport
A FrameGenerator =
Contour Fouting
Save

Save dz..

For Non Jobs, a dialog window is then opened automatically to define
the properties of the job:

Import: Properties

After creating an import task, the following dialog window appears:

Figure 167: Import

Import HE

— File-type File b Import——————————

Import Azsigment anly " Open File Dialog

fute © Mest on Command-Line Cancel |

Apertures/Toolz auto
: & i

m Command-Lins

AperturesdTools select
Gerber

Gerberx

Excelion j
Sieb & Meyer
HP-GL

DxF
Barco-DPF

Aperture/Toal List

8 Bia Nia Bie Nia Nin S Nia Nie Nia 0

It is subdivided into the areas File type and File to import.
The file type defines the file format to be imported or that the import
assignment is to be used for importing.
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The simplest and quickest method to import production data with the aid
of a batch job is to assign the import assignments. This means it is only
necessary to define one single import task in the batch job.

Only this possibility is described here, because it is the most suitable
possibility for 99 % of all cases.

Important: This assumes that the import assignment for your files
to be imported has been defined in the template file DEFAULT.CAT
(see applicable Chapter in this Manual).

The import task is defined as in the figure above:

» Switch on the radio button IMPORT ASSIGNMENT ONLY.

This causes CircuitCAM to import all files defined in the import
assignments

» Switch on the radio button ALL FROM COMMAND LINE.

This selects all files from the command line (see "Execution of batch
job").

» Click OK.

The dialog window closes and all settings for this import task are
saved in the task list.

Contour Routing:

After creating a contour routing task, the following dialog window
appears:

Contour Routing ﬂll
' Dutside  Inside

~ Source

= Current Selection

& Layer IBoardDutIine j

Drestination Layer: IEuttingDutside j

~Used Toal

List I LpkfCuttingT ools j

Taol I j
— Breakout

[ Automatic Gap Wwidth: |1 ]

Distance: |1 0 mm
[T Make diills on the laper ID[illUnplated j

o

Fur | Cancel |

Here you can see the contour routing settings already familiar from
manual work. You can make the settings according to your desires or
requirements.

Click OK to close the dialog window and save all settings for this contour
routing task in the task list.
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Save As...

After calling the Save as... task, the following dialog window appears

Figure 169:

Batch properties for the Save ns.l:

» Enter you the name want to assign to the project in the text box.

[ﬁv > Note: If you use the Save task, the name of the file imported first is
= automatically used for your project (without name extension).

Press OK to close the dialog window and save all settings for this
contour routing task in the task list.

Executing a batch job:
3 different possibilities are available for executing a batch job:

1. Move the files to be imported to the CircuitCAM button on the desktop
with Drag&Drop.

Select all files to be imported in Microsoft Explorer or a similar file
manager program and pull these files to the CircuitCAM button on the
desktop.

2. By double-clicking on a bottom on the desktop. The command line for
the button must contain all required parameters such a file name and
path.

e.g. : C:\LPKF50\CCAM\CircuitCAM.EXE
C:\LPKF50\DATA\Sample. TOP C:\LPKF50\DATA\Sample.BOT........

Disadvantage: If you do not want to change the command lines for the
button each time, the files to be imported must always have the same
names and the same name extension and the files must always be
located in the same directory.

3. By clicking the Run button in the batch dialog window in CircuitCAM.
This method of executing a batch job is suitable primarily when all files
have already been imported and all subsequent processes such as the
contour generator, insulating and exporting are to be performed
automatically. In this case, the name assigned to the template file or the
batch job is irrelevant.

The file DEFAULT.CAT included with the program already contains a
batch job with the name DEFAULT. This batch job is prepared for the
Drag&Drop run possibility.

Caution: It is still necessary for you to set your specific import
assignment.
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10.12 Processing AL-front panels (PCB version)

This aluminium processing is based on sample data. It is only meant to
show the procedure by means of an example.

If you have to process your own front plate, then you need to replace the
sample co-ordinates with your own data.

Note: Key labels and menu terms are shown in bold type.

Note: Keep exactly to the working steps described below, in order
to avoid processing disruptions and breakdowns in functions.

Notes on working with aluminium

- Harder aluminium alloys are better suited to processing than soft
alloys.

- The two-fluted end mill is a particularly suitable tool, given its good
splinter removing properties.

Caution! The milling depth per pass must not be more than half the
diameter of the working tool.

» Start CircuitCAM from the Windows start menu or by double-clicking
on the CircuitCAM icon on the desktop.

If your assistant ,Wizard" is still active, close it and change to the regular
CircuitCAM graphics display.

10.12.1 Prepare front plate outline data

First determine the size of the front plate.

» To do this, select layer BOARDOUTLINE from the layer list field.
The front plate in the example has the dimensions 100 mm x 130 mm.

» Click on the button @@ | ’Rectangle”in the Graphics toolbar
(figure 170).

R [olelm(e]o] [=]

» Select EDIT, SET CURSOR from the menu toolbar (figure 171) or
press the keys SHIFT + C.

The following window appears:
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Figure 171: Setting the cursor

1. Input 2. Input
Set Curzor Point HE Set Cursor Point H E
”M 0K | Ei|431'8 i ok |
X IEI mm Cancel | e I1 27 o Cancel |
& Absolute & Abcolute
Set Set
" Relative " Relative

» The following details have to be entered into the corresponding
window:

x=0 x=431.8
y=0 ->SET y=127 -> SET and then OK.

A yellow rectangle is displayed on the screen.

» Press ESC on your keyboard, to switch off the tool.

» Press the key HOME on your keyboard in order to have an overview
of the drawn rectangle.

The filled rectangle which is still represented by a polygon must now be
converted into an empty rectangle.

» Mark the rectangle by clicking on it.
The rectangle is now displayed in a light yellow.

» Go to the EDIT menu bar under DIVERSE and select function
CONVERT TO CLOSED OUTLINE PATH or use the shortcut SHIFT
+W.

The previously filled rectangle changes to a closed rectangular box
which describes the dimensions of the frontplate.

10.12.2 Preparing cutting and drilling data
» Select the layer BOARDOUTLINE from the layer list field.

» Click on the button | “Circle in the Graphics toolbar.

» Enter a diameter of 12 mm (following figure) and close the window by
clicking on OK.

146 Revision: 2.6.04 CircuitCAM 5.0



IRIE

Laser & Electronics

Figure 172: Diameter
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Create Circle with fixed Diameker 2=l

Diameter: I'I 2 mm

Cancel

i

Now position this object on the front panel of the coordinate (x=
50mm, y= 30mm). To do this, use function SET CURSOR POINT by
pressing key combination SHIFT + C and enter the mentioned
coordinates.

Press ESC on the keyboard.

Use the same procedure to place two more circles with 5 mm
diameter on the coordinates

1.circle  x=20 mm, y= 65 mm
2. circle x=20 mm, y=75 mm.

The filled circles must be converted to empty circle representations, as it
was previously done with the rectangle.

>

To do this, mark all circular objects using the mouse and convert
them using EDIT/ DIVERSE/ CONVERT TO CLOSED OUTLINE
PATH (or use SHIFT + W).

Now place a rectangular aperture of the size 60 mm x 30 mm on the
starting coordinate x= 20 mm, y= 90 mm.

)

Select layer BOARDOUTLINE again.

Click on the ﬂ button and enter the starting coordinates (x= 20
mm, y= 90 mm) by pressing Shift + C on the keyboard. Then click on
SET.

To determine the size of the rectangle, add the starting coordinates
to the desired size of the rectangle and enter these data.

x =80 mm (60 mm + 20 mm)
y =120 mm (90 mm + 30 mm)

Click on SET and then on OK.
Press ESC on the keyboard.

Then convert into an empty rectangular object using Marking with
mouse and pressing SHIFT + W on the keyboard.

The result should look like this:
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Now use the possibilities of the contour generator to create the milling
data for the breakouts.

» Mark the 4 objects with the mouse by opening a rectangle.

» Go to the menu EDIT and open the CONTOUR ROUTING dialog
and select the settings as in the following figure.

Contour Routing ﬂil
" Dutside & Inside
— Source
= Current Selection
& Layer IBoardDutIine j
Destination Layer: IEuttingInside j
— Used Tool
List I LpkfCuttingT ools j
Tool I j
— Breakout
[ Automatic Gap Wwidth: |1 ]
Distance: |1 0 mm
¥ take diills on the layer IDriIIUanated j
Fiur | )8 | Cancel |

» Start the process by pressing on START.

Following this, there are milling lines and start drill holes created for all
breakouts. The start drill hole provides the optimum and gentle start
point for the subsequent milling process.
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10.12.3 Setting text data

Starting with CircuitCAM Version 5.0 all fonts (TTF and TTC) installed on
the computer can be used for writing texts.

To be better able to adjust the text which follows, it is advisable to switch
on a Display and / or Cursor grid from the Grid / Units toolbar
(following figure).

Figure 175: Grid/Unit toolbar

B[] o [

1- Display Grid
2- Cursor Grid

2| [mm =] 0t =0 10 ]|
1 2

= Note: The display grid and the cursor grid should be set to the
@5 same value.

» Select the text program by clicking on ™| from the Graphics
toolbar.

The following window appears:

Figure 176: Entering text
— Font zetting oK I
Layer: ITextTop Cancel |

Select a font: | ©C CicutCAM default

Select a font style : Iﬂegma[

Lef Lef e L«

Select a charset : IDefault

Path width: Ig'z mm Line distance : |1 70000
Height: |5 mm Char distance : Ig_mggg

Level of linear interpolation : |~ E

—Mode Orientation

' Absolut
#: [A1.0571 ram solde RO -

' Mouse

v: [03623 o || [

Character 5 of 1000
Power

» Choose all settings as in figure 176 and quit this dialog with OK.

» To position the text, use the mouse and place it above the big round
drill hole, then click on the left mouse key.
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Repeat the process for labeling the small drill holes. Try to put the text
~otandby“ in a letter height of 3mm at the drill hole at the top and the text
,Online“ at the drill hole at the bottom.

The finished result might look like the following:

Figure 177: Result

Q:ionay
. Online

FPOWER

O

10.13 Exporting and saving»

» Click on SAVE AS... in the menu toolbar and save the object under a
new name.

» Select FILE, EXPORT, LPKF, LPKFCIRCUITBOARDPLOTTER*
from the menu toolbar.

10.14 Preparing data for fiducial recognition

Circuit board plotters that are provided with a camera system for fiducial
recognition must be given the required positioning information via Circuit-
CAM. Well utilizable fiducials are simple round drilled holes of a diameter
of 1.5 mm.

After having finished the insulation of your layout, you then place the fi-
ducial holes.

» First set the cursor and screen grid to an appropriate value.

» Then select the layer FIDUCIAL from the layer list field.
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» Click on the ﬂ button in the GRAPHICS symbol bar and enter
the diameter of 1.5mm. Set the four fiducial circles at right angles
around the layout.

1> Note: Using the cursor display BIG CROSS makes it easier to
( position the circles at right angles.

The result should look like the following:

Figure 178:

RN »
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The four circles around the layout represent the fiducial points (see ar-
rows in figure 178).

» Use the corresponding output job to put out the data als LMD file.

10.15 Producing step-and-repeats (Only PCB
Version)

CircuitCAM can be used to create step-and-repeat directly on the CAM
file.

Having finished all working processes (insulating, contour generation and
so on) at your layout, you can create the step-and-repeat.

» First mark all objects of all layers by using the g button in the
MARKING symbol bar.

All objects are now displayed in light color.

» Go to EDIT / DIVERSE and open the STEP AND REPEAT dialog or
press SHIFT + R on the keyboard.

The following figure is displayed:
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Figure 179:Step and Repeat Dialog

Step and Repeat
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» Add the desired distance to the value already entered and enter that
value under DISTANCE.

» Then enter the desired number of repeats.

Quit this dialog with OK. The result could look like the following figure:

Figure 180:
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Key Combinations

Functions

Reference

General:

F1 Help about current subject

Ctrl + Tab Toggle within CircuitCAM windows

Ins View - Previous View

Home View - Overview

End View Pan Cursor Position
Page up View - Zoom In Cursor Position
Page down View - Zoom Out Cursor Position
Del Delete Selected elements
Esc Cancel

Cursor keys Move Grafic: up, down, left right

Ctrl+Shift+Left Mouse Klick |Set Anchor Point Cursor Position
File Menu:

CtrlI+N New Graphic Window (default.cat)

CtrI+O Open

CtrlI+N Save

Ctrl+P Print

Edit Menu:

Ctri+Z Undo Last Action

Ctrl+Y Redo Last Action

Ctrl+X Cut Selected Elements
Ctrl+C Copy Selected Elements
Ctrl+V Paste ClipBoard
Ctrl+Space Duplicate Selected Elements
Space Move Selected elements
Shift+C Set Cursor Enter Coordinate
Shift+A Set Anchor Point Enter Coordinate
Shift+N Set Zero Point Anchor Point
Shift+L Move Lyer to Zero Point Anchor Point
Shift+X Measure Anchor Point
Shift+O Properties Selected Element
Curve Menu:

Ctrl+A Add Point Anchor Point
Ctrl+U Cut point/Segment Anchor Point
Ctrl+D Delete Point/Segment Anchor Point
Ctrl+M Move Point/Segment Anchor Point
Ctrl+E Move/Create Arc Anchor Point

CircuitCAM 5.0
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Ctri+G Create Gab Anchor Point

Ctrl+R Inverse Direction Selected Elements
Ctri+B Combine Selected Elements
Ctri+K Connect to polygon Selected Elements

Diverse Menu:

Shift+Q Close Curve Selected Elements
Shift+P Path to Polygon Selected Elements
Shift+Y Object to Polygon Selected Elements
Shift+W convert to close Outline Path Selected Elements
Shift+K Convert to Circle Selected Elements
Shift+Z Center point Selected Elements
Shift+M Mass Point Selected Elements
Shift+R Step & Repeat Selected Elements
Shift+G Create Bounding Box Selected Elements

Change Order Menu:

Ctrl+J

Move to Next position

Selected Element

Ctri+l Move to Prev. Position Selected Element
Ctrl+F Move to First Position Selected Element
Ctrl+L Move to Last Position Selected Element

Configuration -
GeneralSetting Methods:

Temp.A+Left Mouse Klick &
Drag

Add/Append Point

Active if cursor
changes its shape
above selected
element

Temp.E+Left Mouse Klick &
Drag

Create / Move Arc

Active if cursor
changes its shape
above selected
element

Temp.U+ Left Mouse Klick

Cut Point / Segment

Active if cursor
changes its shape
above selected
element

Temp.M+Left Mouse Klick &
Drag

Delete Point / Segment

Active if cursor
changes its shape
above selected
element

Temp.L+Left Mouse klick

Select only

Active if cursor
changes its shape
above selected
element
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10.17 Updapting Translation File

A translation file serves to convert the aperture list ASCII file) of any
CAD system so that it can be read into CircuitCAM without further
modification. This allows users who continuously have to work with
different aperture lists to work considerably faster, because manual
definition of the individual apertures is eliminated. Moreover, they can
use the translation files for converting tool lists in Excellon or
Sieb&Meyer format.

CircuitCAM already has a series of prepared translation files for the
common CAD systems; nevertheless, it may be necessary to have to
adapt a translation file to your specific requirements.

Eﬁ > Note: The translation files must have the name extension .txt .
A

T Note: The translation files are located in the CircuitCAM
(@j) subdirectory “Ape_Templates” or in the directory you specify for
the aperture/tool templates in CircuitCAM under GENERAL
SETTINGS.
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10.17.1 Structure of Translation Files

Translation files are files in ASCII format you can edit with any text
editor. For example, Windows provides the text editors EDITOR and
WORDPAD.

However, the use of the program Aperture Template Editor supplied
CircuitCAM Version 5.0 is simpler than using a text editor.

This program has a graphic, syntax-oriented surface and avoids typing
errors such as can occur when a text editor is used. The Aperture
Template Editor button was placed in the Start menu and on the desktop
during installation of CircuitCAM. Information on use of this program is
given in its online help.

.. ApertureT emplateE ditor

File Template Line SetdAs Help

J | M| [7.CC Do s Cicle 2 g N e e N = I A
IT fiperture Table for Tutor sample Files
@ Format Unit: Inch
7 m.n Code: 2.3
— Hode: absolute
! Zeros: leading suppressed
L ]
L ] Aperture unit: 17160 mm
8| D_Code Hode Shape %-size ¥size
2 D10 Drau tircle 20
9| o|mm brov 109
(] D12 Drau Circle ET]
I_D D13 Flash Circle 118
I_ D14 Draw Circle 158
B D15 Flash Circle 138
? D16 Flash Circle 168
T D17 Draw Circle 5
— D18 Flash Finger 258 68
Txrl D19 Flash Rectangle 258 68
(1 | Dz2a Flash Square 635
— D21 Draw Square 635

A translation file is subdivided into three sections:

» Permanently defined parameters
* Aperture definition

* Variable parameters

Note: The permanently defined and variable parameters need to be
defined in the translation file only when the format and aperture
definition in the aperture list do not correspond to the default
settings.
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Section 1: Permanently Defined Parameters

The following table is a list of the permanently defined parameters
available with possible parameter values and the corresponding default
setting.

Parameter name Parameter value Standard setting for parameter
value
APE_SCALE <real number> 1
APE_UNITS INCH MIL
MIL
MM
COMMENT <Sign> | <Sign pair> [ <Sign> | <sign pair> ]
CONFIGURATION ConfigExcellon ConfigGerber
ConfigGerber
ConfigHpgl
ConfigSiebMeyer
COOR_MN <number>.<number> 2.3
COOR_MODE ABSOLUTE ABSOLUTE
INCREMENTAL
COOR_UNITS INCH INCH
MM
COOR_ZEROS DECIMAL TRAILING
LEADING
TRAILING
KEY_STRING <String>
REQUIRED_STRING <String>
Sign declaration:
|Alternative (or)
[...]0 or multiple repetition
APE_SCALE

If the units for the aperture size do not coincide with any of the possible
parameters under APE_UNITS, it is possible to scale the units with
these parameters. Example: The aperture sizes are given in 1/100 mm.
Set APE_UNITS to MM and APE_SCALE to 0.01.

APE_UNITS
Defines the units for the aperture size within the aperture list (MIL, INCH
or MM).

COMMENT

Defines one or more characters preceding a comment line. A number of
characters/character pairs are separated from one another by space.
Example: Comment: COMMENT @ # // means that each line beginning
with “@”, “#” or “/I” is a comment line.

CONFIGURATION
Defines the format defined for this translation file (Gerber, Excellon, HP-
GL or Sieb&Meyer)

COOR_MN

Defines the M.N-Code for the Gerber format. If the Gerber data is always
generated with the same number of digits in front of following the
decimal point, the corresponding values are set here.

COOR_MODE

Defines the coordinate mode for the Gerber format. For Gerber data with
absolute values, COOR_MODE ABSOLUTE is set, for relative values,
COOR_MODE INCREMENTAL is set.

CircuitCAM 5.0
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COOR_UNITS
Defines the unit for the Gerber data in inches (INCHES) or metric (MM).

COOR_ZEROS

Defines the setting for leading zeros in the Gerber format. If the Gerber
data is always generated with leading zeros, LEADING is set here, if it is
generated with trailing zeros, TRAILING is set here. If leading as well as
trailing zeros are output, either TRAILING or LEADING is set.

KEY_STRING

(Only for automatic recognition)

Defines the key word which must be contained in the aperture list so that
this translation file is used for conversion of the aperture list. If the key
word coincides, the scan procedure is terminated immediately.

REQUIRED_STRING

(Only for automatic recognition)

Defines the keyword which must be contained in the aperture list for this
translation file to be taken into closer consideration during automatic
recognition. Even when the keyword matches, the scanning operation is
continued to find the best suitable translation file. All translation files
without this keyword are ignored immediately during the scanning
operation. This allows the range of translation files which could be used
to be limited.

Section 2: Aperture Definition

Each aperture within the aperture list must be capable of being assigned
precisely to the translation file by one of the entries in the aperture
definition. The apertures differ in terms of the D-code, mode, shape and
size. Each line in the aperture list is compared with entries in the
translation file for matching. If a match is found, the aperture information
is set, otherwise the corresponding aperture is ignored.

The following syntax is used for the aperture definition:
1,<DRAW_FORMAT><FLASH_FORMAT>:"<APE_FORMAT>"

Parameter
<DRAW_FORMAT>

Definition

N

Aperture is only used as a flash aperture, never as draw aperture.

C Aperture is used as round or circular draw aperture.
Q Aperture is used as square draw aperture.
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Parameter Meaning Dimension Parameter
<FLASH_FORMAT> in <APE_FORMAT>
N Aperture is only used as a draw aperture, never as
flash aperture.
C Aperture is used as round or circular flash aper- |%a (Durchmesser)
ture..
Q Aperture is used as square flash aperture. %a (side length)
R Aperture is used as rectangular flash aperture. %a (side length X)
%b (side length Y)
O Aperture is used as an oval or finger-shaped flash | %3 (side length X)
aperture. %b (side length Y)
T Aperture is used as an octagonal shaped flash | %a (diameter)er)
aperture.
D Aperture is used as rectangular flash aperture with %Ia (sitc:]e\}?ngth X) %b (side
eng
rounded corners. %c (corner radius)
B Aperture is used as rectangular flash aperture cut |%a (side length X) %b (side
corners i 1)
: %c (cut length )
S Aperture is used as special flash aperture. The
actual form must be designed and implemented
in CircuitCAM.

Parameter <APE_FORMAT>

The <APE_FORMAT> parameter is shown in quotation marks ("") and defines the exact reproduction
of each aperture (aperture line) in the aperture list. Both fixed and variable entries may be used here.
The space is used as the default separator between the various parameters.

Variable entries

Meaning

%% is used for the aperture code
%s ignores a string from space to space
(may be used as often as necessary)
%a %b are used for size parameters (diameter, side

length)

Fixed entries

file.

ble for this.)

All strings appearing between the variable values in the aperture list are permitted as fixed entries.
Multiple consecutive spaces in the aperture list are represented as a single space in the translation

Tip: All entries after the last relevant parameter can be ignored. (There is no need to use the %s varia-
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Example 1

Information in aperture list:
1 D12 Draw circle 8 8 Aperture No.l1l2
2 D20 Flash rectangle 20 60 Aperture No.20
Matching definition in the translation file:
1,CN:"%s D%% Draw circle %a"
1,NR:"%s D%% Flash rectangle %a %b"
Example 2

If the separating character between the individual parameters is
not a space, the corresponding character is given in brackets []

Information in aperture list:

12 Flash Oval X0.6Y1.20
20 Flash Rectangle X1.0Y0.7

Matching definition in the translation file:

1,NO:"%% Flash Oval [X]%a[Y]%b"
1,NR:"%% Flash Rectangle [X]%alY]%b"

Section 3: Variable Parameters

Some CAD systems provide the possibility of writing more precise
specifications in the Gerber format into the aperture list in addition to the
aperture information. Variable parameters can be used for evaluation of
this information to eliminate having to readapt the translation file each
time this additional information is changed.

After conversion, a search is made in the aperture list for the character
chains defined for the variable parameters and when a match is found
they are assigned to the corresponding parameter.
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Variable parameters

Meaning

Coordination-unit

100 : "<text>" The rsgistered string <text> defines the coordination-unit INCH.

101 : "<text>" The registered string <text> definesthecoordination-unit MM.

Coordination-mode

110 : "<text>" The registerd string <text> defines the coordination-mode ABSO-
LUTE.

111 "<text>" The registered string <text> defines the coordination-mode RELA-

TIVE.

Before- and after-comma postitions

120 : The registered string <text> defines the M-Code (Number of before
"<text>%d<text>" comma positions). &d presents the sign from the aperture list - M
code.
121: The registered String <text> defines the N-Code (number of the after-
"<text>%d<text>" comma positions). &d presents the sign from the aperture list N-
Code
122 The registered string <text> defines the M.N-Code (number of the
"<text>%1d.%1d<te | after- comma positions). The first variable &1d presents the sign
xt>" who defines the aperture list M-Code. The second variable &1d pre-

sents the sign who defines theaperture list N-Code.

Koordinate-seros

130 : "<text>" The registered string <text> defined the coordination-zeros as LEAD-
ING. (trailing suppressed.)

131 : "<text>" The registered string <text> defines the coordination-zeros as TRAIL-
ING. (leading suppressed)

132 : "<text>" The registered string <text> defines the coordination-zeros as DECI-

MAL.

Example 1
Information in aperture list:

The units in the Gerber data are metric
m.n format = 3.2

Values absolutes

Leading zeros suppressed

Matching definition in translation file:

101 : "The units in the Gerber data are metric"
110 : "Values absolute"

122 : "m.n format = 1%d.1%d"

131 : "Leading zeros suppressed"

CircuitCAM 5.0
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10.17.2 Tips for Adapting Translation File

If the graphic display of the circuit board does not coincide with the
desired result, incorrect conversion of the aperture/tool list by the
corresponding translation file is usually the cause.

For example if conductors pads are displayed in the wrong shape or
size, the aperture/tool definitions in the translation file do not correspond
to the format of the aperture/tool list to be read in. As a remedy, the
translation file can be adapted specifically to the aperture/tool list as
described previously.

However, frequently only one parameter value is incorrectly defined in
the translation file so that this problems can be solved quickly. The
following table provides a list of the parameters which could cause
erroneous graphic display:

Example of translation files for various CAD systems

Incorrect display in the gra-|Incorrect setting in the trans-|Parameter in the translation file to

phic window:: lation file: modify:
Objects are displayed too big |Coordinates unit APE_'l'JNITS .
or too small by a factor of 100 : "<text>“
101 : "<text>

2.54.
Objects are shown concen- |Coordinates mode COOl}_MODE
trated around the coordinates |ABSOLUTE instead of INCRE- ”2 : "::gx::"
origin. MENTAL - Stex
Objects are displayed in a Cﬁ\?(r:dli?né\tﬂeESNnjr%?_e. oad of

: instead o
dlagon'fll row from bottom left ABSOLUTE
to top right..
Objects are displayed too big |Resolution COOR_MN

or too small by a factor of 0.1/|(number of integer and decimal

120 : "<text>%d<text>"
121 : "<text>%d<text>"

10/100 . places, M.N code) 122 : "<text>%1d.%1d<text>"
Some graphica| objects are Coordinate zeroes COOE_ZEROHS
shown concentrated around 130 : "<text>"
. . 131 : "<text>
the X axis or Y axis. 132 : "<text>"

s

|

Examples of aperture lists from various CAD systems and the
associated translation files prepared by LPKF are listed below

Note: These translation files were created according to the
aperture list available to LPKF. Deviations of individual structures
or aperture definitions are imaginable.

LPKF cannot assume any guarantee for completeness or
correctness of the translation files provided. Modifications must be
made by the user.
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Alegro
Translation file:

APE UNITS MIL
CONFIGURATION ConfigGerber

1,CN : "LINE %a D%%"
1,CC : "CIRCLE %a D%%"
1,00 : "SQUARE %a %S D3%3%"
1,NR : "RECTANGLE %a %b %S D%%"
1,NS : "FLASH %s %a D%%"
100 : "INPUT-UNITS INCHES"

Matching aperture list:
INPUT-UNITS INCHES
WHEEL 1
LINE 4 D26
LINE 6 D27
LINE 8 D24
LINE 10 D25
LINE 20 D29
LINE 25 D28
CIRCLE 60 D12
CIRCLE 65 D13
CIRCLE 80 D10
RECTANGLE 27 72 0 D21
RECTANGLE 30 80 0 D17
RECTANGLE 34 84 0 D19
RECTANGLE 46 86 0 D22
RECTANGLE 50 100 0 D15
RECTANGLE 56 9 6 0 D23
RECTANGLE 72 27 0 D20
RECTANGLE 80 30 0 D16
RECTANGLE 84 34 0 D18
RECTANGLE 100 50 0 D14
FLASH TQ60-40-15-45 0 D11

EAGLE
Translation file:

APE UNITS INCH
CONFIGURATION ConfigGerber

1,CN : "D%% draw %a"

1,NC : "D%% round %a"

1,NQ : "D%% square %a"

1,NR : "D%% rectangle %a %s %b"
1,NT : "D%% octagon %a"

1,NC : "D%% annulus %a"

1,NO : "D%% oval %a %s %b"
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Matching aperture list:

D10 draw

D11 draw

D12 draw

D50 round

D51 round

D52 round

D53 round

D80 square
D81 square
D120 octagon
D121 octagon
D115 rectangle
D116 rectangle
D117 rectangle

ECAM
Translation file:

APE UNITS MIL

.004
.006
.008
.024
.028
.032
.036
.024
.028
.024
.028
.080
.056
.118

IPIE
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x 0.048
x 0.118
x 0.056

CONFIGURATION ConfigGerber

1,CC "D%% ROUND %a"
1,00 "D%% SQUARE %a"
1,NC "D%% DONUT %a'
1,NT "D%% OCTAGON %a"
1,NS "D%% TARGET %a"
1,NS "D%% CUSTOM %s %a"
1,NS "D%$% THERMAL %a"
1,NR "D%% RECTANGLE %a
Matching aperture list:

! GAPFile Version 1.0

! Created: Wed Mar 27 14:33:37 1996

! Created by: ECAM (tm) Version 3.21e

GAPFile Version 1.0 (c) 1991 CAD Solutions, Inc.

! Type Width Length Rotate

English Metric  English Metric
+ +

Offset  Swap Tool

$s 2b"

Size Legend!

English Metric Code No. English Metric !
+ +

D10 ROUND 6.00 0.152 0.00  0.000
D11 ROUND 10.00 0.254 0.00  0.000
D33 SQUARE 50.00 1.270 0.00  0.000
D34 SQUARE 58.00 1.473 0.00  0.000
D38 OBLONG 75.00 1.905 25.00 0.635
D39 OBLONG 25.00 0.635 75.00 1.905
D67 RECTANGLE 60.00 1.524 38.00 0.965
D68 RECTANGLE 38.00 0.965 60.00 1.524
D69 RECTANGLE 92.00 2.337 14.00 0.356

[=lelolololololefe)

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.000 D10 0 0.00 0.000 DO
0.000 D11 0 0.00 0.000 DO
0.000 D33 0 0.00 0.000 DO
0.000 D34 0 0.00 0.000 DO
0.000 D38 0 0.00 0.000 DO
0.000 D39 0 0.00 0.000 DO
0.000 D67 0 0.00 0.000 DO
0.000 D68 0 0.00 0.000 DO
0.000 D69 0 0.00 0.000 DO
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PADS
Translation file:

APE UNITS MIL
CONFIGURATION ConfigGerber

1,NC : "%% %a 1 F"
1,CN : "%% %a 1 D"
1,NQ : "%% %a 2 F"
1,0N : "%% %a 2 D"
Matching aperture list:
POST PROCESSOR REPORT
LAYOUT NAME :—  54224D
LAYOUT TITLE :—~ LISTA APERTURE PHOTOPLOTTER

SYMBOL AVAILABILITY REPORT

Position |[Size Shape Usage Orient Length Count
126 30 1 B 101
10 8 1 D 0
71 12 1 D 0
73 20 1 D 0
78 5 1 D 0
21 80 1 F 7
144 52 1 D 0
145 52 2 F 20
136 44 1 D 0
137 44 2 F 244
57 58 1 D 0
58 58 2 F 20
76 40 1 D 0
20 40 2 F 90
48 60 1 D 0
56 60 2 F 4
82 120 1 D 0
33 48 1 D 0
34 48 2 B 6
30 36 1 D 0

SHAPE: 1 = ROUND
2 = SQUARE
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Translation file:
APE UNITS MIL
CONFIGURATION ConfigGerber
1,CC : "D%% ROUNDED %a %s %s MULTI"
1,NC : "D%% ROUNDED %a %s %s FLASH"
1,NR : "D%% RECTANGULAR %a %b %s FLASH"
1,0R : "D%% RECTANGULAR %a %b %s MULTI"
1,NO : "D%% ROUNDED %a %b %s FLASH"
1,NT "D%% OCTAGONAL %a %b %s FLASH"
Matching aperture list:
D11 ROUNDED 1.000 1.000 0.000 MULTI
D12 ROUNDED 7.333 7.333 0.000 MULTI
D26 RECTANGULAR 62.000 62.000 0.000 FLASH
D27 RECTANGULAR 66.000 66.000 0.000 FLASH
D28 RECTANGULAR 75.000 75.000 0.000 FLASH
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